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Warnings, Cautions, and Notes
as Used in this Publication

Warning

Warning notices are used in this publication to emphasize that hazardous voltages, currents,
temperatures, or other conditions that could cause personal injury exist in this equipment or
may be associated with its use.

In situations where inattention could cause either personal injury or damage to equipment, a
Warning notice is used.

Caution

Caution notices are used where equipment might be damaged if care is not taken.

Note
Notes merely call attention to information that is especially significant to understanding and
operating the equipment.

This document is based on information available at the time of its publication.  While efforts
have been made to be accurate, the information contained herein does not purport to cover all
details or variations in hardware or software, nor to provide for every possible contingency in
connection with installation, operation, or maintenance.  Features may be described herein
which are not present in all hardware and software systems.  GE Fanuc Automation assumes
no obligation of notice to holders of this document with respect to changes subsequently made.

GE Fanuc Automation makes no representation or warranty, expressed, implied, or statutory
with respect to, and assumes no responsibility for the accuracy, completeness, sufficiency, or
usefulness of the information contained herein.  No warranties of merchantability or fitness for
purpose shall apply.

©Copyright 1998 GE Fanuc Automation North America, Inc.

All Rights Reserved.
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SAFETY PRECAUTIONS

This manual includes safety precautions for protecting the user and

preventing damage to the machine.  Precautions are classified into Warnings

and Cautions according to their bearing on safety.  Also, supplementary

information is described as Notes.  Read the Warnings, Cautions, and Notes

thoroughly before attempting to use the machine.

¡  Read this manual carefully, and store it in a safe place.

WARNING

Applied when there is a danger of the user being injured or when there

is a danger of both the user being injured and the equipment being

damaged if the approved procedure is not observed.

CAUTION

Applied when there is a danger of the equipment being damaged, if the

approved procedure is not observed.

NOTE

Notes is used to indicate supplementary information other than

Warnings and Cautions.

NOTE

In this manual, a program used to specify operations of the CNC

machine tool is referred to as "NC data."  In CNC machine tool

manuals, such a program may be referred to as a "machining

program," "part program," or "program," in place of "NC data."  The

above precautions must also be applied to those programs in a CNC

machine tool manual, assuming that the programs have the same

usage and purpose as those of the NC data as described in this

manual.
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GENERAL WARNINGS AND CAUTIONS RELATING TO USE WITH A CNC

This chapter presents the safety precautions which must be observed when

the conversational automatic programming function, described in this

manual, is used with the CNC machine tool.

WARNING

(1) Before starting any operation related to the conversational function

(such as preparing NC data or running an NC data program),

thoroughly check the work area to ensure safety.  For example, close

the door of the machine, if it is open.  Failure to ensure safety may

result in death or serious injury.  Operating the machine with

incorrect NC data may result in the tool colliding with the workpiece

and/or machine, possibly causing damage to the machine,

workpiece, and/or the tool itself, or injury to the user.

(2) When the tool offset function is used, before activating the machine,

check the direction and value of the offset to ensure that the tool will

not collide with the workpiece or machine.  Any collision may cause

damage to the tool, machine, and/or workpiece, or injury to the user.

(3) Before starting the NC data program prepared using the

conversational function, thoroughly check the NC data to ensure that

the tool path and machining processes are set correctly, and that the

tool will not collide with the workpiece or machine (including the

chuck and tailstock).  Before starting a production run, perform a dry

run to ensure that the tool will not collide with the workpiece or

machine (including the chuck and tailstock).  For example, start the

NC data program without mounting a workpiece on the machine.

Any collision may cause damage to the tool, machine, and/or

workpiece, or injury to the user.

(4) Before using the conversational function to perform programming,

ensure that all the data required for the conversational function,

including tool data and cutting condition data, is set correctly.  If

these data values are not set appropriately, the cutting conditions

required for machining may not be set correctly, possibly causing

damage to the tool, machine, and/or workpiece, or injury to the user.

(5) After pressing the power-on button, do not touch any keys on the

keyboard until the window is displayed.  Some keys are specifically

designed for maintenance or other special operations; if any of these

keys is pressed before the window is displayed, the machine may

behave unexpectedly.
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GENERAL WARNINGS AND CAUTIONS RELATING TO USE WITH A
PERSONAL COMPUTER

This chapter presents the safety precautions which must be observed when

the software, described in this manual, is used with a personal computer,

and when the prepared NC data(Note) is used with a CNC machine tool.

WARNING

(1) Before using NC data with a CNC machine tool to perform a

production run, ensure that the machine and tool under the control of

the NC data commands will operate safely.  If incorrect NC data is

used carelessly, or if correct NC data is handled improperly, the

machine or tool may behave unexpectedly, possibly causing damage

to the machine, tool, and/or workpiece, or injury to the user.

(2) In this software, once NC data has been automatically created,

whether the NC data program runs appropriately for the CNC

machine tool is not checked.  When using the NC data with a CNC

machine tool to perform a production run, follow the instructions in

(1) above.

(3) In this software, whether other software for drawing or checking NC

data runs appropriately for the CNC machine tool is not checked.

When using the NC data with a CNC machine tool to perform a

production run, follow the instructions in (1) above.

(4) When even proven NC data is used repeatedly, the contents of the

NC data may have changed when it is input to the CNC machine tool,

due to degradation in the NC data storage, or changes in the

communication facilities for data transfer.  When using the NC data

with a CNC machine tool to perform a production run, follow the

instructions in (1) above.
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PREFACE

Thank you for purchasing FANUC Symbolic CAP T.

The FANUC Symbolic CAP T software provides total support of all lathing

phases from blank figure creation and parts figure creation through to NC

data creation. To take full advantage of the functions and features of

FANUC symbolic CAP T, users are advised to read and become familiar

with the entire contents of this manual.

FANUC Symbolic CAP T is compatible with Microsoft Windows. This

manual does not attempt to explain basic Windows operations. Those users

who are unfamiliar with Windows should first read the Windows

documentation for an explanation of Windows fundamentals.

FANUC Symbolic CAP T uses the following products, whose copyright is

owned by Microsoft of the USA.

• Microsoft Windows Software Development Kit

• Microsoft Windows Visual C++TM

• Microsoft Windows Visual BasicTM

• Microsoft Windows Visual Control Pack

Checking the contents of the package

Immediately after opening the package, check that you have received the

following items.

1) Floppy disks

• For OPEN CNC

FANUC Symbolic CAP T Basic module V1 (A08B-9110-

J550#EN07)

• For Personal computer

FANUC Symbolic CAP T Basic module V1 (A08B-9310-

J550#EN07)

2) Protector (Only for Personal computer)

FANUC Symbolic CAP T Basic module Protector (A08B-0080-

NOTE

Microsoft and Windows are registered trademarks of Microsoft

Corporation of the USA. Visual C++ and Visual Basic are trademarks

of Microsoft Corporation.
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J550#P550)

3) Operator's manual

FANUC Symbolic CAP T Basic module Operator's Manual (this

document)

About this manual

This manual consists of the sections described below.

PREFACE

Describes the use of this manual and related materials.

Also, briefly describes some of the features of FANUC Symbolic CAP

T.

1. SETUP

Describes the environment needed to run FANUC Symbolic CAP T,

and the method of setting up and enabling the use of FANUC

Symbolic CAP T.

2. BASIC OPERATION

Explains how to start and stop FANUC Symbolic CAP T, and

describes its basic operations. Also, briefly describes the functions

provided by the side menu and menu bar.

3. PROGRAMMING EXAMPLE

Provides an example of the operation of FANUC Symbolic CAP T.

4. BLANK FIGURE CREATION

Describes the types of blank figures, and explains their creation.

5. PARTS FIGURE CREATION

Describes how to create parts figure by means of symbolic figure

input.

6. PRE-MACHINING SETTING

Explains how to set the machine's home position and select tooling

data; these operations must be completed before machining definition

can be performed.

7. MACHINING DEFINITION

Describes the specification of machining types, machining area, and

machining conditions, based on the blank and part figures. Also

explains how these items can be determined automatically.
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8. NC DATA PREPARATION

Describes how to prepare the NC data for a specified process. Also

explains how to confirm NC data by animated simulation, and how to

print NC data and process list.

9. TOOL PATH EDITING

Explains how to edit tool paths you prepared.

10. SAVING AND LOADING FILE

Describes how to save a newly created program under a specified

name, and how to load a program that was created and saved

previously.

11. CREATING NEW PROGRAM

Describes how to discard an existing program and create a new one.

12. FIGURE CREATION

Explains the basics of figure creation by means of CAD entry.

Also describes how figures are copied and modified.

13. CUTTING CONDITION DATA

Describes how data is registered and modified, including data on the

workpiece, tools, and machining conditions, needed to enable the

automatic setting of machining conditions.

14. CUTTING CONDITION DATA UTILITY

Explains how to input and output cutting condition data.

15. TOOL DATA AND TOOLING DATA

Describes how to select the tool data to be referenced at Machining

Definition, and how to register new tools and modify existing tool

data.

16. TOOL/TOOLING DATA UTILITY

Explains how to input and output tool/tooling data.

17. NC MACHINE SETTING

Describes how to specify the technical data for the machine and

CNC.

18. FILE TRANSFER

Describes how to transfer NC data to the CNC unit or other units.

19. PLOTTING

Describes how to output NC data from the drawing window to the

plotter.
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20. CAD DATA INPUT/OUTPUT

Describes the exchange of data between Symbolic CAP T and general

CAD software. Also explains the precautions to be observed when

using FANUC Symbolic CAP T to handle data prepared in another

CAD system.

21. FAPT LANGUAGE FIGURE INPUT

Describes a function that is tended to analyze and execute part

program figure definition statements written in FAPT language, and

convert them to figure entities that can to be saved to the Symbolic

CAP figure databases.

22. DIMENSION MEASUREMENT

Explains how to measure coordinates and distances from figures.

23. STANDARD SETTING

Describes the setting of the initial values displayed on each

conversational window.

24. PARAMETER SETTING

Describes the specification of parameters related to FANUC Symbolic

CAP T, such as the part figures and tool path colors to be prepared,

the sequence in which axes are moved during approach/escape, and

whether data is saved automatically at regular intervals.

25. TOOL BAR SETTING

Describes how to modify the contents of the tool bar.

26. TROUBLESHOOTING

Describes the procedure to be followed if a problem occurs.

Also lists the errors that may occur.

27. APPENDIX

Contains information that should be read as required, such as the

function codes used in NC machine files.

Notations

• Product name abbreviations

Major product names are abbreviated as stated below.

FANUC Symbolic CAP T  ->  Symbolic CAP T

FANUC Symbolic CAP T Basic module  ->  Basic module

FANUC Symbolic CAP T Basic module

Protector  ->  Protector
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Microsoft Windows ->  Windows

• Keys

When a sequence of keys are to be pressed and held down, the keys in the

sequence are indicated with an intervening dash (-), as shown below:

Example)  CTRL-ALT-TAB, ALT-F4

• Menus

When a command is to be selected from the menu bars, a right arrow (=>) is

used to link the menus in the sequence, as shown below:

“First menu => second menu => third menu”

Example)  The menus shown below would be indicated as shown below:

“Setting => Parameter Setting => Blank Figure, Parts Figure”

 
• Window examples

The windows shown in this document are merely examples. Note that the

window layout and file names used may vary depending on the equipment or

the resolution of the display unit you are using.

Features of Symbolic CAP T

• Operation on Windows

Comfortable operating environment is afforded by Windows which provides

a de facto standard user interface.

Even inexperienced users can use the system by interactive operation using

graphical menus and a mouse.

• User-friendly operating procedure that is easy to use, even by

beginners

Symbolic CAP T is easy even for beginners to use, thanks to its support of

graphical menus (icons) and mouse-driven conversational processing. In

addition, it provides a wealth of help messages.
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• Operating procedure for experienced operators

Symbolic CAP T commands can be entered from the keyboard, enabling

experienced operators to operate the system quickly.

• Customizing functions

The user can improve the operability or add functions to suit the usage of

customers. Customizing to call frequently used functions by a simple

operation on tool bar is possible.

• One-click switching of the window

The window can be switched between that for machining definition and that

for figure creation simply by clicking a button. Therefore, even if a figure is

found to be missing during machining definition, figure input need not be

repeated from the very beginning.

• Symbolic figure input

Blank and parts figure can be entered using conventional symbolic figure

input based on arrows.

• Fully automatic process determination

An optimum machining type, a tool, a portion to be cut, and machining

conditions can be automatically selected simply by entering blank and part

figures. Even beginners can create machining programs quickly and easily.

• Machining simulation

Three-dimensional animated machining simulation and tool path drawing are

performed simultaneously. Animated machining simulation allows the

operator to actually observe the progress of machining. Tool path drawing

enables the operator to check the tool path generated by a machining

program in detail.

• Tool path editing function

The tool path editing function enables editing tool paths generated on

Symbolic CAP T as figure images, using a mouse.

It is possible to re-prepare NC data from edited tool paths.
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1 SETUP

1.1 Prior to Setting Up (Operating Environment)

1.1.1 Prerequisites

The following operating environment is needed to run Symbolic CAP T.

• Computer

FANUC open CNC (with HSSB personal computer connection), or personal

computer

CPU: i486TMDX or higher (math co-processor required)

Memory: 12 MB or more

Floppy disk: 3.5-inch, 1.44MB

Hard disk: Total capacity of 80 MB or more (20 MB or more of

dedicated area and 32 MB or more of swap file area)

• Display unit

Resolution: 640 × 480 dots or higher

Color: 256 colors

• Keyboard and mouse

(Essential for use with a personal computer)

• Parallel-interface printer cable

(Essential for use with a personal computer)

• Microsoft Windows Version 3.1 or higher, set to enhanced

mode

NOTE

For use with a personal computer, printer cable is required to

connect the protector.
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1.1.2 Other usable devices

• Printer

Windows printer driver

• Plotter

Only for use with a personal computer

NOTE

The plotter having the command system of HP-GL is supported. HP-

GL2 or other command system is not supported.
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1.2 Setting Up Symbolic CAP T

1.2.1 About Setup

Start with the setup of the Symbolic CAP T basic module.  (When the basic

module has already been set up, and only the optional module is to be set up,

no additional setup is required for the basic module.)

• Preparation

(1) First, create a directory on the hard disk to which the Symbolic CAP

T system program will be stored.  (Example:  C:\CAP T)

(2) After making sure that the computer and printer are switched off,

attach the protector for the Symbolic CAP T basic module.

NOTE

Do not set up Symbolic CAP T in the root directory (\).

CAUTION

If other programs, such as FANUC PC FAPT, have already been set

up, do not set up Symbolic CAP T in the same directory as these

programs.

If the same directory is used, both programs may malfunction.

NOTE

The open CNC architecture does not require this procedure.

CAUTION

The computer and printer must be switched off while the protector is

being attached.

If the protector is attached or detached while the computer and

printer are switched on, the computer, printer, or protector may be

damaged.
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P r o t e c t o r

P r i n t e r

P r i n t e r  C a b l e

(3) Switch on the computer and start Windows.

• Setup procedure

(1) Insert the basic module floppy disk (labeled FANUC Symbolic CAP

T Basic module Vx Disk#1) into the floppy drive (where x in Vx is a

numeral).

(2) Select File => Run menu of Program Manager for Windows 3.1, or

select Start => Run menu of Task Bar for Windows 95.

(3) Key in drive-name:\SETUP (where drive-name is the name of the

3.5-inch floppy drive into which the floppy disk has been inserted).

Then, click OK.

(4) When the installation process prompts you to specify where Symbolic

CAP T is to be installed, key in the name of the directory where

Symbolic CAP T is to be installed, then press the Continue button.

(5) When the installation process prompts you to specify the data file to

be set up, select a data file, then click Continue.

(6) Installing the sysytem files to the hard disk begins.  As the

installation progress, you will be prompted to insert the next floppy

disk.  Insert the next disk, then click OK. Repeat this until all of the

floppy disks have been processed.

NOTE

If other programs, such as FANUC PC FAPT, have already been set

up, their protectors can be assembled into the Symbolic CAP T basic

module protector. The protectors to be assembled into the Symbolic

CAP T basic module protector must be attached before installing

Super CAP T. They can be removed after a setting has been made

such that they are assembled into the Symbolic CAP T protector.

They can be connected in any order.

NOTE

When setting up Symbolic CAP T for the first time, all data files must

be registered.
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(7) When the installation process prompts you to specify the directory

into which each type of data is to be stored, change the directory

name as required, then click OK.

(8) A prompt is displayed to inquire whether the optional module is to be

set up.  Click the Yes or No button.

(9) Finally, a prompt appears asking whether you want to assemble the

protectors of other softwares, such as FANUC PC FAPT, into the

protector of the Symbolic CAP T basic module. Click Yes or No, as

appropriate. If the protectors of other programs have not yet been

attached, click No.

(10) When a message indicating the normal completion of setup appears,

click OK.

(11) Upon the completion of setup, confirm that FANUC Symbolic CAP T

NOTE

When it is necessary to change a directory name, select the desired

data type from the list, then click Change. After selecting or keying in

a new drive name and directory name, click OK.

Even once setup has been completed, the data directory can be

changed by selecting “Setting => Environment” from the Symbolic

CAP T menu.

NOTE

When you click the Yes button, the prompt as provided in step (4) is

displayed.  Insert the optional module floppy disk labeled Disk#1,

reenter the installation destination directory name, then select the

Continue button.  (The optional module must be installed in the same

directory as for the basic module.)  For details, see Section 1.2.2,

“Setting up an optional module.”

NOTE

This question does not appear in the open CNC.

Clicking Yes makes it possible to use other softwares simply by

gathering their protector to the Symbolic CAP T basic module

protector. After keying in the specification number of the software

whose protector you want to gather into the Symbolic CAP T

protector, click Gather two protect keys into one protector. (The

specification number of the software appears on the floppy disk from

which the software is installed.)

When No is clicked, the protectors must be attached individually.
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group window has been added to Program Manager, together with an

icon for Symbolic CAP T.

(12) When a message indicating the normal completion of setup appears,

click OK.

(13) Upon the completion of setup, confirm that the FANUC Symbolic

CAP T group window has been added to the Program Manager,

together with an icon for Symbolic CAP T.

 

• Icon registered

Prompts and/or messages not described above may appear depending on the

specific installation.  In such cases, proceed as indicated on the window.

1.2.2 Setting up an optional module

When using an optional module, set it up once setup of the basic module has

been completed.  The procedure for setting up a typical optional module is

described below.  Note that some optional modules require the application of

special procedures or precautions.  Therefore, always refer to the

corresponding operator's manual.

• Preparation

(1) Check the name of the directory where the basic module has been

installed.

(2) After making sure that the computer and printer are switched off,

attach the protectors for the basic module and optional module.

NOTE

Optional modules must be stored into the same directory as that

where the basic module has been installed.

CAUTION

The computer and printer must be switched off while the protectors

are being attached.

If the protector is attached or detached while the computer and

printer are switched on, the computer, printer, or protector may be

damaged.
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Protec tor  for  Bas ic  module

P r i n t e r

P r i n t e r  C a b l e

Protector  for  Opt ion module

(3) Switch on the computer and start Windows.

• Setup procedure

(1) Perform setup in the same way as described in steps (1) to (7) for

setting up the basic module.

(2) Upon the normal completion of setup, a prompt appears asking

whether the protectors for the basic and optional modules are to be

assembled into a single protector.  Click Yes or No.

Prompts and/or messages other than those described above may appear

depending on the specific installation.  In such cases, proceed as directed by

the prompt.

NOTE

If two or more optional modules are to be set up, the protectors for

all those modules can be attached at this time.  Protectors can be

connected in series, in any order.

NOTE

Insert the floppy disk labeled Disk#1 for the module to be set up.

As the installation destination directory, specify the directory where

the basic module was installed.

NOTE

Clicking Yes makes it possible to use Symbolic CAP T without

attaching the protectors for the optional modules.

When No is clicked, the protectors for the basic module and each of

the optional modules must be attached in series to enable the use of

Symbolic CAP T.
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1.2.3 Reinstalling Symbolic CAP T

When reinstalling Symbolic CAP T in a directory where Symbolic CAP T has

already been set up, you can select whether to register the data files again.

When you want to use the existing data, do not register the corresponding

data when you are prompted to specify the data file to be set up.

When you want to reregister a data file, if the corresponding data file already

exists in the target directory, you will be prompted to specify whether the

previous data file is to be backed up.  Click Yes or No, as required.

1.2.4 About the protector (Only for use with a personal computer)

The protector must be kept attached to enable the setup and use of Symbolic

CAP T.  If it is detached, Symbolic CAP T will fail to run normally.

The protectors for other softwares can be gathered into the protector of the

Symbolic CAP T basic module.  It is not possible to assemble the protector

of the Symbolic CAP T basic module into that of any other software.

If the protectors of other softwares are gathered into the Symbolic CAP T

protector, the user need no longer be concerned with the other protectors as

part of daily operation. These softwares can be made usable simply by

attaching the Symbolic CAP T protector. Note that the individual protectors

are required when the corresponding softwares are upgraded. So, they

should be kept in a safe place.

If the protectors are not gathered into the Symbolic CAP T protector, they

must be attached individually.  They can be attached in any sequence.

NOTE

When Yes is selected, the existing data is backed up to the BAK

subdirectory under the Symbolic CAP T directory. The Symbolic CAP T

directory will be rewritten with the standard data. If necessary, however,

the previous data can be restored from the BAK subdirectory.

When No is selected, the existing data is overwritten with the standard

data.

CAUTION

Both the computer and printer must be switched off before

attempting to either attach or disconnect the protector.

If the protector is attached or detached while the computer and printer are

switched on, the computer, printer, or protector may be damaged.
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2 BASIC OPERATION

2.1 Fundamentals

2.1.1 Starting Symbolic CAP T

Double-click the Symbolic CAP T icon.

2.1.2 Terminating Symbolic CAP T

Select File => Exit from the Symbolic CAP T menu.

2.1.3 Reading the latest information about Symbolic CAP T

Double-click the Read Me file icon. The Read Me file contains information

relating to Symbolic CAP T that users should be aware of, together with

information specific to the installed version. The information in the Read

Me file does not appear in the operator's manual. It is imperative, therefore,

that the user read the contents of this file.

2.1.4 Other Symbolic CAP T icons

There are several other executable icons for Symbolic CAP T.  These

correspond to the File Transmission Tool, File Transmission Manager, NC

Machine Setting Tool, and Auto Demo.



2.  BASIC OPERATION B-62824EN/02

-10-

The File Transmission Tool enables NC data exchange with an external

device via a serial port. The File Transmission Manager is an application

that manages the transmission schedule and performs the actual

communication. Usually, it is not used independently.

The NC Machine Setting Tool is used to edit the contents of the

management file that governs the output format of NC data.  Using these

tools together enables Symbolic CAP T to support a range of CNC units.

Auto Demo is an application that introduces the major functions of Symbolic

CAP T.
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2.2 Contents of Symbolic CAP T Window

This section describes the Symbolic CAP T windows, using, as an example,

the first window to appear after Symbolic CAP T becomes operable.

2.2.1 Title bar

The title bar usually displays the name of the file being processed.  If the file

has not yet been saved, Untitled is displayed.

Tool bar

Side menu

Menu bar
Title bar

Prompt area
Status
window

Drawing window
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2.2.2 Side menu

Side menus contain icons corresponding to the major commands related to

programming and figure preparation.

The side menus are configured in a hierarchy.

• Primary menu

Enables the selection of either programming or figure preparation mode.

• Secondary menu

When programming mode is selected, the main menu for programming

appears. When figure preparation mode is selected, the main menu for figure

preparation appears.

• Tertiary menu

A submenu corresponding to each figure appears only in figure preparation

mode.

 Programming mode  Figure creation
mode
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2.2.3 Menu bar

Commands to be executed can be selected from the menu bar.  Command

execution can be nested up to about 20 levels.

• File menu

Provides the functions used to manipulate files.

• Modify menu

Provides the functions used to modify individual figure entities.

• Edit menu

Provides the functions used to edit two or more figures at one time.

• View menu

Provides the functions used to display the drawing windows.

• Auxiliary menu

Provides auxiliary functions, such as those for setting drawing

formats and confirming entity information.

• Setting menu

Provides functions for setting parameters, such as machining

conditions, tool data, and standard values.

• Help menu

Provides functions that help explain the use of Symbolic CAP T.

2.2.4 Tool bar

Those functions that are used most frequently are also provided as icons, so

that processing can be simplified.  Moreover, the tool bar can be customized

as necessary.

2.2.5 Drawing window

The drawing window displays information such as blank figure, parts figure,

those figures prepared in figure preparation mode, and tool paths.

When using the mouse to specify a position or select an entity in this

window, simply click the corresponding item directly.
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2.2.6 Prompt area

In the prompt area, the user can enter responses to prompts output by the

current processing. System messages also appear in this area.

The prompt area may contain the following entities, depending on the type

of the prompt and the particular installation.

(a) Prompt back button (  button)

(b) Interrupt release button (ESC button)

(c) Mode switch box

(d) Key entry panel

(e) Position specification panel

(f) Entity selection panel

(g) Other panels as required

Entity selection panel

  Prompt back button  Interrupt release button

Key entry panel

Mode switch box

Position specification panel
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2.2.7 Status window

The status window displays the current status of an entity being prepared,

such as color, line type, and layer No.  The status of an entity can be

modified directly using the status window.

The status window contains the following items.

(a) Color setting button

(b) Line type setting button

(c) Figure search direction switch button

(d) Machining plane depth entry field

(e) Drawing layer No. entry field

When the Symbolic CAP T window is small, or if the display unit supports

only a low resolution, the status window may not appear.  In such a case,

access the equivalent function on the menu bar (Auxiliary => Set Current

Attributes).
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2.3 Basic Operation

2.3.1 Using the Help function to become familiar with the operating procedure

Users can use the Help function to help them become familiar with the

operating procedure of Symbolic CAP T. Whenever the user is unsure of

how to proceed, accessing the Help function will provide guidance on the

correct procedure. This function provides information that does not appear

in the operator's manual.

Whenever the Help button appears in a window, double-clicking the button

will provide help relating to that window.  Whenever there is no Help

button, help can be displayed by pressing the F1 key or by selecting the Help

menu from the menu bar.

The help menu contains the following submenus.

• Contents

This submenu enables the table of contents to be searched for topics

related to Symbolic CAP T.

• Search for Help on

This submenu enables a search to be made for topics related to

Symbolic CAP T according to a specified keyword.  Selecting this

submenu causes a list of keywords that can be used for a search to

appear.

• How to Use Help

This submenu explains how to use the help function.

2.3.2 Confirming the version

When it is necessary to confirm the installed version of Symbolic CAP T,

such as when performing maintenance, select “Help => About Symbolic

CAP T” from the menu bar.  The version of Symbolic CAP T and

information relating to the computer on which it is running will be

displayed, as shown below.
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2.3.3 Modifying the operation flow

Symbolic CAP T commands are executed by selecting from side menus or

menu bars. Usually, a conversational window or a string of prompts appear.

Operation is performed by responding to the displayed messages or prompts.

This section explains how to abandon the execution of one command in

favor of another, as well as how to correct operator errors.

• Abandoning one command and executing another

Using the side menu, it is always possible to switch the command

being executed. Clicking an icon halts execution of the current

command and starts execution of the command corresponding to the

clicked icon.

Whenever it is not possible to click an icon in a side menu, click a

button such as OK, Cancel, Close, or Exit in the prompt area or in

any current conversational window, then try to click the desired icon

again.

• Interrupt by another command

The commands available on a menu bar or tool bar are executed like

interrupts. While a command is being executed, if another command

is selected from a menu bar or tool bar, the current command is

temporarily suspended while the newly selected command is

executed. Upon completion of the newly selected command,

execution of the original command is resumed from the point at

which processing was suspended.
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• Exiting an interrupt

Whenever a command is selected from a menu bar or tool bar, the

ESC button appears in the prompt area. The command currently

being executed can be terminated by clicking the ESC button or

pressing the ESC key.

Example) This method can be used, for example, to terminate an

edit or modify command that is repeatedly executed for two or

more figures, such as figure copy or Trim/Extend.

Command interrupts can be nested up to about 20 levels. Within this

limit, commands can be interrupted by others without terminating the

original commands.

When an icon on a side menu is clicked, all interrupting commands

are terminated automatically, and the newly selected command is

executed, even if the user does not intend to terminate those

commands.

• Returning to the previous prompt

If the current command displays more than one prompt area, clicking

the     button in a prompt area or pressing the CTRL-BS keys returns

you back to the previous prompt area (if any).

Example) This function can be used with the command used to

define a straight line passing through two points. When you are

prompted to enter the second point after entering the first point,

you may decide that you want to respecify the first point. In such

a case, use this function.
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2.4 Functions Provided by Side Menu

2.4.1 Programming mode

The programming mode side menu provides the following functions.

Icon Function

......................................Blank figure creation

......................................Parts figure creation

......................................Pre-machining setting

......................................Machining definition

......................................NC data preparation

.......................................Tool path editing

2.4.2 Figure creation mode

The figure creation mode side menu enables the generation of the following

figure entities.

Icon Function

     Point and plural points creation

............................Single point

• Start or end point of an entity

• Intersection/point of

   tangency between two entities

• Mid-point of an entity

• Center of a circle/arc entity

• Existing point

• Grid point

• Free point
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............................Linear plural points (with intervals specified)

............................Linear plural points (with a number of

divisions specified)

............................Circular plural points (with intervals

specified for the arc section)

............................Circular plural points (with the number of

divisions specified for the arc section)

............................Circular plural points (with the number of

divisions specified for the entire

circumference)

............................Rectangular plural points

............................Grid plural points

............................Random plural points

.................Add a point to random plural points

................. Insert a point into random plural points

.................Move a point among random plural points

.................Delete a point from random plural points

.................Determine random plural points

.................Select plural points as the target of operation

............................Plural points as nodes of a fitting curve



B-62824EN/02 2.  BASIC OPERATION

-21-

Icon Function

    Straight line creation

............................Horizontal line

............................Vertical line

............................Horizontal and vertical lines

............................Straight line passing through a specified

point and having inclination of specified

degree.

............................Straight line tangential to a specified circle

and having inclination of specified degree.

............................Straight line passing through two specified

points

............................Straight line perpendicular bisector of a line

segment between two specified points

............................Straight line passing through a specified

point and parallel to a specified straight line

............................Straight line passing through a specified

point and perpendicular to a specified

straight line

............................Straight line passing through a specified

point and tangential to a specified circle

............................Straight line tangential to two specified

circles

............................Straight line having a distance d from a

specified straight line

............................Straight line bisecting an angle between two

specified straight lines



2.  BASIC OPERATION B-62824EN/02

-22-

Icon Function

    Circle creation

............................Circle having a specified point as its center

and radius r

............................Circle having a specified point as its center

and passing through a specified point

............................Circle having a specified point as its center

and tangential to a specified entity

............................Circle of radius r, passing through a

specified point, and tangential to a specified

entity

............................Circle of radius r and passing through two

specified points

............................Circle of radius r and tangential to two

specified entities

............................Circle passing through three specified points

............................Circle tangential to three specified entities

............................Circle passing through a specified point and

tangential to two specified entities

............................Circle passing through two specified points

and tangential to a specified entity

............................Circle for which the difference in radius

between the circle and a specified circle/arc

is specified value
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Icon Function

    Arc creation

............................Arc having a specified point as its center and

specified radius

............................Arc having a specified point as its center and

passing through a specified point

............................Arc having a specified point as its center and

tangential to a specified entity

............................Arc of specified radius, passing through a

specified point, and tangential to a specified

entity

............................Arc of specified radius and passing through

two specified points

............................Arc of specified radius and tangential to two

specified entities

............................Arc passing through three specified points

............................Arc tangential to three specified entities

............................Arc tangential to a specified entity at the

start point and another specified entity at the

end point, and passing through a specified

point

............................Arc starting at a specified point and

tangential to two specified entities

............................Arc starting at a specified point, ending at

another specified point, and tangential to a

specified entity

............................Arc starting at a specified point, passing

through another specified point, and

tangential to a specified entity
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............................Arc whose radius differs from the radius of

another arc by d

............................Arc whose radius differs from the radius of a

circle by d

Icon Function

    Rectangle creation

............................Rectangle defined by diagonal two points

............................Rectangle having the specified horizontal

and vertical widths, and inclination of

specified degree

Icon Function

    Polyline/polygon creation

............................Line segment starting at a specified point

and ending at another specified point

............................Arc tangential to a previous entity at the start

point

............................Arc passing through a specified point

............................Arc tangential to a specified entity

............................Arc of specified radius and drawn

counterclockwise

............................Arc of specified radius and drawn clockwise

............................Determine as a polyline

............................Determine as a polygon (by closing the start

and end points)

............................Create a polyline/polygon along other

entities (trace mode)
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............................Cut a line segment/arc at an intersection

with another entity and determine as a

polyline

............................Cut a line segment/arc at an arbitrary point

and determine as a polyline

............................Select a polyline/polygon as a target of

operation

............................Connect a polyline/polygon to another entity

Icon Function

    Fitting curve creation

............................Node addition

............................Node insertion

............................Node movement

............................Node deletion

............................Open fitting curve creation

............................Closed fitting curve creation

............................Select a fitting curve as a target of operation
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2.5 Functions Provided by Menu Bar

2.5.1 File menu

Menu item Function

• New Clears the figure and machining

specification data currently being created and

creates a new figure and machining

specification data.

When the New command is chosen, the data

of the figure and the machining definition

data made till then can be preserved.

• Open Reads a figure and machining data from a

file.

When the Open command is chosen, the data

of the figure and the machining definition

data made till then can be preserved.

• Save Saves the figure and machining data

currently being created to a file.

Former file is overwritten.

• Save As Specifies a file name and saves the figure

and machining data currently being created

to the specified file.

• Clear Machining Data Clears the machining data currently defined

and defines new machining data.

When the Clear Machining data command is

chosen, the data of the figure and the

machining definition data made till then can

be preserved.

• Exchange CAD Data Actives the CAD data conversion.

• DXF-Input The DXF file data is converted into the

figure entity of Symbolic CAP T.

• DXF-Output The figure element of Symbolic CAP T is

converted and the DXF file is output.

• FAPT-Input The figure definition statement of FAPT

language is converted into the figure entity of

Symbolic CAP T.

• Plot Out Outputs a figure and tool path a plotter.

• Plotter Setup Sets conditions for figure output to a plotter.

• Exit Terminates Symbolic CAP T.

It is possible to save current figure and

machining instructions.
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2.5.2 Modify menu

Menu item Function

• Trim/Extend

• Intersection Extends or trims an entity up to an

intersection with a reference entity.

• Intersection - Modal Extends or trims multiple entities up to an

intersection with a reference entity in

succession.

• Nearby Point Extends or trims an entity up to a near by

point of a selected point.

• Both Entities Extends or trims both entities up to an

intersection of two entities.

• Both Ends Extends or trims both ends of an entity up to

an intersection with two reference entities.

• Both Ends - Modal Extends or trims both ends of multiple

entities up to an intersection with two

reference entities in succession.

• Erase Section

• 2 Positions Erases a section specified by two points from

an entity.

• 2 Positions - Modal Erases a section specified by two points from

multiple entities in succession.

• Break

• Intersection Divides an entity at an intersection with a

reference entity.

• Intersection - Modal Divides multiple entities at an intersection

with a reference entity in succession.

• Nearby Point Divides an entity at a near by point of a

selected point.

• Both Entities Divides both entities at an intersection of two

entities.

• 2 Positions Divides an entity by a section specified by

two points.

• 2 Positions - Modal Divides multiple entities by a section

specified by two points in succession.

• Round Rounds a corner.

• Rounds Rounds all corners of a polygon or polyline

at one time.

• Chamfer Chamfers a corner.

• Chamfers Chamfers all corners of a polygon or polyline

at one time.

• Erase Corner Entity Erases the specifications of corner round

circle and chamfering.
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• Erase Corner Entities Erases the specifications of corner round

circle and chamfering for all corners of a

polygon or polyline at one time.

2.5.3 Edit menu

Menu item Function

• Undo Restores the previously created, modified, or

edited entities to its previous state.

• Redo Reproduces entities restored by the Undo

command to its previous state.

• Erase Erases entities. Multiple entities can be

selected and erased at one time.

• Erase - Modal Erases entities one by one in succession.

• Copy

• Parallel-Positions Copies entities to specified positions in

parallel mode.

• Parallel - Distance Copies entities to multiple positions at

uniformly spaced intervals in parallel mode.

• Parallel - Division No. Copies entities in parallel mode to the

multiple positions determined by equally

dividing a specified maximum copy distance.

• Parallel - Position,

Division No. Copies entities in parallel mode to the

multiple positions determined by equaly

dividing the distance to a specified final copy

destination.

• Rotate - Distance Copies entities to each position determined

by rotating the entities repeatedly by the

same angle.

• Rotate - Division No. Rotates and copies entities to the positions

determined by equaly dividing the angle to

an end point.

• Mirror - Plane Specifies a mirror plane perpendicular to the

machining plane, then produces the mirror

image of entities. The original entities are

not erased.

• Mirror - Position Specifies a mirror plane perpendicular to the

machining plane by specifying a base

position and copy destination, and produces

the nirror image of entities. The original

entities are not erased.
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• Arbitrary Specifies a basic axis for the source and copy

destination, and copies a entities.

• Move

• Parallel - Position Moves entities to a specified position in

parallel mode.

• Parallel - Distance Moves entities by a specified distance in

parallel mode.

• Rotate Rotates entities to a specified position.

• Mirror - Plane Produces the mirror image of entities by

specifying a mirror plane perpendicular to

the machining plane. The original entities

are erased.

• Mirror - Position Produces the mirror image of entities by

specifying a mirror plane perpendicular to

the machining plane and defining a reference

position and move destination. The original

entities are erased.

• Arbitrary Moves entities by specifying basic axes for a

source reference point and a move

destination reference point.

• Reverse

• Keep Original Reverses and copies entities.

The original entities are not erased.

• Erase Original Reverses and moves entities.

The original entities are erased.

• Assemble Polyline/Polygon

Converts the separate entities into a polyline

or polygon.

• Disassemble Polyline/Polygon

Converts a polyline or polygon into the

separate entities.

• Offset

• Keep Original Offsets the entire polyline or polygon. The

original entities are not erased.

• Erase Original Offsets the entire polyline or polygon. The

original entities are erased.

• Offset of Part

• Keep Original Offsets part of a polyline or polygon. The

original entities are not erased.

• Erase Original Offsets part of a polyline or polygon. The

original entities are erased.

• Scale - Copy

• All Axes Copies entities while changing its size. The

same scaling factor is applied to the x-, y-,
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and z-axes.

• Each Axis Copies entities while changing its size.

Different scaling factors are applied to each

of the x-, y-, and z-axes.

• Scale - Move

• All Axes Moves entities while changing its size. The

same scaling factor is applied to the x-, y-,

and z-axes.

• Each Axis Moves entities while changing its size.

Different scaling factors are applied to each

of the x-, y-, and z-axes.

2.5.4 View menu

Menu item Function

• Set View Direction Sets the direction of display or rotates the

display.

• Redraw Redraw a drawing window.

• Zoom Enlarges a specified rectangle by mouse to

fill the window.

• Auto Scale Redraws a drawing window with automatic

scaling to enable the entire entities to be

displayed.

• Double Enlarges a drawing window display by a

factor of 2.

• Half Reduces a drawing window display by a

factor of 2.

• Pan Moves a drawing window display in parallel

mode.

• Drawing Layer Turns on or off drawing layer display.

• Layer for Tool path Turns on or off tool path creation layer

Creation display.

• Layer for NC data Turns on or off NC data preparation layer

Preparation display.
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2.5.5 Auxiliary menu

Menu item Function

• Drawing Format Sets up a coordinate system according to the

format of a drawing.

• Entity Information Displays information relating to entity (such

as entity type, pen number, and coordinates).

• Set Individual Attributes Changes the attributes (such as the color and

pen number) of a entity.

• Set Current Attributes Sets the attributes (such as the color and pen

number) of a entity to be prepared.

• Measurement

• Coordinate Values Entity start/end/middle point, intersection of

two entities, center of a circle/arc, Existing

point, and mouse pointer position are

displayed.

• Distance between Distance between two points is measured.

Two Points

• Distance of Point Shortest distance between a point and entity

and Entity is measured.

• Radius of Circle/Arc Radius of a circle/arc is displayed.

• Angle of Two Lines Angle formed by two lines is displayed.

• Display Measured When an entity for which dimension

Information measurement is finished is selected, the

information about a entity that contains the

selected entity is displayed.

• Layer

• Setting Sets the attributes (such as name, drawing,

view, and recognition) of layers.

• Move - Entities Moves specified entities between layers.

• Move - Select Layer Moves all entities between layers.

• Copy - Entities Copies specified entities between layers.

• Copy - Select Layer Copies all entities between layers.
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2.5.6 Setting menu

Menu item Function

• Parameter Setting

• View Option Sets parameters related to displays, such as

Axis Mark, Origin Mark, Grid, and Cursor

Tracking.

• Figure Operation Sets parameters related to figure preparation,

modification, and editing.

• Overall Setting for Sets general information relating to

Symbolic

Symbolic CAP T CAP T.

• Blank Figure, Sets the system behavior related to blank

Parts Figure figure preparation and parts figure

preparation.

• Setting of Sets the system behavior related to the pre-

Pre-machining machining settings.

• Machining Definition Sets the length of arrow which indicates an

area division point displayed in Machining

Definition for Lathe

• Auto Process Sets the system operations related to the

Determination automatic determination of a process, tool, or

cutting condition.

• Tool Path Creation Sets the system behavior related to tool path

creation.

• NC Data Preparation Sets the system behavior related to NC data

preparation.

• Auto Saving Sets the parameters needed to automatically

save existing figures and machining

definition data.

• Standard Setting

• Blank Figure, Sets the initial values for the conversational

Parts Figure window related to blank figure preparation

and parts figure preparation.

• NC Data Preparation Sets the initial values for the conversational

window related to NC data preparation.
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• Library Data Setting

• Cutting Condition Registers and modifies workpiece material,

tool material, and cutting conditions.

• Tool, Tooling Registers and modifies tool data and tooling

data.

• NC Machine File Starts the NC machine setting tool.

• Tool Bar Setting Setting Customizes the tool bar.

• Environment Sets the storage location for each data file.

2.5.7 Help menu

Menu item Function

• Contents Finds an explanation from the table of

contents.

• Search for Help on Finds an explanation using keywords.

• How to Use Help Explains how to use help information.

• About Symbolic CAP T Displays Symbolic CAP T version

information.
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2.6 Functions Provided by the Tool Bar

The standard tool bar contains icons corresponding to the following

functions.

Icon Function

.........................................Reads data from a file.

.........................................Saves the data currently being processed into

a file.

.........................................Cancels the previous operation.

.........................................Recovers a canceled operation.

.........................................Erases figures.

.........................................Redraws figures.

.........................................Automatically enlarges or reduces the view

area.

.........................................Enlarges a specified range within the view

area.

.........................................Doubles the size of the view area.

.........................................Halves the size of the view area.

.........................................Repositions the view area.

.........................................Sets layers.
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2.7 Flow of Operation

Blank figure creation

Pre-machining
setting data

Parts figure data

Blank figure data

NC data
file

Machining
process list

Execution
list

Chuck
data

NC data preparation

Parts figure creation

Pre-machining settings

Process dataMachining definition

Tool path
data

Tool path editing

2.7.1 Overview of each function

• Blank figure creation

Standard blank figures (bars and tubes) can be created simply by

responding to prompts displayed by the system.  Special figures can

also be created using the symbolic input method.

• Parts figure creation

Parts figures (turning figures, screws, grooves, and necking figures)

can be created easily using the symbolic input method.

• Pre-machining settings

Using this function, the user can select tooling data and NC machine

files, set a home position and index position, and set the chuck prior

to machining definition.

• Machining definition

Cutting areas and machining conditions can be automatically

determined from previously created blank figures and parts figures,

machining types (hole machining, roughing, semifinish machining,

finishing, grooving, threading, and so forth), many different cutting
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condition libraries, and tool data.  Moreover, fully automatic process

determination is possible.

• NC data preparation

From the specified processes, NC data can be prepared for each NC

machine.  NC data for a single given process can also be created.

Moreover, a check can be made using animated simulation, and NC

data and machining process lists can be printed out.

• Tool path editing function

The tool path editing function enables the editing of tool paths

generated on Symbolic CAP T as graphic images, using the mouse.

It is possible to re-prepare NC data from edited tool paths.

2.7.2 Overview of data

• Blank figure data(*)

Blank figure data includes blank-related data such as blank materials

and dimensions.

Blank figure data is created using the blank figure creation function,

and is subsequently referenced by the machining definition function

and NC data preparation function.

• Parts figure data(*)

Parts figure data represents the figure of a part to be machined.  Parts

figure data includes figure parameters that have been entered using

the symbolic input method, and surface roughness information.

Parts figure data is created by the parts figure creation function, and

is referenced by the machining definition function and NC data

preparation function.

If parts figure data is deleted, all process data is deleted at the same

time.

• Pre-machining setting data(*)

Pre-machining setting data includes selected tooling data, NC

machine file names, and set home position and index position data.

Pre-machining setting data is created by the pre-machining setting

function, and is subsequently referenced by the turning machining

definition function.

• Chuck data(*)

Chuck data includes data such as chuck figures.

Chuck data is created by the pre-machining setting function, and is

referenced by the NC data preparation function.

• Process data(*)

Process data includes data specified during machining definition.

Process data is referenced by the NC data preparation function.

• NC data file

The NC data file holds the NC programs that are ultimately created.

An NC data file is created by the NC data preparation function.
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• Tool path data

Tool path data includes data related to tool operation, which is

referenced during the creation of an NC program.  Tool path data is

created by the NC data preparation function, and can be edited by the

tool path editing function.

• Execution list

The execution list consists of information relating to errors that

occurred during NC data preparation, and the alarms that were

issued.

• Machining process list

A machining process list contains the tools used, feedrates, and

cutting distances of each process.  A machining process list is created

with the NC data creation function.

Data marked with (*) is saved to a file by selecting File => Save or File =>

Save As from the menu, and is read by selecting File => Open from the

menu.



2.  BASIC OPERATION B-62824EN/02

-38-

2.8 Layers

2.8.1 About layers

Layers are used to make complicated machining areas and figures easy to

read, arrange, and check.  Layers are not normally required for simple

figures, but are useful when handling complicated figures.

Layers can be compared to overlaid sheets of paper: one layer corresponds to

one sheet of paper.  By modifying the settings for a given layer (sheet of

paper) to use for drawing creation, the layer (sheet of paper) to display, and

so forth, the entire machining figure can be understood more easily, or the

details of a desired machining area can be viewed more closely.

2.8.2 Major classification of layers

Layers can be classified into three types according to their purposes.

• Figure creation layers

For figure creation, up to 256 layers (sheets of paper) can be used.

Blank figures, part figures, and machining profiles are automatically

assigned to layer 129 and up.  Figure entities (such as dots, straight

lines, circles, and arcs) created in the figure creation mode of the side

menu are created in layer 1 as standard.  For each layer, display,

recognition, and layer name can be set.  From the total of 256 layers,

only one layer can be set for figure creation.

• Tool path creation layer

On the tool path creation layer, tool paths are displayed for tool path

editing.  This layer does not allow figures to be created.  The user can

switch between display and hide.

• NC data creation layer

On the NC data creation layer, tool paths are displayed when NC data

is created.  This layer does not allow figures to be created.  The user

can switch between display and hide.
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2.8.3 Figure creation layer setting

By selecting Auxiliary => Layer => Setting from the menu bar or clicking

the [Set Layer] button ( ) on the tool bar, the settings below can be made

for 256 figure creation layers.

• Figure creation

Specify a layer number for registering figure entities created in the

figure creation mode of the side menu.  Only one of 256 layers can be

specified.

• Display

Specify a layer to be displayed on the window.  The figures of

specified layers, overlaid over each other, are displayed on the

window.  The figure entities of layers that are not displayed cannot be

selected.

• Recognition

Specify whether to select from the figure entities displayed on the

window.  If non-recognition is specified, the figure entities cannot be

selected even if they are displayed.

• Layer name

An arbitrary name can be assigned.
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2.9 Drawing Format Setting

(1) Select Auxiliary => Drawing Format from the menu.

(2) Select the icon corresponding to the desired drawing format.

When using a horizontal lathe, select one of the four drawing formats above.

To facilitate dimension data input at the time of programming, select  or

 when the dimensions of a drawing are described with respect to the left

side; select  or  when the dimensions of a drawing are described with

respect to the right side.

When using a vertical lathe, select one of the four drawing formats listed

below.
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3 PROGRAMMING EXAMPLE

3.1 Flow of Operation

This chapter describes the procedure for creating NC data with Symbolic

CAP T.

3.1.1 Procedure

Symbolic CAP T is used according to the following procedure:

Figure definition

   Blank figure creation       Part figure creation

Pre-machining settings

Machining definition

Machining definition

 Machining process list

NC data preparation

� Turning figure
� Threading figure
� Grooving figure
� Necking figure

� Bar
� Tube
� Special figure

� Home position
� Index position
� NC machine file selection
� Chuck/tailstock data setting

� Rough groove
� Finish groove
� Rough finish groove
� Threading

� Hole
� Rough
� Semi-finish
� Finish
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The user can switch between figure definition and machining definition at

any time.  So, if the user notices a missing figure during machining

definition, it is not necessary to restart from the beginning, thus improving

work efficiency.

3.1.2 Explanation of each step

................... Blank Figure Creation button

Clicking this button allows the user to specify routine blank figures simply

by responding to displayed prompts, and also enter special figures by

applying the symbolic input method. Blank figures can thus be created very

easily.

................ Part Figure Creation button

Clicking this button allows the user to create part figures quickly and easily

by means of the symbolic input method.

................ Pre-machining Setting button

Clicking this button allows the user to enter a home position, index position,

and so forth.

................ Machining Definition button

Clicking this button automatically sets a cutting area and machining

condition according to the type of machining to be performed and the

contents of the cutting condition libraries. It is possible for the entire process

to be set automatically.

................ NC Data Preparation button

Clicking this button allows the user to create NC data for each NC machine,

based on the cutting area and machining conditions determined by

machining definition.
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3.1.3 Example of operation

 Material : A L ∇∇

This section presents an example of the machining performed according to the

above drawing. This example does not use fully automatic process determination,

but assumes that the machining conditions need not be modified.

NOTE

This example assumes that the values of the cutting condition data,

tool/tooling data, NC machine setting, standard value setting, and

operation setting items are the initial values immediately after setup.

WARNING

Before starting machining based on NC data prepared according to

this example, thoroughly check the contents of the NC data to ensure

that the tool path and machining processes are set correctly, and that

the tool will not collide with the workpiece or machine (including the

chuck and tailstock).  Before starting a production run, perform a dry

run to ensure that the tool will not collide with the workpiece or

machine (including the chuck and tailstock).  For example, start the

NC data without mounting a workpiece on the machine.  Any

collision can cause damage to the tool, machine, and/or workpiece,

or injury to the user.
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(1) Blank figure creation

Click the Blank Figure Creation button, then enter data for each item

as follows:

Material A L

Blank figure Tube

Blank size Diameter : 120.0

Inner dia. : 20.0

Length : 65.0

Base point : 5.0

Standard SR : SR-Mark 2

(2) Part figure creation

Click the Part Figure Creation button to display the symbolic input

window. Then, enter part figure data by using the symbolic figure

input buttons, as follows:

Start point Start DX : 30.0

Start Z : 60.0

Straight line End Z:  30.0

Surface:  SR-Mark 2

Chamfer Chamfer:  2.0

Surface:  SR-Mark 2

Straight line End DX:  37.402

Surface:  SR-Mark 2

Grooving Type:  Trapezoid

Surface:  SR-Mark 2

Last or Next:  On Next element

Direction:Up

Width:  15.0

Depth:  5.0

Bottom1:  Angle

Angle:  (Input not required)

Bottom2:  Angle

Angle:  60.0

1st corner:  None

2nd corner:  Chamfer

2nd value:  1.0

3rd corner:  None

4th corner:  None

Straight line End Z:  0.0

Surface:  SR-Mark 2
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Threading Type:  General thread

Last or Next:  On Last

Length:  18.0

Internal

Lead:  2.0

Thread N:  1

Depth:  1.299

Angle:  60.0

Chamfer Chamfer:  2.0

Surface:  SR-Mark 2

Straight line End DX:  (Input not required)

Surface:  SR-Mark 2

Corner R Corner R:  5.0

Surface:  SR-Mark 2

Straight line End DX:  90.0

End Z:  20.0

Angle A:  15.0

Surface:  SR-Mark 2

Corner R Corner R:  5.0

Surface:  SR-Mark 2

Straight line End Z:  40.0

Surface:  SR-Mark 2

Grooving Type:  Normal

Surface:  SR-Mark 2

Last or Next:  On Last element

Direction:Down

Width:  13.0

Depth:  5.0

1st corner:  Corner R

1st value:  1.0

2nd corner:  Corner R

2nd value:  1.0

3rd corner:  Corner R

3rd value:  1.0

4th corner:  None

Straight line End DX:  110.0

Surface:  SR-Mark 2

Chamfer Chamfer:  2.0

Surface:  SR-Mark 2
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Straight line End Z:  50.0

Surface:  SR-Mark 2

Corner R Corner R:  1.0

Surface:  SR-Mark 2

Straight line End DX:  120.0

Surface:  SR-Mark 2

Chamfer Chamfer:  2.0

Surface:  SR-Mark 2

Straight line End Z:  55.0

Surface:  SR-Mark 2

(3) Pre-machining settings

Click the Pre-machining Setting button to display the Setting of Pre-

machining input window. Then, select the tooling and NC machine,

and specify a home position and index position as follows:

Select Tooling:  Tooling 1

Select NC machine:  FS16T/18T (Geometry)

Home position:  DXH = 200.0,  ZH = 200.0

Index position:  DXI = 150.0,  ZI = 150.0

(4) Machining definition

Click the Machining Definition button to display the Machining

Definition window.  Then, select a machining type by clicking the

Machining Type button in the Addition group.
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• Hole machining

   =>   Hole   =>   Drilling

When a machining type is selected, the machining conditions and cutting

area are determined automatically.  To modify the machining conditions,

click the Machining Condition button  to display the Machining

Condition window. To modify the cutting area, first modify the value of

Depth, then click the Auto button.

To change the cutting area, first change the [Bottom Pos.], then click the

[Auto] button.

• Outer surface rough machining (rough end facing)

   =>   Rough   =>   Outer

When a machining type is selected, the machining conditions and cutting

area are determined automatically. To modify the machining conditions,

click the Machining Condition button  to display the Machining

Condition window. To modify the cutting area, select the first and second

division points, move the division points with the cursor keys, then specify

directions with the numeric keypad.
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• Outer surface rough machining

In the above state, click the separate area specification button  . Then,

the machining conditions and cutting area are determined automatically. To

modify the machining conditions, click the Machining Condition button

 to display the Machining Condition window. To modify the cutting

area, select the first and second division points, move the division points

with the cursor keys, then specify directions with the numeric keypad.
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• Inner surface rough machining

   ⇒   Rough   ⇒   Inner

When a machining type is selected, the machining conditions and cutting

area are determined automatically. To modify the machining conditions,

click the Machining Condition button  to display the Machining

Condition window. To modify the cutting area, select the first and second

division points, move the with points the cursor keys, then specify directions

with the numeric keypad.

• Outer surface finish machining

   ⇒   Finish   ⇒   Outer

The machining conditions and cutting area are determined automatically. To

modify the machining conditions, click the Machining Condition button

 to display the Machining Condition window. To modify the cutting

area, select the first and second division points, move the division points

with the cursor keys, then specify directions with the numeric keypad.
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• Inner surface finish machining

   ⇒   Finish   =>   Inner

The machining conditions and cutting area are determined automatically. To

modify the machining conditions, click the Machining Condition button

 to display the Machining Condition window. To modify the cutting

area, select the first and second division points, move the division points

with the cursor keys, then specify directions with the numeric keypad.
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• Outer grooving

   ⇒   Rough Finish Groove   =>   Outer

The machining conditions and cutting area are determined automatically. To

modify the machining conditions, click the Machining Condition button

 to display the Machining Condition window.

• Inner grooving

   ⇒   Rough Finish Groove  =>  Inner

The machining conditions and cutting area are determined automatically. To

modify the machining conditions, click the Machining Condition button

 to display the Machining Condition window.
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• Inner threading

   ⇒   Thread   =>   Inner

The machining conditions and cutting area are determined automatically. To

modify the machining conditions, click the Machining Condition button 

to display the Machining Condition window.
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(5)  NC data preparation

Click the NC Data Preparation button to display the NC Data Preparation

window. Next, click the start button . Then, the NC data is created.

After the NC data has been created, click the execution list display button

 to display the NC data.
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4 BLANK FIGURE CREATION

4.1 Blank Figure Creation

Click  on the side menu to display the following conversational

window:

Material

Select a material name from the displayed list. The material names

registered in the machining condition data are displayed.

Blank figure (Bar, Tube, Special figure)

Select a type of blank figure.

WARNING

Enter correct blank figure data.  Failure to enter correct data may

result in the tool colliding with the workpiece and/or machine,

possibly causing damage to the machine, workpiece, and/or tool

itself, or injury to the user when machining is performed based on the

NC data.
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Standard SR

The value specified here serves as the initial surface roughness for a turning

figure.

Blank size (when Bar or Tube is selected)

Specify the diameter, inner diameter (when Tube is selected), length, and

base point of the blank.

As the base point, specify the distance from the face to the origin of the

program coordinate system.
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4.2 Special Figure

When Special figure is selected, the following conversational window

appears:

Click OK. Then, the special figure creation window appears.

A special figure can be created by means of the symbolic input method.  For

details of the symbolic input method, see Chapter 5.
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NOTES

• When Special figure is selected, a threading figure, grooving figure,

nor necking figure cannot be specified.

• In special figure creation, use the positive area (including 0) along

the X-axis. If a negative X coordinate is specified, machining

definition and animated simulation may not be performed normally.

• For special figure creation, the start point must be the same as the

end point. Otherwise, the warning message shown below is output

when the End button is clicked. If OK is clicked in response to this

message, a connection is automatically established between the start

and end points.

• Create a special figure with a single stroke. Crossing points, like

those shown below, are not allowed.

X

Z

Cross point
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4.3 Blank Figure Color/Line Type Modification

When “Setting => Standard Setting => Blank Figure, Parts Figure” is

selected from the menu bar, the following conversational window appears to

enable blank figure color/line type modification:

The results of a modification made using this conversational window are

reflected when a blank figure is next modified, or a new blank figure is

created.  A light green, thin dotted line is initially set.
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5 PARTS FIGURE CREATION

5.1 Turning Figure Creation

Click the  button on the side menu to display the first symbolic input

window. Note, however, that when a new figure is to be created, the first

symbolic input window is skipped, the second symbolic input window being

displayed immediately.

[First Symbolic Input Window]

New Figure button

This button is used to delete a previously created figure, and create a new

figure.

Modify Figure button

This button is used to edit a part of an existing figure.

Figure Exit button

This button is used to terminate figure creation using the symbolic input

method.

Clicking the New Figure button or Modify Figure button causes the second

symbolic input window to be displayed. On this window, a figure can be

created using the arrow keys.

WARNING

Enter correct parts figure data.  Failure to enter correct data may

result in the tool colliding with the workpiece and/or machine,

possibly causing damage to the machine, workpiece, and/or tool

itself, or injury to the user when machining is performed based on the

NC data.
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Figure Scroll Bar Symbolic List Symbolic buttons
Reference
button

[Second Symbolic Input Window]

Symbolic buttons

The symbolic buttons are used to select the element used to constitute a

figure.

The user can select Straight line, Arc, Round, Chamfer, Grooving,

Threading, and Necking entities. Clicking a symbolic button causes a

conversational window to be displayed, thus enabling the user to enter an

end point and so forth.

Symbolic list

The buttons corresponding to the entities are displayed as a row, called the

symbolic list.  Up to 10 buttons can be displayed at any one time. The

hidden buttons can be displayed by using the scroll bar.

Scroll bar

The scroll bar is used to scroll the symbolic list. The symbolic list can be

scrolled by clicking the left-hand or right-hand arrow button.  A desired

figure entity on the symbolic list can be displayed by clicking and dragging

the corresponding square button on the scroll bar.

The display of the symbolic list can also be scrolled by pressing the Tab key

to move the focus to the scroll bar and then pressing the “←” or “→” key.

Delete button

Clicking this button deletes selected entity from the symbolic list.

Alter button

Clicking this button displays a conversational window for entering data for

selected entities in the symbolic list.

Exit button

Clicking this button terminates figure creation. When the Exit button is

clicked, the end point of each figure entity is automatically calculated.  If an

error is detected in the entered data during end point calculation, an error

message is displayed.

Figure Reference button

Clicking this button registers figures created using the figure creation function or

those entered using the CAD data input function, as entities for creating a figure.
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5.2 Symbolic Input Method

5.2.1 Entity selection

Using the symbolic buttons shown below, select Straight line, Arc, Round,

Chamfer, Grooving, Threading, or Necking entities.

Entities can be selected in either of the following ways:

• Click the desired buttons on the conversational window.

• By using the keyboard, enter the number or alphabet that appears in

the lower-right corner of each desired button on the conversational

window.

For the figure shown above, click the following symbolic buttons in the

order shown around the outline of the figure.
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is represented the end of a figure, and cannot be deleted.

5.2.2 Symbolic figure data input

When a symbolic button is clicked, a conversational window appears to

enable the user to enter an end point and so forth.  On this window, enter

only those items that appear on the drawing.  Any items that do not appear

on the drawing need not be entered.  Click OK or press the Enter key to

create the figure.  A created figure is displayed in the symbolic list.  The

selected entities can be invalidated by clicking the Cancel button or by

pressing the Esc key.

If sufficient data is not entered to create a figure, a warning message is

displayed.

To enter an increment, key in a value followed by the letter I in the edit box.

The direction of increment is indicated using the algebraic sign of the value

entered rather than an arrow.  The value entered in the edit box is converted

to absolute coordinates instantly when the letter I is entered.

Example:  25I

A value corresponding to the current position plus 25 is displayed in the edit

box.
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(1) Start point (Symbolic input)

When the first entity is selected, the following conversational window

appears to prompt the user to specify the start point of the figure:

Parts position for path

Specify the side where the figure to be entered is located, as viewed in

the direction of the arrow for the selected entity.

(2) Straight line (Symbolic input)

When any of symbolic buttons  is

clicked, the following conversational window appears to enable straight

line entity input.

End DX

Enter the X coordinate of the end point of the straight line, using a

diameter value.

End Z

Enter the Z coordinate of the end point of the straight line.

Angle A

Enter the angle between the Z-axis and the straight line.
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(3) Arc (Symbolic input)

When any of symbolic buttons  is clicked, the following

conversational window appears to enable arc entity input

End DX

Enter the X coordinate of the end point of the arc, using a diameter

value.

End Z

Enter the Z coordinate of the end point of the arc.

Radius R

Enter the radius of the arc.

Center CDX

Enter the X coordinate of the arc center, using a diameter value.

Center CZ

Enter the Z coordinate of the arc center.

Tangent Last

Specify whether the arc is tangent to the previous entity.

Tangent Next

Specify whether the arc is tangent to the next entity.

NOTE

Some items may not be displayed, depending on the type of straight

line and the figure data for the previous entity.
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When multiple intersections occur

The following conversational window is displayed if multiple

intersections (contact points) occur when a straight line intersects (or

touches) an arc, or if an arc intersects (or touches) another arc:

Select the position of an intersection, as viewed from the arc center,

with the following buttons:

  :  Up (also selectable with the 8 key)

  :  Down (also selectable with the 2 key)

  :  Left (also selectable with the 4 key)

  :  Right (also selectable with the 6 key)

(4) Chamfer (Symbolic input)

When symbolic button  is clicked, the following conversational

window appears to enable chamfer entity input.
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Chamfer

Enter a chamfer value.

Surface

The standard SR value, set on the conversational window for blank

figure creation, is displayed as the initial value. Change the value

according to the drawing. The feedrate for finish machining is

automatically determined according to the surface roughness set here.

(5) Round (Symbolic input)

When symbolic button  is clicked, the following conversational

window appears to enable round (corner R) entity input.
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Corner R

Enter a radius for corner R.

Surface

The standard SR value, set using the conversational window for blank

figure creation, is displayed as the initial value. Change the value

according to the drawing. The feedrate for finish machining is

automatically determined according to the surface roughness set here.

(6) Threading (Symbolic input)

When symbolic button   is clicked, the following conversational

window appears to enable threading entity input.
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Type

As the type, select General thread, Metric thread, Unified screw, PT/PF

thread, or Trapezoidal screw. Once a type has been selected, the fields

for setting data for that type appear. If PT/PF screw is selected, the taper

angle for threading is not determined. Instead, the angle of the

immediately preceding or following straight line entity is adopted as the

taper angle for threading.

Last or Next

Specify whether to create a threading entity on the next entity or on the

previous entity.  Note that this specification determines the direction of

threading.

When   are clicked in the order shown, and the On Next

entity is selected

When  are clicked in the order shown, and the On Last

entity is selected
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Length

Specify the length of the threading.  When chamfering is used, the

length of the threading must be calculated starting at the intersection of

the straight line entities before chamfering.

External/Internal/Face

Select a threading type. The constant applied to automatic thread depth

calculation varies with the type of the threading. This item is valid only

when automatic thread depth calculation is specified. For some types of

threading, this item need not be selected. The initial values for the

constants are as follows:

External/Face:  0.7578

Internal:  0.6495

When Setting => Parameter Setting => Blank figure, Parts figure is

selected from the menu bar, the conversational window for constant

modification appears.

Lead and Thread N

The lead value is the distance traveled along the Z-axis for each rotation

of the thread.  For a single thread, the lead is equal to the pitch. For an

n-start thread, the lead multiplied by 1/n equals the pitch. For a taper

thread, the lead calculation is made along the Z-axis.

Depth

For a general thread, the thread depth is calculated using the following

formula:

(Thread depth) = ((lead)/(number of starts)) × (thread constant)

When a lead value and a number of starts (Thread N) are set, the thread

depth is calculated automatically. If an automatically calculated thread

depth is modified, however, thread depth calculation is not repeated if

the lead and the number of starts (Thread N) are changed again.
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Angle

Specify a thread angle between 0  and 90 .

When the straight line entity on which a threading entity is placed is

tapered

When the straight line entity is tilted by up to 45 degrees relative to the

Z-axis, the thread is an external thread or internal thread.  When the

straight line entity is tilted by more than 45 degrees relative to the Z-

axis, the thread is a face thread.

When the straight line entity immediately following a threading entity

is tapered

Threading starts at the intersection of the straight line connecting the

thread roots and the subsequent straight line entity.

In this case, note that the length of the thread actually produced will

differ from the specified length.

NOTE

For a unified screw or PT/PF screw, an automatic thread depth

calculation is performed if the number of crests per inch is specified.
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(7) Grooving (Symbolic input)

When symbolic button  is clicked, the following conversational

window appears to enable grooving entity input:

Type

Select Normal, Slant, or Trapezoid as the type of groove.

a. Normal grooving (Symbolic input)

Surface

The standard SR value, set using the conversational window for blank

figure creation, is displayed as the initial value. Change the value

according to the drawing. The feedrate for finish machining is

automatically determined according to the surface roughness set here.

Last or Next

Specify whether to create a groove on the next entity or on the previous

entity.
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When  are clicked in the order shown

Width

Specify the width of a groove.  When a trapezoidal groove is to be

created, specify the width of the opening.  Note that if the groove width

extends over two or more entities, a groove figure cannot be created.

Depth

Specify a groove depth.

Direction

Specify the direction of the groove to be created, by selecting one of the

arrows, as shown below.

1st corner/2nd corner/3rd corner/4th corner

For the corners of a groove, chamfer or corner R can be specified. When

chamfer or corner R is selected, specify a chamfer value or a radius for

corner R in response to the corner value input prompt.

Corner numbers are assigned in the order of the figure advance direction.

When  are clicked
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b. Slanted grooving (Symbolic input)

In addition to the data entry fields for Normal, a field for specifying the

angle is also displayed.

Angle

Specify the angle of the wall of the groove to be created.

When  are clicked in the order shown

c. Trapezoid grooving (Symbolic input)

In addition to the data entry fields for Normal, a field for bottom

specification and another for width specification are displayed.

Bottom1, Bottom2

Select Angle or Width.

Angle

When Angle is selected in bottom specification, specify the angles

shown below. The order in which these angles are specified depends on

the advance direction of the figure.

When  are clicked in the order shown

Width

When Width is selected in bottom specification, set the widths shown

below. The order in which these widths are specified depends on the

advance direction of the figure.
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When  are clicked in the order shown

(8) Necking (Symbolic input)

When symbolic button  is clicked, the following conversational

window appears to enable necking entity input.

Type

Select General, Grinding1, Grinding2, or Threading necking as the

necking type.

When Grinding1 or Grinding2 is selected, a necking width, necking

depth, and corner value are determined automatically (according to the

DIN standard), provided the previous figure has already been defined.

When Threading necking is selected, a necking width, necking depth,

and corner value are determined provided the previous figure has

NOTE

No grooving entity is drawn until the next entity has been determined.
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already been defined, and that that figure is subsequent to a threading

figure.

Surface

The standard SR value, set using the conversational window for blank

figure creation, is displayed as the initial value. Change the value

according to the drawing. The feedrate for finish machining is

automatically determined according to the surface roughness set here.

a. General necking (Symbolic input)

When General is selected as the type of necking, the data entry fields

shown below appear.

Width/Depth/Approach angle/Relief value/Relief height/

Relief angle

1st corner/2nd corner/3rd corner/4th corner/5th corner

For necking angle setting, chamfer or corner R can be specified.  When

chamfer or corner R is selected, specify a chamfer value or a radius for

corner R in response to the prompt for corner value input.
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Numbers are assigned to the corners of a necking figure as shown

below.

b. Grinding necking 1 (Symbolic input)

When Grinding1 is selected as the type of necking, the data entry fields

shown below appear.

Width/Depth/Approach angle/1st corner/2nd corner

The initial width, depth, and corner value indicated in the table shown

below are set.  An approach angle of 15 degrees is initially set.

c. Grinding necking 2 (Symbolic input)

When Grinding2 is selected as the type of necking, the data entry fields

shown below appear.

Width/Depth/Approach angle/Relief angle/Relief value/1st corner/2nd

corner

The initial width, depth, relief value, and corner value indicated in the

table shown below are set.  An approach angle of 15 degrees, and a

relief angle of 8 degrees are initially set.
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The initial values indicated in the table shown below are set in the fields

for Grinding1 and Grinding2, according to the X coordinate of the

previous straight line entity:

Diameter

(X coordinate)

Width Depth Corner

value

Relief

value

Less than 18 mm

Less than 0.7087 inch

2.0 mm

0.0787 inch

0.25 mm

0.0098 inch

0.6 mm

0.0236 inch

0.1 mm

0.0039 inch

18 mm to 80 mm

0.7087 to 3.15 inch

2.5 mm

0.0984 inch

0.35 mm

0.0138 inch

0.6 mm

0.0236 inch

0.2 mm

0.0079 inch

80 mm or more

3.15 inch or more

4.0 mm

0.1575 inch

0.45 mm

0.0177 inch

1.0 mm

0.0394 inch

0.3 mm

0.0118 inch

d. Threading necking (Symbolic input)

When Threading necking is selected as the type of necking, the prompts

shown below appear.

Width/Depth/Approach angle/1st corner/2nd corner

The width, depth, and corner value calculated using the formulas given

below are initially set. The pitch and thread depth values entered for the

subsequent threading entity are used. If the subsequent entity is other

than a threading entity, no initial value calculation is performed.

Width = 3.5 × pitch

Depth = 1.2 × thread depth

Corner value = 0.5 × pitch
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An approach angle of 30 degrees is initially set.

5.2.3 Symbolic Figure data editing

(1) Selecting entities (Symbolic Figure data editing)

The symbolic list button for the currently selected entity is displayed as

though it has been physically pressed. To select another entity, click the

corresponding button in the symbolic list.

The currently selected entity can be shifted one entity to right by pressing

the + key on the keyboard. Similarly, the currently selected entity can be

shifted one entity to left by pressing the – key.

(2) Deleting entities (Symbolic Figure data editing)

To delete an entity, select the entity from the symbolic list, then click the

Delete button. When an attempt is made to delete the first entity, the

conversational window for setting a start point is displayed. Specify an

appropriate start point.

(3) Inserting entities (Symbolic Figure data editing)

To insert an entity between another two entities, select the latter of the two

entities in the symbolic list. Then, from the symbolic buttons, select the

entity to be inserted. The conversational window for the selected entity is

displayed.  Then, enter the required data.

NOTE

• A necking entity is not drawn until the next entity has been

determined.

• Necking cannot extend over three or more successive entities.

• A necking entity must be created between a horizontal straight line

and a vertical straight line.
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(4) Modifying figure data (Symbolic Figure data editing)

To modify figure data select, from the symbolic list, the entity to be

modified, then click the Alter button. The conversational window for the

selected entity appears. Then, modify the data as required. When an

attempt is made to modify the first entity, the conversational window for

setting a start point is displayed.  Specify an appropriate start point.

(5) Redo and undo (Symbolic figure input)

During symbolic input, the redo and undo operations are disabled.  If a

redo operation is performed after the completion of symbolic input, the

state existing before the start of symbolic input is restored.  Subsequently

performing an undo operation would restore the state existing at the

termination of symbolic input. So, to abandon the editing of a figure for

whatever reason, terminate symbolic input, then execute the undo

operation.

(6) Color/line of parts figure

When Setting => Parameter Setting => Blank Figure, Parts Figure is

Changeselected from the menu bar, the conversational window enabling

part figure color/line modification appears.

NOTE

If the figure data is edited, the drawing may not be updated

immediately.  This is because intersection calculations will not yet

have been made for the entities subsequent to that currently selected

in the symbolic list.  By advancing from the currently selected entity

to the next, the intersection calculation required to update the

drawing can be instigated. Note that the drawing of an entity such as

a chamfer entity, round entity, threading entity, grooving entity, and

necking entity is not updated until the next entity is selected.
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Select the item to be modified, then modify its color and line width.

Multiple figure types can be selected together for color and line

modification. If modification is performed during symbolic input, the

modification is not immediately reflected in the drawing; the modification

is not reflected in the drawing until after symbolic input has terminated,

and the next symbolic input operation is started.

The initial settings are as follows:

Parts figure :  Light red

Undefined :  Pale yellow

Threading/grooving/necking :  Light blue

Selected figure :  Pale yellow

Selected point :  Light blue

5.2.4 Symbolic figure creation by figure reference

(1) Overview (Symbolic figure creation by figure reference)

By means of the symbolic input function, the user can create a symbolic

figure by entering figure-related data on the input window from the

keyboard.  With the symbolic figure creation function based on figure

reference, however, the user creates a symbolic figure by selecting a figure

that was previously created by using the drawing function, rather than by

entering figure data from the keyboard.

Thus, the user can create a symbolic figure as if the selected figure data

had been automatically entered with the data input window.

The symbolic figure creation function based on figure reference can be

used to create parts figures and special figures.

Figures that can be referenced

(a) Figures created with the figure creation function

(b) Figures entered with the CAD data input function

(c) Figures created with the figure creation function of the FANUC

PC FAPT series

Types of figures that can be referenced

(a) Straight lines parallel to the machining plane

(b) Circles parallel to the machining plane

(c) Arcs parallel to the machining plane

(d) Polylines/polygons parallel to the machining plane

(e) Fitting curves parallel to the machining plane
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(2) Operation (Symbolic figure creation by figure reference)

The creation of a symbolic figure by means of figure reference is outlined

below.

            (a)

               (b)

¬ Display the second symbolic input window, then click button (a). A

symbolic figure is created immediately before the selected button.

 

­ Click button (b). The symbolic figure creation function based on

figure reference is started.

 

® If selected button (a) is located at the start entity, the prompts related

to the start point and parts position for the path are displayed as

described below.

• When an end point of a figure to be selected is used as the start

point, never select check box (c).

• When an arbitrary point is selected as the start point, select

check box (c), then enter a desired start point.

• When a part figure is to be created, select Parts position for path.

(c)
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¯ To enable the user to select a reference figure, the following prompts

appear:

(d)

• Select an entity from the window.

• To perform trimming between the currently selected entity and

the next entity to be selected, click YES in box (d).

• Click the End button or the Esc button to terminate the symbolic

figure creation function based on figure reference, and return to

the symbolic figure input window.

• When the  button is clicked, the symbolic figure entity

registered last is deleted. Note that it is not possible to delete

symbolic figures that were already registered before the symbolic

figure creation function based on figure reference was started.

° Depending on the type of a selected figure, the prompt shown below

may appear to enable the user to specify the direction of the entity.

(i) When the selected figure is other than a circle

In response to the prompt shown below, select a desired end side for

the entity.
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• When the  button is clicked, the currently selected entity is

canceled, and the prompts for entity selection (4) reappear.

(ii) When the selected figure is a circle

The prompt shown below appears.  When the Yes or No button is

clicked, a symbolic figure is created.  When the Cancel button is

chosen, no symbolic figure is created, and the prompts for entity

selection ¯ reappear.

± When symbolic figure creation terminates normally, the window

displays an X at the end point position. Then, the prompts for entity

selection ¯ reappear.

² Repeat steps ¯ through ° to complete symbolic figure creation.

NOTE

When a symbolic figure is created by figure reference, not all figure

data is referenced, instead only that data necessary for symbolic

figure creation being referenced.

For a symbolic figure created by figure reference, the standard SR is

already set.

Referenced figures are neither deleted nor deformed as a result of

being referenced.

If you want to change the end point of a symbolic figure entity

fetched through figure reference, turn on the [Specify End Point]

check box.

A figure to be fetched through figure reference must be continuous.
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6 PRE-MACHINING SETTING

Pre-machining settings consist of the following:

• Selecting tooling data

• Selecting an NC machine file

• Setting the home position

• Setting the index position

• Setting and selecting a chuck

[Example of the Pre-Machining Setting Window]
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6.1 Selecting Tooling Data

Clicking  of Select Tooling displays a list of available tooling data.

Select the tooling data to be used.
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6.2 Selecting an NC Machine File

Clicking  of Select NC machine displays a list of available NC

machines.  Select the NC machine to be used.

After the user selects the NC machine, the home position and index position

are automatically changed to the values in the selected NC machine file.

WARNING

Select an NC machine file that matches the CNC machine tool to be

used.  If a mismatching NC machining file is selected, NC data that

does not match the machine tool to be used is output.  This may

result in the tool colliding with the workpiece and/or machine,

possibly causing damage to the machine, workpiece, and/or tool

itself, or injury to the user.
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6.3 Setting the Home Position

Set the home position.  As the initial home position, the values set in the

currently selected NC machine file are displayed.

NOTE

This setting item can be suppressed by setting of Setting =>

Parameter Setting => Setting of Pre-machining.

WARNING

Set correct home position data.  Failure to set correct data may

result in the tool colliding with the workpiece and/or machine,

possibly causing damage to the machine, workpiece, and/or tool

itself, or injury to the user.
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6.4 Setting the Index Position

Set the index position. As the initial index position, the values set in the

currently selected NC machine file are displayed.

When Setting of Pre-machining is terminated after the index position has

been set, the machining start position for the previously defined machining

is calculated automatically.

NOTE

This setting item can be suppressed by setting of Setting =>

Parameter Setting => Setting of Pre-machining.

WARNING

Set correct index position data.  Failure to set correct data may result

in the tool colliding with the workpiece and/or machine, possibly

causing damage to the machine, workpiece, and/or tool itself, or

injury to the user.
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6.5 Setting the Chuck

Clicking the  button displays the window shown below.  Using this

window, chuck data can be set.

The chuck selected using this window will be displayed during animated

simulation when the NC data is prepared.

6.5.1 Setting items of the chuck

On the window, set the following items:

(1) Currently Selected Chuck

Set the chuck figure to be used for animated simulation, as well as the data

for positioning the chuck.  The values set here are stored in a part file which

is prepared for each program. Animated simulation is based on the values

stored in this file.

Chucking Depth ZC

To prevent a workpiece from being held by the chuck at the innermost

position, set this item.  If this item is not set, the workpiece is held by the

chuck at the innermost position.

WARNING

Be sure to set correct chuck figure data when making a tool and

check interference check with the animated simulation function.  If

incorrect chuck figure data is entered, the animated simulation

function cannot make an interference check correctly.  This may

result in the tool colliding with the chuck, possibly causing damage to

the machine, workpiece, and/or tool itself, or injury to the user.
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Holding Diameter XC

When a blank having an special figure is to be used, specify the workpiece

holding diameter for the chuck.  If the blank is a bar or tube, this item

need not be set.  If no value is specified, the diameter presented to the end

face near the chuck is assumed to be the holding diameter.

Current Selected Chuck

Data for the currently selected chuck is displayed. Double-clicking the

chuck displays the registration/edit window, with which the user can edit

figure data directly.

To select a chuck from the Registered Chuck list, click the desired chuck,

then click the following:

To store the currently selected chuck figure by adding it to the Registered

Chuck list, click the following:

(2) Registered Chuck

In Registered Chuck, the chuck figure data to be used for animated

simulation is registered or edited. The displayed chuck data is stored in

the chcktail.ctf file. This file is stored under the directory containing Tool,

Tooling as set in Environment.

Work
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To register chuck figure data, click the following:

Then, the registration/edit window appears.

To edit chuck figure data, double-click the desired chuck. Alternatively,

select the desired chuck, then click the following:

Then, the registration/edit  window appears.

To delete a registered chuck, select the chuck, then click the following:

6.5.2 Chuck figure registration/edit window

Clicking the Edit button on the Selection /Register of chuck data window

causes the following window to appear:

Data set using this window is stored in the chcktail.ctf file. This file is

stored under the directory containing Tool, Tooling as set in Environment.
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Set the following items using this window:

Name

Specify a chuck name using up to 15 characters or up to 7 double-byte

characters. Each name must be unique within the list.

Type

Select outer claw or inner claw type.

L, L1, W, W1

Set the figure data indicated in the guidance drawing.
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7 MACHINING DEFINITION

Symbolic CAP T supports the following machining operations:

• Hole

• Rough

• Semi-finish

• Finish

• Rough Groove

• Finish Groove

• Rough Finish Groove

• Threading

NOTE

When the blank figure and part figure have not yet been defined, the

machining definition window is not displayed.
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7.1 Machining Definition Window

Clicking the  button on the side menu displays the machining

definition window. Using this window, the user can define the machining to

be performed.

The machining definition window is shown below.

The functions of the machining definition work buttons are as follows:

 : Add the machining definition.

 : Changes the machining contents.

 : Deletes the machining definition.

 : Specifies automatic process determination.

 : Ends machining definition, and displays the side menu again.

NOTE

The machining definition work buttons may be enabled or disabled

as follows, according to the machining definition status:

Enabled Disabled
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7.2 Selecting the Machining Type

Clicking the  button displays the following Machining Type major

classification menu:

Position the cursor to a desired item.  Then, the detail menu appears.  Select

the machining type to be defined.

[Example of Detail Items for Rough]

After the machining type has been selected, the cutting area, tool, and

machining conditions are determined automatically, then the cutting area

definition window, shown below, appears in the prompt area.

When the cutting area cannot be determined automatically, the 

button is disabled .

[Example of the Cutting Area Definition Window for Rough (Outer)]
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Clicking the  button defines the machining data and returns the

display to the machining definition window.

Clicking the  button does not define the machining data and returns

the display to the machining definition window.

The user can manually modify the automatically set data.  When the area

and conditions for the selected machining type cannot be determined

automatically, the cutting area definition window appears, but with the

 button disabled.  Enter the required data manually.

Even after the user has manually entered area and condition data, the 

button may remain disabled.  This indicates that machining cannot be

performed under the specified conditions.  Click the  button to

terminate the procedure, or check and correct the conditions and other data

again.

NOTE

The cutting area definition window varies depending on the selected

machining type.
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7.3 Specifying the Cutting Area and Condition Data

The cutting area definition display supports the following three functions:

• Cutting area definition function

• Condition setting function (  button)

• Function for defining another area (  button)

7.3.1 Specifying the Cutting Area

(1) Hole (center drilling, drilling, reaming, tapping)

Set the hole diameter and bottom position.  (For tapping, also set a lead

value.)  After setting the necessary data, click the  button.  Then,

the tool and machining conditions are determined automatically.

(2) Rough, Semi-finish, Finish (Normal) (Outer, Face, Inner)

Specify the cutting direction, first division point, second division point,

and the dividing direction at each division point to determine the cutting

area for rough machining, semi-finish machining, and finish machining

with a normal tool.

(a) Specifying the cutting direction

Specify the cutting direction as one of the following four directions:

  :  8 key of numeric keypad

  :  2 key of numeric keypad

  :  4 key of numeric keypad

  :  6 key of numeric keypad

NOTE

For Bottom position, specify the tool tip position as an absolute
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(b) Specifying the dividing direction

First division point: Indicated by a white arrow

Second division point: Indicated by a green arrow

• Specify the location of a division point.

Pressing a cursor key causes a division point to move together with

an arrow.  Set the arrow at one end of the cutting area.

If you want to move the division point to an arbitrary location, key in

“0” from the numeric key pad.  You will be prompted to specify the

desired location.  When you specify the location of the division point,

a point on the parts outline that has the specified location as its

neighborhood point is calculated, and the division point is shifted to

the calculated location.  At the same time, the cutting area is re-

created.

• Specifying the direction of an arrow for the division point

Select the direction of division from the following eight arrows using

the numeric key pad.  Specifying the direction of division causes an

area that can be cut with the currently selected tool and under the

currently selected cutting conditions to be drawn.

Direction of Corresponding

division numeric keys

If you want to specify an arbitrary angle, key in “5” from the numeric key

pad.  You will be prompted to specify the desired angle.  The specification

of the angle does not depend on the drawing format.

The counterclockwise rotation is represented as a positive number, and the

clockwise rotation, as a negative number.  The direction of the arrow is set

to the specified angle.  At the same time, the cutting area is re-created.
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(3) Rough, Semi-finish, Finish (Reverse) (Outer, Face, Inner)

When an area is left uncut after machining with a normal tool, it can be

cut with a reverse tool. Whenever such an uncut area exists, the selected

part of the area is drawn. When more than one such area exists, an area

can be selected by using the area select buttons ( ).

An area can also be defined by specifying the cutting direction and

division points.

NOTE

Only one direction is determined automatically for the area dividing

arrow, depending on the machining type:  Outer-surface cutting,

inner-surface cutting, or end facing.  So, it is not necessarily optimal.

NOTE

When the division points are specified, they can be moved to an end

point of a linear entity, end point of an arc entity, and quadrant

division point. To return the cutting area to the previous area, use the

area select button.

NOTE

The commands for specifying the cutting direction and division point

for this machining type are the same as those for roughing,

semifinishing, finishing (forward) (outer-surface, inner-surface

cutting, and end facing).
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(4) Groove (Rough, Finish, Rough/Finish)

Clicking  displays the following, allowing the user to

select one of four groove types:

When more than one area exists when Normal, Trapezoid, or Slant is

selected, an area can be selected by using the area select buttons

( ). The selected groove area is drawn in a different

color.

When Free groove is selected, specify two division points to specify an

area in the same way as when Rough, Semi-finish, or Finish is selected.

(5) Thread (Outer, Front, Inner)

NOTE

When Normal, Trapezoid, or Slant is selected, a groove area created

with figure definition “G” must be specified for machining.  When

Free groove is selected, any figures including figures created with “G”

can be machined.

NOTE

The commands for specifying the division point for this machining

type are the same as those for roughing, semifinishing, finishing

(forward) (outer-surface, inner-surface cutting, and end facing).
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Cutting area

Boundary
entity

Division point

Parts figure

Blank figure

Boundary entity

X

Z

When more than one area exists for threading, use the area select buttons

( ) to select an area.  The selected threading area is

drawn in a different color.

7.3.2 Location of the division point and the cutting area

The cutting area is a portion enclosed using lines indicating the direction of

the arrow at the division point, the blank figure, and parts figure.  A line

indicating the direction of an arrow is referred to as a boundary entity.  The

way a boundary entity is handled changes with the location of the division

point.  So, the resulting cutting area takes a different figure depending on

the location of the division point.

The boundary entity has either of the following two attributes depending

on the location of the division point.

¬ Portion of a parts outline

­ Boundary line on the tool-nose radius center

In a boundary entity with attribute ¬, the boundary entity is provided with

the same finishing allowance as for a parts outline (even for machining type

other than finishing).

WARNING

Set correct cutting area data.  Failure to set correct data may result

in the tool colliding with the workpiece and/or machine, possibly

causing damage to the machine, workpiece, and/or tool itself, or

injury to the user.
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Blank figure

Cutting areaBoundary entity

Boundary entity

Parts
figure

X

Z

Finishing amount

Tool-nose radius

In a boundary entity with attribute 2, the actual cutting area extends beyond

the boundary entity by the tool-nose radius, because the tool-nose radius

center lies on the boundary entity.

There are two boundary entities for one cutting area.  Each boundary entity

may have a different attribute depending on the location of each division

point.  The relationships between the division point and the related attribute

are described below.

(1) If a division point is at one end of a parts entity and the angle formed

by parts at the division point is smaller than 180 degrees:

If a division point is at one end point of an entity (line segment or

arc) forming a parts figure, and the angle formed by parts entities at

the division point is smaller than 180 degrees, the boundary entity

has the “portion of a parts outline” attribute.

Angle formed

Division point Parts
figure

X

Z

Blank figure

Finishing amount

Cutting area

Blank figure

Boundary entity

Boundary entity

Parts
figure

X

Z

Finishing amount
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(2) If a division point is at one end of a parts entity and the angle formed

by the parts entity and an adjacent part is larger than 180 degrees:

If a division point is at one end of a parts entity and the angle formed

by the parts entity and an adjacent part included in the cutting area

side is larger than 180 degrees, the boundary entity has the “portion

of a parts outline” attribute.

‚ È‚ ·Š p“ x

• ªŠ „“ _• ”• i

‘ f•Þ

(3) If two division points coincide:

If two division points coincide, the boundary entity has the “portion

of a parts outline” attribute.

• ªŠ „“ _
• ”• i

‘ f•Þ

X

Z

Parts figure
Division point

Blank figure

X

Z
Blank figure

Parts figure Division point

Angle
formed
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(4) Other than cases (1), (2), and (3)

If a division point is not in any of cases (1), (2), and (3), the boundary

entity has the “boundary line on the tool-nose radius center” attribute.

• ªŠ „“ _

• ”• i ‘ f• Þ

• ªŠ „“ _

• ”• i ‘ f• Þ

Blank figure

Division
point

Parts figure

Blank figureParts figure

Division
point

X

Z
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7.3.3 Condition setting

Clicking the  button displays a condition setting data window.  On this

window, the following condition data can be changed and modified:

• Machining condition data

• Tool data

• Start position/pass position data

[Example of Condition Setting Window

(Outer Rough Machining)]

Clicking a button displays the corresponding setting window.
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[Example of Tool Data Setting Window]

[Example of the Machining Start Pass Position Setting Window]
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On the condition setting window, the  button is provided for each item.

Clicking this button displays an explanatory drawing that describes the

data items to be set.  Then, the user can set that data.

[Example When the  Button for Clearance Amount is Clicked]

The  button is provided for each item on each window.  For an

explanation of the data to be specified, refer to the corresponding window.

7.3.4 Specifying Another Area

A different area can be machined using the same tool by specifying that area

with the  button.

¬ First, move the division points to the area to be machined.  Specify a

tool and the machining conditions as necessary. Then, click the 

button.  This defines the first area.

WARNING

Set correct machining condition data.  Failure to set correct data may

result in the tool colliding with the workpiece and/or machine,

possibly causing damage to the machine, workpiece, and/or tool

itself, or injury to the user.
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­ Then, move the division points to the area to be machined next. The

dividing direction and machining conditions can all be changed. The

tool, however, cannot be changed.

® When no further cutting areas remain to be specified, click the

 button to terminate the specification.
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7.4 Changing and Modifying the Machining Process

After machining definition, the machining definition window is displayed,

as follows:

[Example of List Window Displayed after Machining Definition]

(1) Modifying the process

Modify the process in either of the following ways:

• Position the cursor to the area line to be modified in the process list,

then click the  button.  Then, a prompt for selecting the item

to be modified is displayed as shown below.  Select the desired item.

• Position the cursor to the area line to be modified in the process list,

then double-click that line.  The cutting area definition window

appears.  Using this window, the user can make the necessary

modifications.

(2) Adding a machining process

To append a new machining process to the end of the process,

perform the following procedure.
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• Position the cursor to the end of the process list, click the 

button, and select the machining type to be added.

[Positioning of Cursor to Add a Machining Process]

To insert a machining process at a point in the middle of a process, perform

the following procedure.

• Position the cursor to the point immediately after the machining

number line in the list into which a machining process is to be

inserted.  Click the  button and select a machining type to

be added.

[Positioning of Cursor to Insert a Machining Process]

(3) Deleting a machining process

To delete a machining process, position the cursor to that machining

process, and click the  button. Then, deletion is performed

according to the cursor position, as follows:

• When the cursor is positioned to the machining name

All areas subject to that machining process are deleted.

• When the cursor is positioned to an area line

Only the specified area is deleted.

NOTE

In the example shown below, a new machining process is added

between machining process 3 and 4.
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7.5 Defining New Machining Process

To delete all defined processes and define a new process, apply either of the

following two methods:

• Delete all machining process on the machining definition window.

• Select “File => Clear Machining data” from the menu bar.
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7.6 Fully Automatic Determination

The fully automatic determination function automatically performs

machining definition by using blank figure, part figure, and automatic

determination data.

Click the  button on the machining definition window. Then, the

machining process will be determined automatically.

Automatic determination uses the tooling data and machining condition

data. The processing is performed according to the machining procedure

specified in a machining procedure group. Therefore, these data items must

be set in advance.

Clicking the  button displays the following prompt area.

 : Selects a machining procedure group.

 : Starts fully automatic determination.

 : Sets machining procedure data and other data.

 : Ends fully automatic determination.
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(1) Setting a machining procedure group

Clicking the  button displays the window for setting automatic

determination data.

: Adds or inserts a machining process.

: Deletes the machining process, to which the cursor is 

positioned, from the list.

: Registers the machining procedure group being edited.

: Returns the machining procedure data being edited to its 

original state.

: Ends the setting of automatic determination data.

: Starts fully automatic determination.

: Not used

(2) Selecting and renaming a machining procedure group

Clicking  displays the following, allowing the user to

select a desired machining procedure group.  Selecting a group causes the

display to change from the list to the contents of the selected group.

When group “************” is selected, a new group can be added.
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To rename a group name, enter a new name in response to the prompt, as

follows:

(3) Adding or inserting a machining process

¬ To append a machining process to a list, position the cursor to the

last line of the list.

­ To insert a machining process, position the cursor to the line

immediately after the point where the machining is to be inserted.

® Click the  button.  Then, a two-level menu appears.  Select

the machining process to be added or inserted.

[Example of Selecting Outer Rough Machining]

WARNING

When using the fully automatic process determination function,

correctly set all the data required for automatic determination

including blank figure data, part figure data, tooling data, cutting

condition library data, machining method group data, standard value

setting data, and operation setting data.  If any incorrect data is set,

an incorrect machining process is automatically determined.  This

may result in the tool colliding with the workpiece and/or machine,

possibly causing damage to the machine, workpiece, and/or tool

itself, or injury to the user.
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8 NC DATA PREPARATION

8.1 Preparing and Displaying NC Data

Click the NC data preparation button. On the NC data preparation window,

shown below, specify a program number, program name, and output file

name, then click the NC data preparation start button. Then, NC data

preparation starts.  Once NC data preparation has been completed, click the

execution list display button. Then, the NC data appears.

: NC data preparation button

: NC data preparation start button

: Execution list display button
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8.2 NC Data Preparation Window

Clicking the NC data preparation button causes the above NC data

preparation window to appear.  On this window, operation and setting

related to NC data preparation can be performed.

: NC data preparation button

• Program No.

Specify an O number for the NC data.

• Program Name

Specify a program name (comment) for the NC data.

• Output File Name

Set the name of the file to which NC data will be output. The

directory specified by “Setting => Parameter Setting” is used. When a

directory has been specified in the Output File Name field, that

directory is used.

: Output file name reference button

Clicking this button causes the file select window to appear. Using this

window, a search can be made for an NC data output file or such a file can

be specified.

Delete Tool Path button

Clicking this button causes the Delete Tool Path dialog box to appear.  In

this dialog box, specify the cutting area for a tool path to be deleted.
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: Execution list display button

Clicking this button causes an execution list to appear. This allows the user

to edit, print, and transfer NC data.

: Machining process list display button

Clicking this button causes a machining process list to appear.

: Line drawing button

Clicking this button causes a line drawing to be produced.

: Animated simulation button

Clicking this button starts animated simulation.

: Redraw button

Line drawing •  The tool path is erased, and other entities are redrawn.

Animation •  The blank is initialized.

: NC data preparation start button

This button is used to start NC data preparation.

NOTE

Tool paths for standard machining are prepared based on machining

definition data during NC data preparation.  If there is already a tool

path, changing cutting conditions using machining definition does not

re-prepare the tool path.

To enable machining definition changes for standard machining, it is

necessary to delete tool paths before NC data preparation.

To use this function, it is necessary to previously enable the tool path

editing function using the following commands:

Setting => Parameter Setting => Overall Setting for Symbolic CAP T

... on the menu bar

Use for Tool Path Editing Function in the dialog box for setting the

overall attribute of Symbolic CAP T.
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: NC data preparation pause button

Clicking this button pauses NC data preparation. To continue the

preparation processing, click the NC data preparation start button or NC

data preparation step execution button.

: NC data preparation step execution button

Each time this button is clicked, one step of the NC data preparation

processing is executed. Note, however, that each click of this button does not

necessarily correspond to the output of one block of data.

: NC data preparation stop button

Clicking this button terminates NC data preparation.

: NC data preparation setting window display button

Clicking this button causes the window for setting the data required for NC

data preparation to appear. For details, see the description of the NC data

preparation setting window.

: NC data preparation end button

Clicking this button terminates NC data preparation.
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8.3 Process Order Editing Window

The process order editing window supports the following functions:

• Changing the order in which NC data is prepared

The order in which NC data is prepared can be changed by moving

processes as required.  Specify the range of the processes to be moved

in the list, then click the Move button.  The window changes to that

shown below.  Position the cursor to the move destination process

number (the specified processes will be moved to a point immediately

above the destination process number), then click the OK button.
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• Selecting the processes for which NC data will be prepared

By selecting processes from the list, NC data will be prepared only

for those processes.

Clicking the Select All button selects all the processes.

• Specifying whether interference check will be performed during C/Y-

axis machining

It is possible to specify whether an interference check will be

performed during C/Y-axis machining.  Specify the range of

processes for which an interference check will be performed (or will

not be performed) in the process list, then click the Yes or No button.

• Initializing the order in which NC data is prepared

Clicking the Default Order button cancels the results of editing

performed on this window and restores the default order.

NOTE

This field is displayed only when the optional C/Y-axis module is

installed.

WARNING

After process sequence editing, ensure that correct machining

sequence data is set.  If incorrect machining sequence data is set,

the tool may collide with the workpiece and/or machine, possibly

causing damage to the machine, workpiece, and/or tool itself, or

injury to the user.
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8.4 NC Data Preparation Data Setting Window

• Working Animation

Select this item to enable animated simulation.

• Output Mode

Specify the NC data output mode.

• Sequence No. Output

Specify whether to output sequence numbers, and also specify the

number output pattern.
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8.5 Animation Window

Symbolic CAP T enables animated simulation for NC data to be performed

while the NC data is being prepared. If the tool interferes with anything, it is

drawn in purple.  However, the color of an inner surface drawn in gradation

is not changed even if it interferes with the tool. For animated simulation,

the following settings can be performed:

• Rotation

The blank rotates.  A value from 0° (side face) to 90° (end face) can be set.

• Speed

The tool movement speed can be changed. A value of between 1

(minimum) and 100 (maximum), or MAX. (only the point of each block is

drawn) can be set.

• Tool bar

: Redraw button

The blank is initialized.

: Automatic Scale button

The display scale is automatically adjusted so that the entire blank fits into

the animated simulation window.
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: Partial Enlarge button

Part of the displayed data is enlarged.

: Double Enlarge button

The display scale is enlarged by a factor of 2, with the center of the

animated simulation window used as the reference.

: Half Reduction button

The display scale is reduced by a factor of 2, with the center of the

animated simulation window used as the reference.

: Display Area Move button

The display area is moved in parallel.

: Cutting Surface Display button

When a C/Y-axis machining surface is displayed on the animated

simulation window, the previous cutting surface is displayed.

: Animated simulation data setting window display

button

Clicking this button causes the window for setting the data required for

animated simulation to appear.
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8.6 Data Setting Window for Animated Simulation

This window is used to set the drawing pattern for the blank.

• Full Graduation

Full graduation is applied. Note that the cutting status and the inner

surface, as viewed from the side face, cannot be shown.

• 3/4 Graduation

Drawing is produced with one-fourth graduation omitted. During

cutting, the drawing is always displayed in this state.

• Holder ON

Both the tip and tip holder are drawn.

• Holder OFF

Only the tip is drawn. Drawing requires less time than when Holder

ON is selected.
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8.7 Writing NC Data to a Floppy Disk and Transferring NC Data to
      a Peripheral Device

When the execution list is displayed, and the NC data output command is

selected, the file transmission tool is activated. The file transmission tool

can be used to transfer data to floppy disks and peripheral devices. For

details, see the description of the File Transmission Tool.
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8.8 Printing NC Data and a Process Table

An execution list and process table can be printed by selecting the File =>

Print command from the execution list and process table.
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9 TOOL PATH EDITING

This section explains how to edit tool paths you prepared.

9.1 Tool Path Editing

The tool path editing function enables editing tool paths generated on

Symbolic CAP T as figure images, using a mouse.  It is possible to re-

prepare NC data from edited tool paths.

9.1.1 Tool paths subjected to editing

The following three types of tool paths can be edited.

• Tool paths generated for standard machining on Symbolic CAP T

• Tool paths generated using the machining macro execution function

of Symbolic CAP T

• Tool paths generated using the user customization function of

Symbolic CAP T

Tool paths for standard machining are prepared based on machining

definition data during NC data preparation.  If there is already a tool path,

changing cutting conditions using machining definition does not re-prepare

the tool path.

To enable machining definition changes for standard machining, it is

necessary to delete tool paths before NC data preparation.

To use this function, enable the tool path editing function using the

following commands:

(1) Setting => Parameter Setting=> Overall Setting for Symbolic CAP T

... on the menu bar

WARNING

After tool path editing, ensure that the correct tool path data is set.  If

incorrect tool path data is set, the tool may collide with the workpiece

and/or machine, or forced machining may occur, possibly causing

damage to the machine, workpiece, and/or tool itself, or injury to the

user.
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(2) Use (U) for Tool Path Editing Function in the dialog box for setting

the overall attribute of Symbolic CAP T.

9.1.2 Unit of editing

Tool paths are edited in machining process units.  If there is a machining

subprocess, however, they are edited in subprocess units.

9.1.3 Coordinate system used for tool path editing

When a tool path is edited, the machining surface on which the tool path lies

is caused to face the front.  The drawing coordinate system is set on the

machining surface.  If a machining surface is cylindrical, however, no tool

path is drawn for it.

9.1.4 Editing

A tool path consists of two types of entities:  Movement entity (line/arc) and

auxiliary entity (POST statement).  Commands related canned cycle, C-axis

rotation, and feedrate are categorized as auxiliary entities.  Only movement

entities can be edited using the tool path editing function.  They can be

submitted to the following types of editing:

• Erase movement entities.

• Add movement entities.

• Trim/Extend movement entities.

• Round or chamfer a corner between movement entities.



B-62824EN/02 9.  TOOL PATH EDITING

-129-

9.2 Execution of Tool Path Editing

Clicking the  button in the side menu causes the Tool Path Editing

dialog box to appear.  In this dialog box, you can edit tool paths.  If there is

no tool path, the following message appears, and the Tool Path Editing

dialog box does not appear.

NOTE

Editing executed using this function cannot be undone.
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9.3 Tool Path Editing Dialog Box

If there is a tool path, the following Tool Path Editing dialog box appears.

9.3.1 Machining process list

Previously defined processes are listed in the Tool Path Editing dialog box.

The Kind of Machining, Machining Plane, and status of editing are

displayed for each machining process.  The following symbols are used to

indicate the status of editing, and appear in the Edit column.

NG : There is no tool path.

OK : There is a tool path, which has not been edited.

** : There is a tool path, which has been edited.

9.3.2 Selecting a tool path for editing

Clicking the  button selects a tool path for a process specified in

the Tool Path Editing dialog box as a target of editing.  If you do not know

the process to which the desired tool path belongs, click the 

button to select the desired tool path in the box, and the corresponding

process will be selected in the process list.
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9.3.3 Deleting tool paths

Clicking the  button deletes a tool path for a process selected in

the Tool Path Editing dialog box.  Erasure executed using this function

cannot be undone.

9.3.4 Terminating tool path editing

Clicking the  button terminates tool path editing.
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9.4 Editing Movement Entities

Clicking the  button in the Edit Tool Path dialog box changes

the display in the prompt area as follows:

9.4.1 Adding movement entities

Shown below are icons used to add movement entities.
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This function inserts a movement entity in such a manner that it will

continue to a specified entity (start entity).  If no start entity is specified

before one of the icons shown above is clicked, you will be prompted to

specify one.  From this point on, no prompt is made to specify a start entity.

The attributes, such as color, of an entity to be added are the same as those

on a tool path being edited.

If an entity to be added is a line segment, the following combo box appears

in the prompt area, enabling specifying a feedrate attribute.

If cutting feed is specified for an entity to be added, the feedrate for the

entity is inherited from the previous cutting feed entity.

Line (From start point to end point)

Trace

Arc (Counterclockwise)

Line (Passing through another point)

Arc (Clockwise)

Arc (Tangential to another entity)

Arc (Tangential to previous entity at start point)
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9.4.2 Erasing movement entities

Shown below is an icon used to erase movement entities.

This function erases movement entities.

9.4.3 Trimming/Extending movement entities

Shown below are icons used to Trim/Extend movement entities.
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9.4.4 Undoing/redoing editing

Shown below are icons used to undo/redo.

ƒ Aƒ “ƒ hƒ D

ƒ Šƒ hƒ D

This function is valid only when a movement entity is being edited.  Once

movement entity editing is terminated, the previous undo information is

cleared, disabling the previous editing from being undone.

 Chamfering

 Nearby point

 Both ends

 Intersection

 Both entities

 Round

 Redo

 Undo
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9.4.5 Specifying start entities

This function adds a movement entity in such a way that it will link to a

start entity.  To change the position where a movement entity is to be added,

it is necessary to specify a new start entity.  A start entity can be specified by

picking an entity of a tool path on the window.  An entity of a tool path on

the window can be picked using the following icon.  This way, a start entity

is specified.

If a start entity is specified, the start position is circled as shown below.

•H‹ ïŒ õ H
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The color of the circle enclosing a start position can be changed as follows:

(1) Setting => Parameter Setting => Figure Operation ... on the menu

bar

(2) The color of the circle enclosing a start position is the one specified

using Attribute 1 in Display Attribute for Plural Possibilities of

Figure Creation in a dialog box related to figure manipulation.

Tool path

Start position
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9.4.6 Checking tool paths for continuity

Clicking the  button enables checking a tool

path being edited for continuity.  If a discontinuity is found, its entities

beside it are drawn in a color different from that of the tool path.  If there is

no discontinuity, the following message appears.

The color of the entities beside a discontinuity can be changed as follows:

(1) Setting => Parameter Setting => Figure Operation ... on the menu

bar

(2) The color of the entities beside a discontinuity is the one specified

using Attribute 1 in Display Attribute for Plural Possibilities of

Figure Creation in a dialog box related to figure manipulation.
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9.4.7 Listing entities

Clicking the  button causes the following

Entities List dialog box to appear.

In this dialog box, entities (such as auxiliary, line segment, and arc entities)

forming a tool path are listed in the order in which they are arranged on the

tool path.  The list indicates an entity serial number, display status, and type.

Whether an entity is displayed is indicated using letter * at the left of the

entity.

Letter * appears : The entity is being displayed.

Letter * does not appears : The entity is not being displayed.

Whether to display an entity can be switched using the  and

 buttons.  Clicking these buttons can cause an entity selected in

the list to appear or disappear.  This does not work for auxiliary entities,

however.

Clicking the  button causes all entities in the list to be selected.

Pressing the  button closes the dialog box.

9.4.8 Canceling movement entity editing

Pressing the  cancels all editing operations performed on

movement entities.  The effect of this function cannot be undone.



B-62824EN/02 9.  TOOL PATH EDITING

-137-

9.4.9 Terminating movement entity editing

Clicking the  button causes a tool path to be automatically checked

for continuity.  If there is no discontinuity in the tool path, the Tool Path

Editing dialog box is opened again.  If there is one, another dialog box

appears to prompt you to specify whether to make a connection at the

discontinuity automatically.  If an automatic connection is not specified, it is

impossible to terminate the dialog box for editing movement entities.

To make a manual connection, click the  button

to check for continuity previously.  It is impossible to terminate the dialog

box for editing movement entities as long as there is a discontinuity in the

tool path.

If cutting feed is specified as a feedrate attribute for an entity, the feedrate

for the entity is inherited from the previous cutting feed entity.
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10 SAVING AND LOADING FILE

10.1 Saving a File

Once figures and machining definitions have been prepared, they can be

saved.  To do this, select the File => Save As command.  Alternatively, click

the Save As button  on the tool bar, and specify a destination drive as

necessary.
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10.2 Loading a File

A saved file can be loaded.  To do this, select the File => Open command.

Alternatively, click the File Open button  on the tool bar, and select

the required file.
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11 CREATING NEW PROGRAM

When Symbolic CAP T is activated, a new file is created automatically. This

new file contains no blank figure, part figure, or machining definition data.

The file is assigned a temporary name (untitled). Thus, when creating a new

program, the user can start programming immediately, using this file.

To create a new program at any other time, select File => New command

from the menu bar. To create machining definition data using only existing

blank figure and part figure data, select File => Clear Machining Data.

When the contents of a program to be created closely approximate those of

an existing file, the user can read the original file, then assign it a new name

and store it under that name.

NOTE

When New or Clear Machining Data is executed, the file being

manipulated at that instant is discarded. If the program being

manipulated has not yet been saved, a prompt appears asking the

user to specify whether the program should be stored before

initialization.
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12 FIGURE CREATION

12.1 Types of Figures

This section explains the types of figures that can be handled.

(1) Figure entities

The smallest graphics unit is called a figure entity. Figure entities

include:

• Point

• Straight line

• Circle

• Arc

• Polyline

An open figure entity consisting of multiple connected arcs and

straight lines with both ends of the entity not connected.

• Polygon

A closed figure entity consisting of multiple connected arcs and

straight lines.

• Fitting curve

A figure entity formed by connecting a series of points with arcs

and straight lines smoothly.

(2) Group

A group consists of multiple figure entities. At present, only a point

group is defined as a group.
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12.2 Specifying a Radius, Distance, and Angle

Enter values such as a radius, distance, and angle from the keyboard. An

angle is positive in the counterclockwise direction and negative in the

clockwise direction, relative to the positive Z-axis.
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12.3 Specifying Positions

When figures are created, modified, and edited, the positions of figure

entities, the positions of figure intersections, or positions in a plane may

have to be selected. Before specifying positions, select the position

specification mode by using the following buttons:

(1) Specifying a coordinate system and dimensions

(a) Coordinate system and dimension

Specify one coordinate system and dimension from among the 2-

dimensional machining plane coordinate system (2D), 3-

dimensional machining plane coordinate system (3D), and 3-

dimensional world coordinate system.

2D: Z and X coordinates are specified in the machining plane

coordinate system.

3D: X, Y, and Z coordinates are specified in the machining

plane coordinate system.

3DW: X, Y, and Z coordinates are specified in the world

coordinate system.

For details of the coordinate systems, see Section Coordinate

system.

(2) Coordinate specification method

(b) Cartesian coordinates

Specify a position by inputting the X and Y coordinates.

(c) Polar coordinates (reference point is fixed)

Specify a position by means of the distance from the fixed

reference point and the angle, which indicates the direction.

(d) Polar coordinates (reference point is updated automatically)

Specify a position by means of the distance from the position

input immediately before and the angle, which indicates the

direction.

(a) (b)  (c)  (d) (e)  (f)  (g)  (h)  (i)  (j)  (k)  (l)  (m)
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(e) Origin of the polar coordinate system

Set the origin of the polar coordinates system.

(3) Specifying a location with the mouse

(f) Start point or end point of an entity

Click on a point near the start point or end point of an entity to

select the start point or end point.

(g) Intersection of a figure

Click on a point near an intersection to select it.

(h) Intersection of two figure entities

Click on a point near each of two figure entities to select the

intersection of the two figure entities. The intersection of the

extended lines of two entities can also be selected.

(i) Midpoint of an entity

Click on a point near an entity to select its middle point. The

middle point is determined as follows:

� Line segment: Midpoint of the line segment

� Circle: Center of the circle

� Arc: Middle point on the circumference of the arc

� Others: Middle point of one of the entities constituting

the target entity

(j) Center of a circle or arc

Click on a point near a circle or arc to select the center of the

circle or arc.

(k) Already entered point or point group

Click on a point near an already entered point or point group to

select it.

(l) Grid display point

Click on a point near a grid display point to select it.

(m) Position of the mouse pointer in the window

Click on a desired point in the drawing window to select the

mouse pointer position.
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12.4 Selecting Entities

To select an entity, click the corresponding position.

When an entity is selected, figure search processing is performed in figure

type order (point to straight line to circle to arc ...). When entities are close

together, a desired entity sometimes cannot be selected. In such a case, the

figure search direction switch button displayed in the status window can be

clicked to reverse the search order.

To select more than one entity, the user can select them one-by-one, by

clicking them with the mouse.  Alternatively, the user can specify a

rectangle and select all the entities in that rectangle. Or, a particular entity

in the rectangle can be excluded.

The method of selecting entities can be set using the entity select mode, as

follows.

(a) Select/Deselect

Whether an entity is to be selected or deselected is indicated.

(b) Entities inside a rectangle

All entities inside a rectangle are selected. select entities by dragging

diagonal corners of the rectangle to indicate the range of selection.

(c) Entities inside a rectangle and entities touching the rectangle

frame

All entities inside a rectangle and all entities that touch the rectangle

frame are selected. Select entities by dragging diagonal corners of the

rectangle to indicate the range of selection.

(d) Entities outside a rectangle

All figures that are located entities outside a rectangle are selected.

Select elements by dragging diagonal corners of the rectangle to

indicate the range of selection.

(a) (a) (b)  (c)  (d)  (e)  (f)  (g)
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(e) Entities outside a rectangle and entities touching the rectangle

frame

All entities that are located outside a rectangle and entities that touch

the rectangle frame are selected. Select elements by dragging

diagonal corners of the rectangle to indicate the range of selection.

(f) All entities displayed in a window

All entities displayed in a window are selected. Click on an arbitrary

point in a target window to select all elements in the window.

(g) All entities displayed in a window

All the entities displayed in a window are selected.

Click any point within the window.
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12.5 Coordinate System

This section explains two coordinate systems:  the world coordinate system

and machining plane coordinate system.

12.5.1 World coordinate system

Created figures and tool paths are stored in a dedicated three-dimensional

database. These data items are managed using a unique coordinate system

which is used as a base coordinate system to indicate all positions. This

absolute coordinate system is called the world coordinate system.

Normally, parts or other structures have one point that is used as a reference

point for the entire structure. Placing this reference point at the origin of the

world coordinate system streamlines figure creation and other processing.

12.5.2 Machining plane coordinate system

A machining plane coordinate system tailored to a drawing format is

provided to facilitate coordinate input. The machining plane coordinate

system is automatically determined according to the drawing format.
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12.6 Modifying Figures by Extension/Trimming

A figure can be modified by trimming unnecessary parts of figure entities

such as unnecessary draft lines and by extending parts of figure entities to

specified position.

(a)Trimming    (b)Trimming       (c)Trimming         (d)Trimming

(a)Extention      (b)Extention     (c)Extention             (d)Extention

Using the above figures as examples, modifying figures by selecting

Modify=>Trim/Extend from the menu is described below. The operations

for extension and trimming are the same in the examples below.

(a) Extending/trimming a figure entities up to an intersection

1) Select Modify => Trim/Extend => Intersection from the menu.

2) Select point 1 and point 2 in this order.

(b) Extending/trimming a figure entities up to a nearby point

1) Select Modify => Trim/Extend => Nearby Point from the menu.

2) Select point 1 and point 2 in this order.

(c) Extending/trimming two figure entities up to the intersection of

the entities

1) Select Modify => Trim/Extend => Both Entities from the menu.

2) Select point 1 and point 2 in this order.

(d) Extending/trimming both ends of figure entities

1) Select Modify => Trim/Extend => Both Ends from the menu

2) Select point 1, point 2, and point 3 in this order.
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12.7 Copying Figures

A figure can be copied in many different ways.

(a) Parallel-Positions

A figure can be copied to specified multiple positions in parallel

mode.

1) Select Edit => Copy => Parallel-Positions from the menu.

2) Select point 1 to specify the figure to be copied, then select the

End button.

3) Select point 1 to specify the reference point of the figure to be

copied.

4) Select point 2 and point 3 as copy destinations, then select the

End button.

5) Press the ESC button.

(b) Parallel-Distance

A figure can be copied to the multiple positions at uniformly spaced

intervals in parallel mode.

1) Select Edit => Copy => Parallel-Distance from the menu.

2) Select point 1 to specify the figure to be copied, then select the

End button.

3) Enter 15 and -15 to specify space interval values DZ and DY,

respectively.

4) Enter 2 to specify the number of copy destinations.

5) Press the ESC button.
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(c) Parallel-Division No.

A figure can be copied in parallel mode to the multiple positions

determined by equally dividing a specified maximum copy distance.

1) Select Edit => Copy => Parallel-Division No. from the menu

2) Select point 1 to specify the figure to be copied, then select the

End button.

3) Enter 30 and -30 to specify maximum copy distance values DZ

and DX, respectively.

4) Enter 2 to specify the number of copy destinations.

5) Press the ESC button.
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(d) Parallel-Position, Division No.

A figure can be copied in parallel mode to multiple positions

determined by equally dividing the distance to a specified final copy

destination.

1) Select Edit => Copy => Parallel-Position, Division No. from the

menu.

2) Select point 1 to specify the figure to be copied, then select the

End button.

3) Select point 1 to specify the reference point of the figure to be

copied.

4) Select point 2 to specify the final copy destination.

5) Enter 2 to specify the number of copy destinations.

6) Press the ESC button.

(e) Rotate-Distance

A figure can be copied to positions determined by rotating the figure

repeatedly by the same angle.

1) Select Edit => Copy => Rotate-Distance from the menu.

2) Select point 1 to specify the figure to be copied, then select the

End button.

3) Select point 2 to specify the center of rotation.

4) Enter 60 to specify the angle of rotation.

5) Enter 2 to specify the number of copy destinations.

6) Press the ESC button.
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(f) Rotate-Division No.

A figure can be copied to positions determined by equally dividing a

specified total angle of rotation.

1) Select Edit => Copy => Rotate-Division No. from the menu.

2) Select point 1 to specify the figure to be copied, then select the

End button.

3) Select point 2 to specify the center of rotation.

4) Enter 120 as the total angle of rotation.

5) Enter 2 to specify the number of copy destinations.

6) Press the ESC button.

(g) Mirror-Plane

The mirror image of a figure can be produced by specifying two

points to define a mirror plane perpendicular to the machining plane.

1) Select Edit => Copy => Mirror-Plane from the menu.

2) Select point 1 to specify the figure to be copied, then select the

end button.

3) Select point 2 and point 3 to specify the mirror plane.

4) Select the ESC button.
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(h) Mirror-Position

The mirror images of a figure can be produced by defining a

reference point and copy destination to specify a mirror plane

perpendicular to the machining plane.

1) Select Edit => Copy => Mirror-Position from the menu.

2) Select point 1 to specify the figure to be copied, then select the

End button.

3) Select point 1 to specify the reference point of the figure to be

copied.

4) Select point 2 to specify the copy destination.

5) Select  the ESC button.

(i) Arbitrary

A figure can be copied by specifying a copy source reference point

and the directions of two associated orthogonal axes and a copy

destination reference point and the directions of two associated

orthogonal axes.

1) Select Edit => Copy => Arbitrary from the menu.

2) Select point 1 to specify the figure to be copied, then select the

End button.

3) Select point 1 to specify the reference point of the figure to be

copied.

4) Select point 3 and point 4 to define the directions of the first axis

and second axis.
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5) Select point 5 to specify the reference point of the copy

destination.

6) Select point 6 and 7 to define the directions of the first axis and

second axis.

7) Press  the ESC button
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12.8 Creating Polygons

A polygon can be created by combining multiple entities.

(a) (b)

This section explains how to create the polygon in (a) above from the figure

in (b) above.

1) Create figure in (b) with a rectangle and two lines.

2) Select the icon  for polygon from the side menu.

3) Select the icon  for Trace from the side menu.

4) Select start point P1.

5) Select the polygon entities P2, P3, P4, P5, P6, P7,and P2 in this

order.

6) Select Edit => Erase from the menu.

7) Select P8, P9, and P10.  Then, select the End button.

8) Select View => Redraw from the menu.
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12.9 Fitting Curve

12.9.1 Creation method of a fitting curve

A smooth curve that passes through a series of points is called a fitting

curve.  A fitting curve consists of a series of tangent arcs.  When three

consecutive points lie on the same straight line, they can be connected by a

straight line.  Generally, one section (between two adjacent points) is

connected by two arcs.  When there is an inflection point within a section,

the section is connected with four arcs.

12.9.2 Adjusting the creation method of a fitting curve

Normally, the method of creating a fitting curve need not be adjusted.  When

necessary, however, the method of creating a fitting curve can be adjusted by

changing the three parameters explained below.  To adjust the creation

method, modify the Fig_FcvCvdg parameter registered in the initialization

file (the standard initialization file is CAPT.INI) in the same directory as

that in which Windows is installed, then restart the system.  By changing

this parameter setting, the window for setting the parameters is displayed

each time a fitting curve is created:

Fig_FcvCvdg=FALSE    =>    Fig_FcvCvdg=TRUE
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(1) Dumping constant

The dumping constant parameter is used for adjusting a section

which has no inflection point and which is connected by two arcs.

When the arcs for such a section are obtained, a tangent vector is

obtained at each end point first.  Then, an arc tangent to each tangent

vector is obtained.  The fitting curve can be adjusted by using the

dumping constant to correct the tangent vector at the end point, as

shown in the figure below.

When the dumping constant is set to 100, no adjustment is made.

When the dumping constant is set to a value other than 100, a

different fitting curve will be obtained from the same series of points,

depending on whether the creation order is reversed.  Therefore, the

dumping constant should be used carefully.

A value between 0 and 100 can be set as the dumping constant.  The

initial value is 100.

(2) Movement rate of inflection point

The movement rate of inflection point parameter is used to adjust the

position of the inflection point when a section contains an inflection

point.

An inflection point is the intersection of the inflection point vector

and the perpendicular bisector of the straight line connecting the start

and end points.

As the value of this parameter is reduced, the position of the

inflection point approaches nearer to the midpoint of the start and

end points.

The inflection point vector is obtained as follows:
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A1: Angle between the start point tangent vector and the straight line

connecting the start and end points

A2: Angle between the end point tangent vector and the straight line

connecting the start and end points

Ap: Angle between the inflection point vector and the straight line

connecting the start and end points

A1 - A2

Ap =                  ×  ( Movement rate of inflection point) / 100

  2

A value between 0 and 100 can be set.  The initial value is 75.

(3) Tolerance for section judgment

This parameter is used to determine a straight line section.

When the angle formed by three consecutive points is equal to or less

than the value specified for this parameter, the sections

corresponding to those three points are recognized as being a straight

line.  The units are radians.  The formula for converting radians to

degrees is as follows.

180

Angle (degrees)  =              × Angle (radians)

  π
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12.10 Offset

A figure can be created by shifting a polyline/polygon, either entirely or partly,

through a specified distance.  This function is called the offset function.

To execute this function, select Edit => Offset, or Edit => Offset of part.

The following sections explain the use of the offset function to shift a corner

both out and in.

12.10.1 Outward offset for a corner

When outward offset is applied to a corner, the corner entities will be

separated from each other.  Each entity must be extended in order to

reconnect them.  This processing is called corner interpolation.  There are

four modes of corner interpolation.  The desired mode is selected by

responding to the Target corner prompt which appears in the prompt area

when Edit => Offset or Edit => Offset of part is selected.

(1) Segment/OFF

When this mode is selected, entities are extended by a straight line to

connect them.  When the original entity is a straight line, it is simply

extended directly.  When the original entity is an arc, a straight line

tangent to the arc is extended.

(2) Segment/Tolerance

In this mode, the Length to Chamfering position, set when Setting =>

Parameter Setting => Figure Operation is selected, is referenced.

Basically, the operation performed in this mode is almost the same as that

performed in Segment/OFF mode.  In this mode, however, when the

distance from the vertex of the original corner to the vertex of the new

corner obtained by the offset operation exceeds the value set for Length to

Chamfering position, each entity is extended with a straight line by an

amount equal to the offset.  Then, both ends are connected with a straight

line.  This operation is called chamfering.
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(3) Segment/Auto

In this mode, the corner angle is referenced.

When the corner angle is smaller than 90 , chamfering is performed in the

same way as explained above.

When the corner angle is equal to or greater than 90 , the operation

performed is the same as that performed in Segment/OFF mode.

(4) Arc

In this mode, the entities are connected by an arc having a radius equal to

the specified offset.

12.10.2 Inward offset for a corner

When inward offset is performed for a corner, the figure entities obtained by

performing offset may cross other entities, or the positional relationship

between entities may differ from the original figure.  Such conditions are

referred to as interference.
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The operation performed in the case of interference is determined according

to the setting of the When Interfering item, which appears when Setting =>

Parameter Setting => Figure Operation is selected.

If The interfered element is not removed. is selected, the offset figure is

created with the interference left as is.

If The interfered element is removed. is selected, the interference is first

removed, then the figure is created.  If removing the interference causes the

figure to disappear, as in the case of Example 1 above, an error occurs.

By default, The interfered element is removed. is set.
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13 CUTTING CONDITION DATA

This section describes how to edit the cutting condition data that is used

when automatically determining the machining conditions during

machining definition.

13.1 Overview

Symbolic CAP T allows cutting speed, feedrate, and other cutting condition

data to be classified according to the workpiece material, such that it can be

registered in a cutting condition library. Cutting condition data can be

registered as combinations of machining type, tool type, and tool material

for a given workpiece material.

Multiple materials can be registered. When a range of materials is

registered, the material selected for a blank figure can be referenced and

used in machining definition.

In machining definition, the cutting condition data corresponding to a

desired machining type, as well as the type and material of the tool to be

used are determined from the cutting condition data registered for the

current workpiece material. Based on this data, the spindle speed, feedrate,

and other data are determined automatically. As part of machining

definition, the cutting condition library can be updated by feeding back the

cutting condition data to the library.
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NOTE

1. Searching for a tool to be used

For both manual and automatic process determination for machining

definition, the tooling data is searched for a tool of a type that can be

used for the machining type specified in the cutting condition data for

the current workpiece material.  An appropriate tool is selected as the

tool to be used.

When there are two or more tools that are judged as being suitable

for the machining type, a search of the data is made in the order in

which the tool types are registered.

2. Cutting conditions and machining conditions

In this chapter, the cutting speed, feed amount, and other data that

can be specified for each workpiece material are referred to as the

cutting conditions. The spindle speed, feedrate, and other data that

are obtained from the cutting conditions are referred to as machining

conditions.

WARNING

Before creating a machining program using the conversational

function, ensure that correct cutting condition data is set.  Failure to

set correct cutting condition data may result in the tool colliding with

the workpiece and/or machine, possibly causing damage to the

machine, workpiece, and/or tool itself, or injury to the user.
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13.2 Functions

The following functions can be used to edit the cutting conditions:

• Adding or deleting a workpiece material name

This function adds or deletes the name of the material of the workpiece to

be machined.  The material registered using this function can be selected

on the blank figure window.

• Adding modifying, or deleting the cutting conditions

This function adds, modifies, or deletes the cutting condition data

corresponding to the combination of machining type, tool type, and tool

material specified for a workpiece material.

The following cutting condition data can be set.

(1) Data set for a machining type

• Finishing allowance

(2) Data set for a machining type, tool type, or tool material

• Coolant type

• Cutting speed

• Feedrate or feed amount for a single tooth or for all teeth

• Cutting depth

• Activation of the cutting condition data utility
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13.3 Starting of Editing Cutting Condition Data

The function to edit cutting conditions is started by selecting it from the

menu bar.

From the menu bar, select Setting => Library Data Setting => Cutting

Condition.

Edit Cutting Condition Data window appears, as shown below:
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13.4 Adding a Material Name

Click the Addition button on the Edit Cutting Condition Data window.

Add Material Name dialog appears, as shown below:

A cutting condition file must be placed in the directory specified in Setting

of Environment dialog of the Setting menu.

The cutting condition file can be added in either of the following two ways:

• Creating a new cutting condition file

A cutting condition file is created and placed in the directory

specified on Setting of Environment dialog of the Setting menu.

• Reading an existing cutting condition file

An existing cutting condition file is copied into the directory

specified in Setting of Environment dialog of the Setting menu.

NOTE

Cutting condition file and cutting condition data

In this chapter, a file containing cutting conditions is referred to as a

cutting condition file. The cutting condition data includes the contents

of the cutting condition file and information registered for the system.
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(1) Creating a new cutting condition file

On the Add Material Name window, select the New Making of

Cutting Condition File option. Specify a workpiece material name,

NC machine name, and file name. Then, click the OK button.

The NC machine name is merely a comment and can be omitted. The

window for selecting the machining type to be added as a cutting

condition is displayed. For an explanation of adding the cutting

conditions, see the section describing the editing of cutting condition

data.

(2) Reading an existing cutting condition file

On the Add Material Name window, select the Reading of Cutting

Condition File option.  Specify the directory containing the cutting

condition file, then click the List Display button.  Select a target

cutting condition file from the list, then click the OK button. The

Addition of Cutting Condition Data window remains displayed. The

specified cutting condition file can be read. To return to the Edit

Cutting Condition Data window, click the Cancel button.
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13.5 Deleting a Material Name

On the Edit Cutting Condition Data window, select the material to be

deleted, then click the Delete button.  This operation cannot be used to

delete the cutting condition data for a material referenced in the machining

definition.

The window for deleting material name appears, as shown below:

The material name can be deleted in either of the following two ways:

• Deleting the material name from the material list only

The material name is deleted from the material list such that it

cannot be referenced in machining definition. The corresponding

cutting condition file is not deleted from the cutting condition file

directory specified in the Setting of Environment.

• Deleting both the material name and the cutting condition file

The material name is deleted from the material list. The

corresponding cutting condition file is also deleted from the cutting

condition file directory specified in the Setting of Environment.

To delete a material name, select the Delete from Material List option

or Delete Cutting Condition File option, then click the OK button.
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13.6 Editing Cutting Condition Data

On the Edit Cutting Condition Data window, select the material for which

the corresponding data is to be edited, then click the Modify button.

The Machining Type List window appears, as shown below:

Clicking the OK button after editing the cutting condition data makes the

edited data effective.

Clicking the Cancel button after editing the data discards all changes that

have been made.

13.6.1 Modifying cutting condition data on a machining type basis

To modify the cutting condition data, select a target cutting condition on the

Machining Type List window, then click the Modify button.

The Tool Type List window appears, as shown below:
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• Finishing Allowance

Specify the finishing allowance to be referenced during automatic

process determination.

A finishing allowance can be specified for the following machining

types:

• Rough turning (outer, inner, face)

• Turning - semi-finish (outer, inner, face)

• Rough grooving (outer, inner, face)

• Tool type list

A tool type that appears in the tool type list can be used for the

selected machining type. In manual or automatic process

determination of the machining definition, the tooling data is

searched for a tool of the tool type registered in this list.

If two or more tool types are registered, data corresponding to those

tool types is searched in the order in which the types appear in the

list.

Back button

Clicking this button causes the tool type list for the machining type

preceding the currently selected type to be displayed.

Next button

Clicking this button causes the tool type list for the machining type

following the currently selected type to be displayed.

13.6.2 Adding cutting condition data

To add cutting condition data, select the tool type at a desired insertion

position on the Tool Type List window, then click the Insert button.

The window for adding a tool type appears, as shown below:

• Tool Type

The kind of tool types that can be added for a given machining type is

determined by the system. This kind cannot be changed.
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• Tool Material

To change the tool material of a tool type , click Setting => Library

Data Setting => Tool, Tooling.

Select the tool type or tool material of the cutting condition data to be added,

then click the OK button.

The window for adding and modifying the cutting conditions data for the

selected machining type appears.

The following data can be specified. For some data items, two units are

specified: The first is for metric specification while the second is for inch

specification.

• Coolant Type

Select one of the following three coolant type settings:

• Not used

• Oil

• Mist

• Cutting Speed

The following data can be specified for each machining type, in units

of meters per minute or feet per minute.

• Hole machining

Cutting speed for tool diameter

• Other machining

Cutting speed for turning

• Feed Amount

The following data can be specified for each machining type:

• Hole machining (center drilling)

Specify the feed amount per revolution, corresponding to  the

tool diameter, as the feed amount for all teeth, in units of
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millimeters per revolution or inches per revolution.

• Hole machining (drilling)

Specify the feed amount per revolution, corresponding to the tool

diameter, as the feed amount for all teeth, in units of millimeters

per revolution or inches per revolution. From this value, the

cutting feedrate is calculated.

• Specify the feedrates at start, at end, at return, and at repeated

cut-in as a percentage of the cutting feedrate.

• Hole machining (reaming)

Specify the feed amount per revolution, corresponding to the tool

diameter, as the feed amount per tooth, in units of  millimeters

per revolution or inches per revolution. From this value, the

cutting feedrate is calculated.

Specify also the feedrate at return as a percentage of the cutting

feedrate.

• Other machining

Specify the feed amount per revolution for a machining type, in

units of millimeters per revolution or inches per revolution.
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• Cutting depth, cutting ratio

The following data can be specified for a machining type:

• Hole machining (drilling)

Specify the change ratio (%) and cramp amount (maximum or

minimum value, in units of millimeters or inches) for the

pecking amount in drilling.

Specify also the ratio of the hole depth to the diameter so that a

drilling method can be determined.

Example

Ratio of hole depth to diameter (depth/diameter) for drilling

method 1 = A (%)

Ratio of hole depth to diameter (depth/diameter) for drilling

method 2 = B (%)

Ratio of hole depth to diameter of hole to be machined = R

NOTE

Calculating the cutting speed and feed amount corresponding to the

tool diameter

If the cutting speed or feed amount corresponding to the tool

diameter is registered in the cutting condition data, the registered

cutting speed or feed amount is used.

If not, the data is determined by linear interpolation from the

registered tool diameter and the cutting speed or feed amount, as

shown below:
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Under the above conditions, the drilling method is determined as

follows:

R < A : Drilling cycle

A ≤ R < B : High-speed deep drilling cycle

B ≤ R : Deep drilling cycle

• Rough turning (outer, inner, face)

Specify the cutting depth (in units of millimeters or inches) in

the direction of the diameter, the change ratio (%) for the cutting

depth, and the cramp value (maximum or minimum value, in

units of millimeters or inches) for the cutting depth.

• Rough grooving (outer, inner, face)

Specify the change ratio (%) for the cutting depth in the direction of

the groove depth and the cramp value (maximum or minimum

value, in units of millimeters or inches) for the cutting depth.

Specify also the cutting depth in the direction of the groove

width as a ratio to the available chip width (%) and the first

cutting depth in the direction of the groove depth by a ratio to

the chip width (%).

• Threading (outer, inner, front)

Specify the first cutting depth and cramp value for the cutting

depth (maximum or minimum value, in units of millimeters or

inches).

Back button

When two or more tool types are registered, clicking this button causes the

cutting conditions for the tool type preceding the currently selected tool

type to appear.

Next button

When two or more tool types are registered, clicking this button causes the

–

–
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cutting conditions for the tool type following the currently selected tool

type to appear.

Specify the desired cutting condition data, then click the OK button. The

cutting conditions are registered.

13.6.3 Modifying cutting condition data

To modify previously registered cutting condition data, select the target tool

type on the Tool Type List window, then click the Modify button.

The window for registering and modifying the cutting conditions for the

selected machining type is displayed.

Modify the cutting condition data, then click the OK button.  The cutting

conditions are modified.

13.6.4 Deleting cutting condition data

To delete registered cutting condition data, select a target tool type on the

Tool Type List window, then click the Delete button.

A prompt window asking the user to confirm the deletion appears.  To delete

the data, click the Yes button.

Two or more cutting conditions can be deleted at one time.

13.6.5 Changing the order of the tool types

When two or more tool types are registered for a machining type, the order

of those tool types can be changed.

To change the order, select a target tool type on the Tool Type List window,

then click the Change Order button.

At the bottom of the conversational window, the following message appears:

Select Position of Top Reversed List after Changed Order.

Select a new position from among those that are not displayed in reverse

video.  The order is changed.

The positions of two or more tool types can be changed at one time.

13.6.6 Deleting cutting condition data on a machining type basis

To delete a cutting condition on a machining-type basis, first select a target

machining type on the Machining Type List window, then click the Erase

button.

A prompt window asking the user to confirm the deletion appears.  To delete

the data, click the Yes button.

The cutting condition data for two or more machining types can be deleted

at one time.
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13.7 Calculating Method of the Machining Condition Data

• Spindle speed (S)

• Hole machining

S = (1000 × V)/( π × D) ... Metric machine

S = (12 × V)/( π × D) ... Inch machine

V:  Cutting speed

D:  Tool diameter

 

• Other machining

S = (Smax + Smin)/2

Smax = (1000 × V)/( π × Dmax)

Smin = (1000 × V)/( π × Dmin) ... Metric machine

Smax = (12 × V)/( π × Dmax)

Smin = (12 × V)/( π × Dmin) ... Inch machine

V: Cutting speed

Dmax: Maximum workpiece diameter in the corresponding

tool path output

Dmin: Minimum workpiece diameter in the corresponding

tool path output

• Feedrate (F)

• Hole machining (center drilling)

Feedrate for cutting

F = f

f:  Feed amount for all teeth

• Hole machining (drilling)

Feedrate for cutting

F = f

Feedrate at start, at end, at return, and at repeated cut-in

Fn = F × α /100

α :  Compensation ratio (%)

• Hole machining (tapping)

Feedrate for cutting

F = P

P:  Pitch
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• Hole machining (reaming)

Feedrate for cutting

F = f × n

f:  Feed amount per tooth

n:  Number of teeth

Feedrate for return

Fn = F × α /100

α :  Compensation ratio (%)

• Other machining

The feed amount per revolution specified for the corresponding

machining type is used as is.

• Cutting depth (C)

• Drilling

Primary drilling depth (D1, first cutting depth) and secondary

drilling depth (D2) of a high-speed deep drilling cycle or deep

drilling cycle are calculated as follows:

D1 = ((Ratio of hole depth to diameter for drilling method

1)/100) × (Tool diameter)

D2 = ((Ratio of hole depth to diameter for drilling method

2)/100) × (Tool diameter)
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• Rough turning, threading

The cutting depth specified as part of the cutting condition data

is used as is.

• Rough grooving

(First) cutting depth in the Z-axis direction for outer or inner

machining, or in the X-axis direction for face machining (D1)

D1 = ((Ratio to available chip width)/100) × (Available chip

width)

(First) cutting depth in the X-axis direction for outer or inner

machining, or in the Z-axis direction for face machining (D2)

D2 = ((Ratio to chip width)/100) × (Chip width)

For all machining types, if the cutting depth varies in a cutting

cycle, the cutting depth is calculated as follows:

C = Cn × α /100

Cn: Previous cutting depth

α: Change ratio for cutting depth(%)
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14 CUTTING CONDITION DATA UTILITY

This section describes the cutting condition data utility used to input/output

cutting condition files.

14.1 Functions

The cutting condition data utility has the following functions.

• Output of cutting condition file

A cutting condition file is output from a cutting condition file

directory, specified using Setting of Environment, to a specified

directory.

• Input of cutting condition file

A cutting condition file is input from a specified directory to a cutting

condition file directory, specified using Setting of Environment.

• Change of cutting condition file

The workpiece material, target NC machine, and file names related to

a cutting condition file in a specified directory are changed.  This

function can also be used as a copy tool by preserving the original

cutting condition file.

• Uniting of cutting condition file

Two cutting condition files in a specified directory can be united into

a single cutting condition file.
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14.2 Starting the Cutting Condition Data Utility

The cutting condition data utility is started from cutting condition

registration.

To start the utility, select Setting => Library Data Setting => Cutting

Condition from the menu bar.

The following Edit Cutting Condition Data dialog box appears.

Click the Utility button.  Cutting condition data utility dialog box appears.
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14.3 Selecting Utility Functions

Clicking a function button displays the dialog box that corresponds to the

selected function.

Clicking the Close button returns you to Cutting Condition Data dialog box.
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14.4 Outputting Cutting Condition Files

Clicking the Output button in Cutting condition data utility dialog box

displays the following dialog box, used to specify cutting condition file

output.

• Output origin

• Cutting condition file list

This is a list of the cutting condition files in a cutting condition

file directory, specified as the output origin using Setting of

Environment.

If a cutting condition file name in the cutting condition file list

is suffixed with an asterisk, the relevant information has not

been registered as system management information, even though

the corresponding cutting condition file exists in the directory.

Cutting condition files, selected from the cutting condition file

list, are output.

• All/Nothing button

This button either selects or deselects all the cutting condition

files in the cutting condition file list.  Clicking the button toggles

between selection and deselection of all the cutting condition

files.

• Output destination

• Directory

This box is used to specify a directory to which cutting condition

files are to be output.

• Cutting condition file list

Clicking the List button displays a list of cutting condition files

in a specified directory.
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If a cutting condition file name in the cutting condition file list

is suffixed with an asterisk, the relevant information has not

been registered as system management information, even though

the corresponding condition file exists in the directory.

• Execution button

Cutting condition files are output by selecting them from the

output origin list, specifying the output destination directory,

then clicking the Execution button.

The cutting condition file list at the output destination is

updated.  Cutting condition file output can continue after the

update.

It is possible to output more than one cutting condition file at a

time.

• Close button

Clicking the Close button returns you to Cutting condition data

utility dialog box.
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14.5 Inputting Cutting Condition Files

Clicking the Input button in Cutting condition data utility dialog box

displays the following dialog box, used to specify cutting condition file

input.

• Input destination

• Cutting condition file list

This is a list of cutting condition files in a cutting condition file

directory, specified as an input destination using Setting of

Environment.

If a cutting condition file name in the cutting condition file list

is suffixed with an asterisk, the relevant information has not

been registered as system management information, even though

the cutting condition file exists in the directory.

• Input origin

• Directory

This box is used to specify a directory from which cutting

condition files are to be supplied.

• Cutting condition file list

Clicking the List button displays a list of cutting condition files

in a specified directory.

If a cutting condition file name in the cutting condition file list

is suffixed with an asterisk, the relevant information has not

been registered as system management information, even though

the cutting condition file exists in the directory.

Cutting condition files, selected from the cutting condition file

list, are input.

• All/Nothing button

This button either selects or deselects all the cutting condition



B-62824EN/02 14.  CUTTING CONDITION DATA UTILITY

-185-

files in the cutting condition list.  Clicking the button toggles

between selection and deselection of all the cutting condition

files.

• Execution button

Cutting condition files are input by selecting them from the

input origin list and clicking the Execution button.

The cutting condition file list at the input destination is updated.

Cutting condition file input can continue after the update.

It is possible to input more than one cutting condition file at a

time.

• Close button

Clicking the Close button returns you to Cutting condition data

utility selection dialog box.
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14.6 Changing Cutting Condition Files

Clicking the Change button in Cutting condition data utility dialog box

displays the following dialog box, used for changing the cutting condition

files.

• Directory

This box enables the specification of a directory in which cutting

condition files are to be changed.  Initially, the box indicates the

cutting condition file directory specified using Setting of

Environment.

• Cutting condition file list

Clicking the List button displays a list of cutting condition files

in a specified directory.

If a cutting condition file name in the cutting condition file list

is suffixed with an asterisk, the relevant information has not

been registered as system management information, even though

the corresponding condition file exists in the directory.

Cutting conditions selected from the cutting condition list are

subjected to change.

• All/Nothing button

This button either selects or deselects all the cutting condition

files in the cutting condition list.  Clicking the button toggles

between selection and deselection of all the cutting condition

files.
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• Execution button

After the target cutting condition file has been selected from the

cutting condition file list, clicking the Execution button displays

the following dialog box for specifying the name data to be used

after the change.

• Original Data is Left

If the check box for this item is not selected, the original cutting

condition file is replaced with a new cutting condition file

(resulting from the change); the original is deleted.

If the check box is selected, the original cutting condition file is

not deleted.  Instead, it is duplicated, using different names for

the original and new cutting condition files.

• Material Name

This box is used to specify the work material name to be used in

the new cutting condition file.

• NC Machine

This box is used to specify the NC machine name to be used in

the new cutting condition file.

• File Name

This box is used to specify the file name to be used for the new

cutting condition file.

If the Original Data is Left check box is not selected, there is no

need to change the file name.  If the check box is selected, an

error message is displayed unless the new file name differs from

the original file name.

• Next/OK button

When there are other cutting condition files for which new data

is to be specified, the Next button is displayed.  After the new

data has been specified, clicking the Next button displays a

dialog box for changing the data of another cutting condition

file.
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If new data for the last cutting condition file is specified, the OK

button is displayed.  After the new data has been specified,

clicking the OK button applies the specified changes, then

returns you to Changes of cutting condition file dialog box.

It is possible to change more than one cutting condition file at a

time.

• Cancel button

Clicking the Cancel button returns you to Change of cutting

condition file dialog box, without applying the specified

changes.

• Close button

Clicking the Close button returns you to Cutting condition data

utility dialog box.
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14.7 Uniting Cutting Condition Files

Clicking the Uniting button in Cutting condition data utility dialog box

displays the following dialog box, used to unite cutting condition files.

• First condition file

• Directory

This box is used to specify the directory that contains one of the

cutting condition files to be united.  Initially, the box indicates

the cutting condition file directory specified using Setting of

Environment.

• Cutting condition file list

Clicking the List button displays a list of the cutting condition

files in a specified directory.

If a cutting condition file name in the cutting condition file list

is suffixed with an asterisk, the relevant information has not

been registered as system management information, even though

the cutting condition file exists in the directory.

A cutting condition file selected from the cutting condition file

list is subjected to file uniting.  Only one cutting condition file

can be selected from this list.

• Second condition file

• Directory

This box is used to specify the directory that contains the second

cutting condition file to be united.  Initially, the box indicates

the cutting condition file directory specified using Setting of

Environment.

• Cutting condition file list

Clicking the List button displays a list of the cutting condition



14.  CUTTING CONDITION DATA UTILITY B-62824EN/02

-190-

files in a specified directory.

If a cutting condition file name in the cutting condition file list

is suffixed with an asterisk, the relevant information has not

been registered as system management information, even though

the cutting condition file exists in the directory.

The cutting condition file selected from the cutting condition file

list is subjected to file uniting.  Only one cutting condition file

can be selected from this list.

• Execution button

After both the first and second cutting condition files have been

selected, clicking the Execution button displays the following

dialog box, used to specify the conditions for file uniting.

• Method of preserving the same data

• Preserve data of first condition file

• Preserve data of second condition file

If two files to be united have different data for the same item, the

Preserve data of first condition file and Preserve data of second

condition file items enable the specification of which file is to

supply data to the new file.  For example, if both the first and

second cutting condition files have cutting condition data for

roughing preceding contouring, end-milling, and tool material
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HSS, the cutting condition data from the specified file is saved

in the new file.

• Material Name

This box is used to specify the work material name to be used in

the new cutting condition file (resulting from uniting).

• NC Machine

This box is used to specify the NC machine name used in the

new cutting condition file (resulting from uniting).

• Method of Preserving Uniting File

• Replacement First Condition File

• Replacement Second Condition File

• Preserve New Condition File

These items enable the specification of the way in which the new

cutting condition file is to be saved.  If the Preserve New

Condition File item is selected, the user must specify the

directory in which the new file is to be saved, as well as the file

name.

• Directory

This box is used to specify the directory in which the new

cutting condition file is to be saved.  Initially, the box indicates

the cutting condition file directory specified using Operating

Environment.

• File Name

This box is used to specify a name for the new cutting condition

file.

• OK button

After the conditions for file uniting have been specified, clicking the

OK button applies the specified uniting, then returns you to Uniting

of cutting condition files dialog.

• Cancel button

Clicking the Cancel button returns you to Uniting of cutting

condition files dialog without applying the specified uniting.

• Close button

Clicking the Close button returns you to Cutting condition data utility

dialog box.
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15 TOOL DATA AND TOOLING DATA

This section describes how to edit the tool data and the tooling data.

15.1 Overview

Symbolic CAP T defines tool data and tooling data as described below:

• Tool data

Tool data consists of data relating to all the tools in a manufacturing

facility, for example, organized according to tool type. The data for

all the available tools can be registered as tool data.  Data that has

been registered only as tool data cannot be referenced or used in

machining definition.

• Tooling data

Tooling data is registered data for those tools selected from all tools

that are to be mounted on a machine to enable the machining of a

workpiece. A tool for which data is registered in the tooling data can

be referenced as part of  machining definition.

Two or more toolings can be registered. In this case, the tooling data

to be referenced or used in machining definition is selected using

Setting of pre-machining dialog.

Usually, tooling data is created as follows: Data relating to all available tools

is registered as tool data. The data for a tool to be used in machining

definition is copied into the tooling data.
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WARNING

Before programming using the conversational function, ensure that

correct tool data and tooling data are set.  Failure to set correct tool

data and tooling data may result in the tool colliding with the

workpiece and/or machine, possibly causing damage to the machine,

workpiece, and/or tool itself, or injury to the user.

Tooling data selected by
“Setting of pre-machining”
which can be refered and
used by “Machining
definition”

Tooling data 2

Tooling data 1
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15.2 Functions

For tool data and tooling data, the following functions are available:

• Addition and deleting of a tooling data

This function adds, or deletes a tooling data.  Tooling data add using

this function can be referenced in machining definition.

• Modification of tooling data

This function is used to modify add tooling data.

• Editing the tool data

This function is used to modify the tool data for a given tool type.

• Activation of tool/tooling data utility

Activate the utility function used for tool/tooling data input/output

and modification.  For details of the tool/tooling data utility, see

Tool/Tooling Data Utility.
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15.3 Starting of Tool Data/Tooling Data Editing

From the menu bar, select Setting => Library Data Setting => Tool,

Tooling.

Edit Tool Data, Tooling Data window appears, as shown below:
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15.4 Addition of Tooling data

Click the Addition button on Edit Tool Data, Tooling Data window.

Addition of Tooling Data dialog appears, as shown below:

A tooling file(Note 1) must be placed in the directory specified in Setting

of Environment Dialog of the Setting menu.

The tooling file can be added in either of the following two ways:

• Creating a tooling file

A new tooling file is created and placed in the Toolin/Tool File directory

specified in Setting of Environment Dialog of the Setting menu.

• Reading an existing tooling file

An existing tooling file is copied into the directory specified in Setting of

Environment dialog of the Setting menu.

NOTE 1

Tool file, tooling file, tool data, and tooling data:

This chapter refers to a file containing data related to tools as a tool

file or tooling file. The data in the tool file or tooling file and the

information registered in the system are referred to as tool data or

tooling data.
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(1) Creating a tooling file

Select the New Making of Tooling File option on Addition of Tooling

Data window.  Specify a tooling name and file name, then click the

OK button.

Edit Tool Data, Tooling Data window appears. For an explanation of

how to edit the tooling, see the section describing modification of the

tooling data.

(2) Reading an existing tooling file

Select the Reading of Tooling File option on Addition of tooling data

window. Specify the directory in which tooling files are stored, then

click the List Display button. Select a target tooling file from the list,

then click the OK button. Addition of Tooling Data window remains

displayed and another tooling file can be read. To return to Edit Tool

Data, Tooling Data dialog, click the Cancel button.
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15.5 Deleting a Tooling

On Edit Tool Data, Tooling Data window, select the tooling name to be

deleted, then click the Delete button. Tooling data referenced during

machining definition cannot be deleted.

The window for deleting a tooling data appears, as shown below:

The tooling data can be deleted in either of the following two ways:

• Deleting the tooling data only from the tooling name list

The tooling is deleted from the tooling name list and cannot be

referenced in machining definition. The tooling file, however, is not

deleted from the Tooling/Tool File directory specified with Settings

of Environment.

• Deleting both the tooling name list entry and the tooling file

The tooling is deleted from the tooling name list.  In addition, the

tooling file is deleted from the Tooling/Tool File directory specified

with Setting of Environment.

To delete the tooling, select the Delete from Tooling Name List option or the

Delete Tooling File option, then click the OK button.
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15.6 Modification of the Tooling Data

On Edit Tool Data, Tooling Data window, select the tooling name to be

edited, then click the Modify button.

The window for modifying tooling data and tool data appears, as shown

below:

Clicking the OK button after editing the tooling data or tool data makes the

edited data effective.

Clicking the Cancel button after editing the data discards all changes that

have been made.

15.6.1 Adding or inserting the tool data for a tool into the tooling data

To add or insert the registered tool data for a tool into the tooling data, select

a target tool from the tool data list on Modify Tool Data, Tooling Data

window, then click the Copy to Tooling Data button.  The tool data for two

or more tools can be copied into the tooling data at one time.

Selecting the Add option of the tooling data causes the tool data to be added

to the end of the tooling data.

Selecting the Insert option causes the tool data to be inserted before the tool

currently selected in the tooling data list.

To display the tool data for another tool type, click Tool Type, display the

tool type list, then select the desired tool type name.
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15.6.2 Registering a new tool and adding or inserting the data into the tooling data

To add or insert the data for a new tool into the tooling data, click the New

Make button in the tooling data field on Modify Tool Data, Tooling Data

window.

The conversational window for registering and modifying tool appears.

• Tool Name

Specify a unique tool name.

• Material Name

Select a tool material from the tool material name list.

To add or delete a tool material name, do so after clicking the

Material Edit button. Tool materials can be registered for individual

tool types.

• Tool No., Offset No.

Specify a tool number and tool offset number for NC data output.

These numbers need not always be specified on this window.  If not

specified, the numbers must be specified in the machining definition.

• Dimension information

Specify the dimensions of a tool.  Specify all dimensions, including

the angle, as a positive value.

To display an explanatory drawing, click the Explanation button.

• Rotate Direction

For a milling tool, specify the direction of rotation for the tool.  For a

turning tool, specify the direction of rotation for the workpiece.
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• Blade Protect Angle (turning tool only)

For pocketing or turning, specify a clearance angle between the

cutting edge and material.

This angle need not always be specified on this window.  If not

specified on this window, however, the angle must be specified in the

machining definition.

• Number of blades

Specify the number of blades of a tool such as a reamer.

• Holder type

Specify the holder type of a tapping tool.

• Mounting position (ZS,XS)

Specify the relative distance between the tip of a tool to the reference

point (usually, the turret turning position) when the tool is mounted.

Clicking the OK button after entering the tool causes the data to be added

to, or inserted into, the tooling data.

Selecting the Add option of the tooling data on Modify Tool Data, Tooling

Data window causes the tool to be added to the end of the tooling data.

Selecting the Insert option of the tooling data causes the tool data to be

inserted before the tool currently selected in the tooling data list.
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15.6.3 Modifying tool registered in the tooling data

To modify tool that has been registered in the tooling data, first select the

target tool from the tooling data list, then click the Modify button for the

tooling data on Modify Tool Data, Tooling Data dialog.

The conversational window for registering and modifying tool data appears.

Modify the tool, then click the OK button.

Multiple tools can be modified in succession by selecting the tools from the

tooling data list and clicking the Modify button.

15.6.4 Duplicating a tool in tooling data

This function is used to modify tooling data only.  Any tool registered in the

tooling data can be duplicated by selecting the tool from the tooling data list

and clicking the Copy button for the tooling data.

A dialog box for tool registration and modification appears.  After

modifying the data in the dialog box, click the OK button.

If the Add to End option has been selected for the tooling data, the copy of

the specified tool is added to the end of the tooling data.

If the Insert before Highlight option has been selected for the tooling data,

the copy of the specified tool is inserted before the selected tool in the

tooling data list.

When more than one tool has been selected from the tooling data list,

clicking the Copy button enables the selected tools to be duplicated in

succession.

15.6.5 Changing the order of the tools in the tooling data

This function is used to modify tooling data only.  The order in which tools

registered in the tooling data will appear can be changed by selecting a tool

from the tooling data list and clicking the Change Order button for the

tooling data.  The following message appears at the bottom of the dialog

box:

Specify the new position for the highlighted (top) line

Selecting a position from the non-highlight list moves the selected tool to

that position.

The positions of two or more tools can be changed at the same time.
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15.6.6 Deleting tooling from the tooling data

To delete tool from the tooling data, select a target tool from the tooling data

list, then click the Delete button for the tooling data on Modify Tool Data,

Tool Data dialog.

A prompt window requesting the user to confirm the deletion appears.  To

delete the data, click the Yes button.

Two or more tools can be deleted at one time.

15.6.7 Registering a new tool and adding or inserting tool data

To add or insert new tool, click the New Make button for the tool data on

Modify Tool Data, Tooling Data dialog.

Modify Tool dialog appears. Enter the tool, then click the OK button. The

tool is added or inserted.

Selecting the Addition option for the tool data on Modify Tool Data, Tooling

Data dialog causes the tool to be added to the end of the tool data.

Selecting the Insert option for the tool data causes the tool to be inserted

before the tool currently selected in the tool data list.

15.6.8 Modifying tool registered in the tool data

To modify registered tool, select the target tool from the tool data list, then

click the Modify button for the tool data on Modify Tool Data, Tooling Data

window.

Modify Tool dialog appears.  After modifying the data, click the OK button.

Multiple tools can be modified in succession by selecting the tools from the

tool data list and clicking the Modify button.

15.6.9 Duplicating the tool in the tool data

This function is used to modify tool data only.  A specific registered tool can

be duplicated by selecting the tool from the tool data list and clicking the

Copy button for the tool data.  Modify Tool dialog appears.  After modifying

the data in the dialog box, click the OK button.

If the Add option has been selected, the specified tool is added to the end of

the existing tool data.

If the Insert option has been selected, the new tool is inserted before the tool

data for the selected tool in the tool data list.

When more than one tool has been selected from the tool data list, clicking

the Copy button causes the tool data for all the selected tools to be

duplicated.
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15.6.10 Changing the order of the tools in the tool data

This function is used to modify tool data only.  The order in which tools

registered in the tool data will be displayed can be changed by selecting a

tool from the tool data list and clicking the Change Order button for the tool

data.  The following message appears at the bottom of the dialog box:

Select Position of Top Reversed List after Changed Order

Selecting a line from the unhighlighted list moves the selected tool to that

line.

The order of two or more tools can be changed at the same time.

15.6.11 Deleting tool from the tool data

To delete registered tool, select the target tool from the tool data list, then

click the Delete button for the tool data.

A prompt window asking the user to confirm the deletion appears.  To delete

the, tool click the Yes button.

The tool for two or more tools can be deleted at the same time.

15.6.12 Adding or deleting a tool material name only

To add or delete a tool material name only, click the New Make button for

the tooling data on Modify Tool Data, Tool Data.

Modify Tool dialog appears.  Tool material names are specified for each tool

type.  Select the target tool type from the tool type list, click the Material

Edit button, then add or delete the material name.

After adding or deleting a tool material name, close the Modify Tool dialog

box by clicking the Cancel button.  Only a tool material name modification

is made.
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16 TOOL/TOOLING DATA UTILITY

This section describes the tool/tooling data utility for the input/output of tool

files and tooling files.

16.1 Functions

The tool/tooling data utility has the following functions.

• Tool/tooling file output

Tool and tooling files are output from “Tooling/Tool File” directory,

specified using Settings of Environment, to a specified directory.

• Tool/tooling file input

Tool and tooling files are input from a specified directory to

Tooling/Tool File directory, specified using Setting of Environment.

• Tooling file change

Tooling names used in, and the name of, a tooling file in a specified

directory are changed.  This function can also be used to copy a

tooling file while leaving the original tooling file as is.
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16.2 Starting the Tool/Tooling Data Utility

The tool/tooling data utility is started from Tool Data, Tooling Data dialog.

To start the utility, select Setting => Library Data Setting => Tool, Tooling

from the menu bar.

The following Tool Data, Tooling Data dialog box appears.

Click the Utility button.  Tool/Tooling data utility dialog box appears.
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16.3 Selecting Utility Functions

Clicking a function button displays the dialog box corresponding to the

selected function.

Clicking the Close button returns you to Tool Data, Tooling Data dialog

box.
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16.4 Outputting Tool/Tooling Files

Clicking the Output button in Tool/Tooling data utility dialog box displays

the following dialog box for tool/tooling file output.

• Output origin

• Tool file list

This is a list of tool files in Tooling/Tool File directory, specified

as the output origin using Setting of Environment.  Tool files

selected from the tool file list are output.

• All (Tool)/Nothing (Tool) button

This button either selects or deselects all the tool files in the tool

list.  Clicking the button toggles between the selection and

deselection of all the tool files.

• Tooling file list

This is a list of tooling files in Tooling/Tool File directory,

specified as an output origin using Setting of Environment.

If a tooling file name in the tooling file list is suffixed with an

asterisk, the relevant information has not been registered as

system management information, even though the tooling file

exists in the directory.

The tooling files selected from the tooling file list are output.

• All (Tooling)/Nothing (Tooling) button

This button either selects or deselects all the tooling files in the

tooling list.  Clicking the button toggles between the selection

and deselection of all the tooling files.

• Output destination

• Directory

This box is used to specify a directory to which the tool/tooling

files are to be output.
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• Tool file list

Clicking the List button displays a list of the tool files in a

specified directory.

• Tooling file list

Clicking the List button displays a list of the tooling files in a

specified directory.

If a tooling file name in the tooling file list is suffixed with an

asterisk, the relevant information has not been registered as

system management information, even though the tooling file

exists in the directory.

• Execution button

Tool and tooling files are output by selecting them from the

respective output origin lists, specifying the output destination

directory, then clicking the Execution button.

The tool and tooling file lists at the output destination are

updated.  Tool/tooling file output can continue after the

completion of update.

It is possible to output more than one tool or tooling file at a

time.

• Close button

Clicking the Close button returns you to Tool/Tooling data

utility dialog box.
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16.5 Inputting Tool/Tooling Files

Clicking the Input button in Tool/Tooling Data Utility dialog box displays

the following dialog box for tool/tooling file input.

• Input destination

• Tool file list

This is a list of the tool files in Tooling/Tool File directory,

specified as an input destination using Setting of Environment.

• Tooling file list

This is a list of the tooling files in Tooling/Tool File directory,

specified as an input destination using Setting of Environment.

If a tooling file name in the tooling file list is suffixed with an

asterisk, the relevant information has not been registered as

system management information, even though the tooling file

exists in the directory.

• Input origin

• Directory

This box is used to specify the directory from which tool/tooling

files are to be supplied.

• Tool file list

Clicking the List button displays a list of the tool files in a

specified directory.

The tool files selected from the tool file list are input.

• All (Tool)/Nothing (Tool) button

This button either selects or deselects all the tool files in the tool

list.  Clicking the button toggles between the selection and

deselection of all the tool files.

• Tooling file list

Clicking the List button displays a list of the tooling files in a
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specified directory.

If a tooling file name in the tooling file list is suffixed with an

asterisk, the relevant information has not been registered as

system management information, even though the tooling file

exists in the directory.

The tooling files selected from the tooling file list are input.

• All (Tooling)/Nothing (Tooling) button

This button either selects or deselects all the tooling files in the

tooling file list.  Clicking the button toggles between the

selection and deselection of all the tooling files.

• Execution button

Tool and tooling files are input by selecting them from the input

origin tool and tooling file list, then clicking the Execution

button.

The tool and tooling file lists at the input destination are

updated.  Tool/tooling file input can continue after the update.

It is possible to input more than one tool or tooling file at a time.

• Close button

Clicking the Close button returns you to Tool/Tooling data

utility dialog box.
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16.6 Changing Tooling Files

Clicking the Change button in Tool/Tooling data utility dialog box displays

the following dialog box for tooling file change.

• Directory

This box is used to specify the directory containing the tooling files

to be changed.  Initially, the box indicates the Tooling/Tool File

directory specified using Setting of Environment.

• Tooling file list

Clicking the List button displays a list of the tooling files in a

specified directory.

If a tooling file name in the tooling file list is suffixed with an

asterisk, the relevant information has not been registered as

system management information, even though the tooling file

exists in the directory.

The tooling files selected from the tooling file list are subjected

to change.

• All (Tooling)/Nothing (Tooling) button

This button either selects or deselects all the tooling files in the

tooling list.  Clicking the button toggles between the selection

and deselection of all the tooling files.

• Execution button

After the target tooling list file has been selected from the list of

tooling list files, clicking the Execution button displays a dialog

box for specifying the name to be used after the change.
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• Original Data is Left

If the check box for this item is not selected, the original tooling

file is replaced with the new tooling file; the original is deleted.

If the check box is selected, the original tooling file is not

deleted.  Different names are used for the original and new

tooling files.

• Tooling Name

This box is used to specify the tooling name for the new tooling

file.

• File Name

This box is used to specify the file name for the new tooling file.

If the Original Data is Left check box is not selected, there is no

need to change the file name.  If the check box is selected, an

error message is displayed unless the original file name differs

from the new file name.

• Next/OK button

If there are other tooling files for which new data is to be

specified, the Next button is displayed.  Once new data has been

specified, clicking the Next button displays a dialog box for

changing the data of the next tooling file.

Once new data for the last tooling file has been specified, the

OK button is displayed.  Clicking the OK button applies the

specified changes, then returns you to the tooling file change

dialog box.

It is possible to change more than one tooling file at a time.

• Cancel button

Clicking the Cancel button returns you to Change of

Tool/Tooling file dialog box without applying the specified

changes.

• Close button

Clicking the Close button returns you to Tool/Tooling data

utility dialog.
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17 NC MACHINE SETTING

With Symbolic CAP T, NC data can be prepared by means of blank figure

creation, part figure creation, and machining definition.  However, the

format of the NC data will vary from one NC machine to another.

To enable these different NC data formats to be handled, Symbolic CAP T

provides NC machine files that are used for NC data output format

management. Editing an NC machine file to tailor it to a particular NC

machine is referred to as NC machine setting.

This chapter describes NC machine setting.

17.1 NC Machine File

When NC data is prepared, an NC machine file is referenced to determine

the NC data output format for the NC machine.
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17.2 Overview of NC Data Preparation Procedure

With Symbolic CAP T, tool path data is created from figure data and

machining data, after which the created tool path data is converted to NC

data.

(1) Tool path data is created from figure data and machining data.

(2) The created tool path data is converted to NC data by referencing

data such as parameters in the NC machine file.
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17.3 Modifying the NC Data Output Format

The output format of the NC data can be tailored to a given NC machine by

editing the NC machine file to suit the NC machine.  Each NC machine file

consists of parameters and machining pattern macros, as shown below.

• Parameters

Parameters are used to determine NC data formats. The output

formats include those of individual functions such as an address word

and G code (such as character string and numeric value formats), and

those based on CNC specifications (such as the circular interpolation

and threading formats).

• Machining pattern macros

Macro programs are used to determine the output formats of

machining patterns (such as tool change, spindle rotation, and

coolant control) other than those for cutting. (For details of the macro

language, refer to the appendix.)

By means of parameter setting, NC data output formats can be modified.

If the output formats cannot be modified as required by parameter setting

alone, the machining pattern macros must be edited.
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• Parameters (machine setting/CNC setting)

Machine

specifications

• Home position and index position setting

• Number of simultaneously controlled axes

• Spindle speeds (maximum and minimum)

• Rapid traverse rate

CNC

specifications

• Modification of address characters (such as move

axes, F, S, and T)

• Total number of numeric value digits

• Whether to output a decimal point

• Number of decimal places

• Minimum input increment

• Output character string modification of G code

and M code

• G code group number modification

• Setting of arbitrary output character strings

• Circular interpolation method

• Whether to use a threading cycle

• Whether to use a hole machining cycle

• Whether to move the home position and index

position

NC data format • Start and end sections of NC data

• Move block (approach, retraction, normal)

• Threading cycle

• Hole machining cycle

• Others



17.  NC MACHINE SETTING B-62824EN/02

-218-

• Machining pattern macros

Start of NC data

(POST_INT)

• Program number and program name

• Sequence number

• ABS/INCR

Tool registration

(POST_TOOL)

• Storing of tool numbers and offset numbers

(only when the use of the ATC function is

specified in the machine specifications)

Coordinate system

registration

(POST_CORD)

• Setting of workpiece coordinate systems

(only when the use of the ATC function is

specified in the machine specifications)

Preprocessing

before start of

machining

(POST_HOME)

• Reference position return (only when this item is

specified in the CNC specifications)

• Coordinate system setting (only when this item is

specified in the CNC specifications)

Start of main

machining(POST_

PROCINT)

• Coordinate system setting  (Whether to output

this information can be specified.)

• Coolant command

• Maximum speed command

• Constant surface speed control command

• Spindle rotation command

• Tool change command

Start of sub-

machining(POST_

PROCSUB)

• Coolant command (not output by default)

• Maximum speed command (not output by

default)

• Constant surface speed control command (not

output by default)

• Spindle rotation command (not output by default)

• Tool change command (not output by default)

Preprocessing

before retraction

(POST_PROCESC

)

• Coolant OFF

• Spindle stop

Termination of

main machining

(POST_PROCEND

)

• Offset cancel (only when this item is set)

Canned

cycle(POST_DRIL

LCYCL)

• Output of each cycle command

End of NC

data(POST_END)

• Reference position return (only when this item is

set in the CNC specifications)

• Program end output
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17.4 Machine Specifications

17.4.1 NC machine name

Assign a name to each NC machine.  After the NC machine files have been

stored, an NC machine file can be selected simply by specifying the NC

machine name.

[Restrictions]

• Maximum number of characters:  24

• Duplicate machine names must not be specified.

17.4.2 Home position/index position

Specify a home position and index position.  Specified data is also displayed

on the Setting of Pre-machining window.

• Position in machine coordinate system

• Index center

• Use a radius value for input.

• Start position for tool path drawing

• Set -1.0 for an unused item.

17.4.3 Total number of axes/number of simultaneously controlled axes

Specify the number of machine axes.

• Total number of axes

• Number of axes that are simultaneously controlled in rapid traverse

• Number of axes that are simultaneously controlled in cutting feed

If the specified number of simultaneously controlled axes is less than the

total number of axes, tool operation is divided into multiple operations so

that the tool can operate within the number of simultaneously controlled

axes.

[Restrictions]

• The number of simultaneously controlled axes must not exceed the

total number of axes.

• A value of 1 or above must be set.
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17.4.4 Feedrate

Set the feedrates as follows:

• Specify a rapid traverse rate for each axis.

• Specified rapid traverse rates are used for machining time

calculation, and are indicated in the machining list.

17.4.5 Spindle speed

Specify the maximum and minimum spindle speeds.

• Specify a maximum and minimum spindle speed for each stage.

• A stage switching command is output if the spindle speed moves

outside the range specified with the maximum and minimum values.

• A minimum or maximum speed is output if no stage is applicable.

• Specify -1 for an unused item.

Example:

Minimum speed for first stage 100

Maximum speed for first stage 4500

Minimum speed for second stage 3000

Maximum speed for second stage 9000

Minimum speed for third stage -1.0

Maximum speed for third stage -1.0

Speed command 2000 → S2000

:

Speed command 4000 → S4000

:

Speed command 6000 → M?? (M code for 2nd

range switching)

:

S6000

:

Speed command 12000 → S9000

17.4.6 Whether to use the ATC function

Specify whether the automatic tool changer (ATC) function can be used with

the NC machine.  When the ATC function is supported, register all tools

and the coordinate systems for every process, using the following machining

pattern macros:

• POST_TOOL():  Tool registration

• POST_CORD():  Coordinate system registration
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17.5 CNC Specifications

17.5.1 Address setting

(1) Address word

Set an address word for the NC data for each function.  The characters set

here are output as NC data.

• Address word (such as a move axis) for real number output

• Address word (such as a T code) for integer output

• Modal management is performed for each function.

• Some address words are set separately for absolute and incremental

programming.

Example:

   First linear axis   “X” → “A”

   Second linear axis   “Y” → “B”

   Third linear axis   “Z” → “C”

G01X100.0Z50.0 → G01A100.0C50.0

[Restrictions]

• Only a single character can be specified for each address word.

(2) Minimum input increment

Specify a minimum input increment for real numbers in the NC data.

Real numbers in the NC data, when output, are rounded according to the

minimum input increment.

• Specify a real number.

• Usually, the same value as that specified for the number of decimal

places is used.

(3) Number of decimal places

Specify the number of decimal places for real numbers in the NC data.

• Specify an integer.

• Usually, the same value as that specified for the minimum input

increment is used.
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(4) Whether to output a decimal point

Specify whether to output a decimal point when outputting real numbers

in the NC data.

Example:

Minimum input increment      0.001

Number of decimal places  3

Movement on the X-axis With a decimal point Without a decimal point

100.1234    → X100.123 X100123

100.0          → X100.0 X100000

(5) Maximum number of digits

Set the maximum number of digits to be used when numeric values (real

numbers and integers) in the NC data are output.

• A warning is output when a numeric value that exceeds the

maximum number of digits is output.

• Specify a value that includes no decimal point nor sign.

17.5.2 G code

Set a G code in the NC data for each function.  The characters set here are

output as NC data.

• Set a group number.

• Modal management is performed on a group-by-group basis.

• Set “G-1” for any unused functions.

Example:

Linear interpolation  “G01”  →  “Linear”

G01X100.0Z50.0  →   LinearX100.0D50.0

[Restrictions]

• Use no more than seven characters for the setting.

17.5.3 M code

Specify an M code in the NC data for each function.  The characters set here

are output as NC data.

• Specify whether to perform modal management.

• Specify “M-1” for any unused functions.

Example:

Subprogram call  “M98”  →   “Call”

M98P1000  →   CallP1000
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[Restrictions]

• Use no more than seven characters for the setting.

17.5.4 Arbitrary character string

Specify arbitrary character strings that will be output in the NC data

regardless of the function.  Up to 16 character strings can be set.  To output

character strings, specify the function code for arbitrary character string

output in the NC data format specification.

17.5.5 Specifying required functions

Specify the CNC functions to be used.  NC data is output based on the

functions specified here.

• Whether to use the constant surface speed control function

• Whether to use a canned hole machining cycle

• Circular interpolation function

• Radius output/IJK output

• Minimum radius/maximum radius

• Allowable error

• Linear axis sign inversion

• Spindle speed fluctuation ratio

Specify a spindle speed fluctuation ratio to output a fluctuated spindle

speed that exceeds the currently set fluctuation ratio.

Example:  When a fluctuation of 0.01 is set

Spindle speed 4000 →  S4000

4010 →  This fluctuation does not exceed the currently set

fluctuation, 4000 ± 40 (= 4000 × 0.01), so this spindle speed is not

output.

4050 →  S4050

• Feedrate fluctuation ratio

Specify a feedrate fluctuation ratio to output a fluctuated feedrate that

exceeds the currently set fluctuation ratio.

Example:  When the currently set fluctuation is 0.01

Feedrate 300 →  F0300

302 →  This fluctuation does not exceed the currently set fluctuation,

300 ± 3 (= 300 × 0.01), so this feedrate is not output.

310 →  F0310
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• Minimum number of digits to be specified in a feedrate command

• Threading

• Whether to use a threading cycle

• Taper direction

• Lead direction

• Number of finish machining passes

• Chamfer amount

0 = 0.0L (L = Lead)

1 = 0.1L

10 = 1.0L

99 = 9.9L

• Format between a home position and index position

• T code output after the completion of machining
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17.6 NC Data Format

By using the function codes for an NC machine file, specify the formats of

the NC data to be output. (For details of the function codes, see the

appendix.)

17.6.1 Example of referencing NC data formats

NC data is output when NC data formats are referenced according to the

following procedure.

• Example of reference
Tool path
data

Movement from the current point (10,10) to (100,100)

Referenced
NC data
format

Movement with or without tool-tip radius compensation

(G90_QG91, G00_QG01,Xmot,Zmot,Fmr,EOB)
1    2 3 4 5 6

1 Output of G codes programmed in either absolute or
incremental mode
->  The G code output format is set in the CNC
specifications.

2 Output of a G code for rapid traverse or cutting feed
->  The G code output format is set in the CNC
specifications.

3 Output of first linear axis
->  The address word output format is set in the CNC
specifications.

4 Output of third linear axis
->  The address word output format is set in the CNC
specifications.

5 Feedrate output
->  The address word output format is set in the CNC
specifications.

6 Output of line feed code
Output NC
data

(a) For rapid traverse in absolute mode

G90G00X100.0Z100.0;

• G90 is output because absolute output is specified.
• G00 is output because of rapid traverse is specified.
• Absolute output of the first and third linear axes
• Because rapid traverse is specified, no F code is

output.

(b) For a feedrate of 100 in incremental mode

G91G01X90.0Z90.0F0100;

• G91 is output because incremental output is
specified.

• G01 is output because cutting feed is specified.
• Incremental output of the first and third linear axes
• Because cutting feed is specified, an F code is output.
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• Example of modification

• To suppress G90/G91 output:

Delete function codes G90_G91.

G00_G01,Xmot,Zmot,Fmr,EOB

• Specify a null string for the G code setting in the CNC

specifications.

“G90” -> “ ”

“G91” -> “ ”

17.6.2 Timing of NC data format reference

Symbolic CAP T supports the standard tool path data output format shown

below. This section explains the NC data format(s) referenced at each

timing. Note, however, that these data formats and their reference timings

are not applicable when machining pattern macros are modified.
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The NC data formats referenced at the individual timings are explained below.

When multiple NC data formats are referenced, the order in which reference

is performed is determined from the order of the machining pattern macro

description or tool path preparation.

g When only
the ATC
function is
supported

g Only when
sub
machining is
performed

:Repeated as many times as the number of processes

  Initial processing

  Start of NC data (POST_INT)

Tool setting (POST_TOOL)/coordinate system setting (POST_CORD)

Preprocessing before the start of machining
(POST_HOME)

Start of main machining (POST_PROCINT)

Cutting

Preprocessing before retraction (POST_PROCESC)

Retraction

Termination of main machining (POST_PROCEND)

Start of sub machining (POST_PROCINT)

Cutting

:Repeated as many times as the number of
sub processes

 End of NC data (POST_END)

 Termination processing
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• Data that can be output in a referenced NC data format can also be

output in a subsequently accessed NC data format, depending on the

state of the modal information (with any codes having the same value

or the same group number not being output).

• The function codes for modal clear (Gclr, Mclr, Tclr, Sclr) and those

for arbitrary character strings (Str1, ..., Str16) can be output at any

time. Note, however, that modal management is not applied to

arbitrary character strings.

(1) Initial processing

• Start of an NC data file

 Referenced NC data format  Data (function code) that can be output
 Leader section  - % (EOR)

 - Feed (FEEDnull, FEEDsp)

(2) Start of NC data

• Start of main program

• Machine type selection

• ABS/INCR

• Sequence number setting

 Referenced NC data format  Data (function code) that can be output
 Start of main program  - Program number (Omain)

 - Program name (Name)

(3) Coordinate system setting/tool setting

• Setting of positions of workpiece coordinate systems for all

processes

• Storing of tool numbers and offset numbers for all processes

 Referenced NC data format  Data (function code) that can be output
 Setting of workpiece coordinate
system positions

 - Workpiece coordinate system number
(Pwcoord)

 - Position of workpiece coordinate
system (Xorg,Zorg)

NOTE

Workpiece coordinate systems are not used. So, the NC data format

“setting of workpiece coordinate system positions” is referenced, but

no NC data is output.



B-62824EN/02 17.  NC MACHINE SETTING

-229-

(4) Preprocessing before start of machining

• Coordinate system specification at the home position (only when

this item is set in the CNC specifications)

• Retract mode ON

 Referenced NC data format  Data (function code) that can be output
 Coordinate system setting  - Coordinate system setting

 (G50 or G92)
 - Coordinates of current point
 (Xmot,Zmot)

(5) Start of main machining

• Start of machining

• Workpiece coordinate system selection

• Machining start point specification

• Coolant ON command

• Maximum speed command

• Constant surface speed control ON/OFF

• Spindle rotation command

• Tool change command

 Referenced NC data format   Data (function code) that can be output
 Machining start section for each
type of machining

 - Machining type (ProcName)

 Workpiece coordinate system
 selection

 - Workpiece coordinate system selection
(G54, ..., G59)

 Coordinate system setting  - Coordinate system setting
(G50 or G92)

 - Coordinates of the current point
 (Xmot,Zmot)

 Coolant ON command or
 coolant OFF command

 - Coolant ON M code (M07_M08)
 - Coolant OFF M code (M09)

 Maximum spindle speed clamp
value specification

 - Maximum speed clamp (G92 or G50)
 - Maximum speed S code (Smaxrpm)

 Constant surface speed control
command, or constant surface
speed control cancel command

 - Constant surface speed control (G96)
 - Constant surface speed control cancel

(G97)

 Spindle rotation command  Constant surface speed control
(G96_G97)
 Spindle rotation M code (M03)
 S code (Srotsur)

 Tool change command block
 output

 Tool number (Tsel)
 Offset number (Hcomlng)

NOTE

Workpiece coordinate systems are not used. So, NC data format

“workpiece coordinate system selection” is referenced, but no NC

data is output.
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(6) Start of sub-machining

Almost the same data as that used for starting main machining can be

used. However, no specifications are added to the standard machining

pattern macros.  Add specifications as required.

(7) Cutting

• Approach operation

• Positioning

• Linear interpolation

• Circular interpolation

• Threading

• Hole machining

• Approach operation
 Referenced NC data format  Data (function code) that can be output
 Movement with or without tool-
 tip radius compensation

 - Positioning or linear interpolation
(G00_G01)

 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current point
 (Xmot,Zmot)

 Command following the first
 approach motion block (when
 the number of simultaneously
 controlled axes is 1)

 - Positioning or linear
 interpolation (G00_G01)
 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current point
 (Xmot,Zmot)

 Command following the second
approach motion block (when
 the number of simultaneously
 controlled axes is 1)

 - Positioning or linear interpolation
(G00_G01)

 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current poin
 (Xmot,Zmot)

 Command following a
 simultaneous specified-axes
 approach motion block (when
 the number of simultaneously
 controlled axes is 2)

 - Positioning or linear interpolation
(G00_G01)

 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current point
 (Xmot,Zmot)
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• Positioning/linear interpolation
 Referenced NC data format  Data (function code) that can be output
 Movement with or without tool-
 tip radius compensation

 - Positioning or linear interpolation
(G00_G01)

 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current point
 (Xmot,Zmot)

 Command following an ordinary
motion block

 - Positioning or linear interpolation
(G00_G01)

 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current point
 (Xmot,Zmot)

 Movement after start of tool-
 tip  radius
compensation(movement
immediately after the
 specification of the start of tool-
 tip radius compensation)
 

 - Positioning or linear interpolation
(G00_G01)

 - Tool-tip radius compensation
(G41_42)

 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current point
 (Xmot,Zmot)

• Circular interpolation
 Referenced NC data format  Data (function code) that can be output
 Circular interpolation move
 command (IJK command,
 ZX plane)

 - Circular interpolation (G02_G03)
 - Plane selection (G18)
 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current point

(Xmot,Zmot)
 - Center position (Icent,Kcent)

 Circular interpolation move
 command (Radius command,
ZX plane)

 - Circular interpolation (G02_G03)
 - Plane selection (G18)
 - ABS/INCR (G90_G91)
 - Feedrate (Fmr)
 - Coordinates of the current point

(Xmot,Zmot)
 - Radius (Rzx)
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• Threading

The referenced NC data formats depend on the threading cycle setting

in the CNC specifications.

 Referenced NC data format  Data (function code) that can be output
 Threading command
 (Normal threading)
 (Tapered threading)

 - Feedrate command (G94_G95)
 - ABS/INCR (G90_G91)
 - Threading (Gthrd)
 - Coordinates (Xmot,Zmot)
 - Lead (Fthrd_lead)

 Threading cycle command
 (normal threading)

 - Threading cycle (Gthrd_cycl)
 - Threading end point coordinates

(Xthrd_cycl,Zthrd_cycl)
 - Lead (Fthrd_lead)
 - Cutting angle (Qthrd_cang)

 Threading cycle command
 (tapered threading)

 - Threading cycle (Gthrd_cycl)
 - Threading end point coordinates

(Xthrd_cycl,Zthrd_cycl)
 - Lead (Fthrd_lead)
 - Taper amount (Ithrd_tapr)

 Multiple repetitive threading
 cycle (normal threading)

 - Multiple repetitive threading cycle
(Gthrd_mul)

 - Threading end point coordinates
 (Xthrd_cycl_mul, Zthrd_cycl_mul)
 - Crest height (Kthrd_height)
 - Initial depth of cut (Dthrd_cut)
 - Lead (Fthrd_lead)
 - Thread angle (Athrd_tang)
 - Threading type (Pthrd_type)
 - Cutting angle (Qthrd_cang)
 - Minimum depth of cut (Qthrd_mincut)
 - Finishing allowance (Rthrd_fallow)
 - Number of finishing passes 

(Pthrd_floop)
 - Chamfer amount (Pthrd_chamf)

 Multiple repetitive threading
 cycle (tapered threading)

 - Multiple repetitive threading cycle
 (Gthrd_mul)
 - Threading end point coordinates
 (Xthrd_cycl_mul, Zthrd_cycl_mul)
 - Taper amount (Ithrd_tapr)
 - Crest height (Kthrd_height)
 - Initial depth of cut (Dthrd_cut)
 - Lead (Fthrd_lead)
 - Thread angle (Athrd_tang)
 - Threading type (Pthrd_type)
 - Cutting angle (Qthrd_cang)
 - Minimum depth of cut (Qthrd_mincut)
 - Finishing allowance (Rthrd_fallow)
 - Number of finishing passes 

(Pthrd_floop)
 - Chamfer amount (Pthrd_chamf)
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• Hole machining

The referenced NC data formats depend on the type of canned cycle.

When no canned hole machining cycle function is used, ordinary

move commands or tapping commands are referenced. The following

data can be output in canned cycles other than the cancel command:

• Return level (G98_G99)

• ABS/INCR (G90_G91)

• Hole position (Xmot)

• Hole bottom position (Zcycl)

• R point coordinate (Rcycl)

• Feedrate (Fmin)

• Number of repeats (Lcode)

Referenced NC data format Data (function code) that can be output
Canned cycle cancel command - Return level (G98_G99)

- Canned cycle cancel (G80)
Tapping cycle - Tapping (G84)

- Dwell (Pcycl)
Reverse tapping cycle - Reverse tapping (G74)

- Dwell (Pcycl)
Rigid tapping - Rigid tapping (G84_2)

- Shift amount (Qsft)
- Dwell (Pcycl)
- S code (Srot)

Reverse rigid tapping - Reverse rigid tapping (G84_3)
- Shift amount (Qsft)
- Dwell (Pcycl)
- S code (Srot)

Boring cycle - Boring (G85/G86/G88/G89)
- Dwell (Pcycl)

Drilling cycle - Drilling (G81)
Peck drilling cycle - Peck drilling (G83/G73)

- Pecking amount (Qpeck)
Specification of a hole position
in a canned cycle
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In hole machining based on Symbolic CAP T, the NC statement output

format depends on the setting of the G code used for the canned cycle of

each machining type and the setting of whether to use a canned cycle

function for each machining type.  The table below indicates the canned

cycle settings for Symbolic CAP T hole machining types in a standard NC

machine file.  By modifying these settings as required, the NC statement

output format can be modified.

• FS15 or FS15-C/Y
Machining type NC data format

referenced (standard G
code setting)

CNC specification
referenced (standard
setting of whether to use
a canned cycle function)

Center drilling Drilling cycle (G81) Drilling cycle function
(used)

Drilling (normal) Drilling cycle (G81) Drilling cycle function
(used)

Drilling cycle (peck
drilling)

Peck drilling cycle 1
(G83)

Peck drilling cycle 1
function (used)

Drilling (high-speed
peck drilling)

Peck drilling cycle 2
(G83.1)

Peck drilling cycle 2
function (used)

Drilling (medium-
speed peck drilling)

None

Tapping Tapping cycle (G84)

Reverse tapping Reverse tapping cycle
(G84.1)

Rigid tapping Rigid tapping cycle (G84)

Reverse rigid
tapping

Reverse rigid tapping
cycle (G84.1)

Reaming Boring cycle 1 (G85) Boring cycle 1 function
(used)

Boring(*) Boring cycle 4 (G89) Boring cycle 4 function
(used)

Fine boring(*) Fine boring cycle (G86.1) Fine boring cycle
function (used)

Counterboring(*) Counter boring (G82) Counter boring function
(used)

Circle cutting(*) None

Chamfering(*) Counter boring (G82) Counter boring function
(used)

Contour
chamfering(*)

None

NOTE

A machining type marked with (*) can be specified only when the

C/Y-axis module is installed.
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• FS1618 or FS1618-C/Y
Machining type NC data format

referenced (standard G
code setting)

CNC specification
referenced (standard
setting of whether to use
a canned cycle function)

Center drilling Drilling cycle (ZX
plane/XY plane) (G83)
Drilling cycle (YZ plane)
(G87)

Drilling cycle function
(used)

Drilling (normal) Drilling cycle (ZX
plane/XY plane) (G83)
Drilling cycle (YZ plane)
(G87)

Drilling cycle function
(used)

Drilling cycle (peck
drilling)

Peck drilling cycle 1 (ZX
plane/XY plane) (G83)
Peck drilling cycle 1 (YZ
plane) (G87)

Peck drilling cycle 1
function (used)

Drilling (high-speed) Peck drilling cycle 2 (ZX
plane/XY plane) (G83)
Peck drilling cycle 2 (YZ
plane) (G87)

Peck drilling cycle 2
function (used)

Drilling (medium-
speed)

None

Tapping Tapping cycle (ZX
plane/XY plane) (G84)
Tapping cycle (YZ plane)
(G88)

Reverse tapping None

Rigid tapping Rigid tapping cycle (ZX
plane/XY plane) (G84)
Rigid tapping cycle (YZ
plane) (G88)

Reverse rigid
tapping

None

Reaming Boring cycle 1 (ZX
plane/XY plane) (G85)
Boring cycle 1 (YZ plane)
(G89)

Boring cycle 1 function
(used)
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Machining type NC data format
referenced (standard G
code setting)

CNC specification
referenced (standard
setting of whether to use
a canned cycle function)

Boring(*) Boring cycle 1 (XY plane)
(G85)
Boring cycle 1 (YZ plane)
(G89)

Boring cycle 1 function
(used)

Fine boring(*) None

Counterboring(*) Drilling cycle (XY plane)
(G83)
Drilling cycle (YZ plane)
(G87)

Drilling cycle function
(used)

Circle cutting(*) None

Chamfering(*) Drilling cycle (XY plane)
(G83)
Drilling cycle (YZ plane)
(G87)

Drilling cycle function
(used)

Contour
chamfering(*)

None

(8) Preprocessing before retraction

• Coolant OFF

• Spindle rotation stop

• Retract mode ON

Referenced NC data format Data (function code) that can be output
Coolant OFF command - Coolant OFF (M09)
Spindle rotation stop command - Spindle rotation stop (M05)
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(9) Retraction

Referenced NC data format Data (function code) that can be output
Retraction without
compensation

- Positioning or linear  interpolation
(G00_G01)

- ABS/INCR (G90_G91)
- Feedrate (Fmr)
- Coordinates of the current point 

(Xmot,Zmot)
- Reference position return (G28/G30)
- Pass position (Xref,Zref)

Command following the first
retract motion block (when the
number of simultaneously
controlled axes is 1)

- Positioning or linear interpolation 
(G00_G01)

- ABS/INCR (G90_G91)
- Feedrate (Fmr)
- Coordinates of the current point 

(Xmot,Zmot)
- Reference position return (G28/G30)
- Pass position (Xref,Zref)

Command following the second
retract motion block (when the
number of simultaneously
controlled axes is 1)

- Positioning or linear
interpolation (G00_G01)

- ABS/INCR (G90_G91)
- Feedrate (Fmr)
- Coordinates of the current point 

(Xmot,Zmot)
- Reference position return (G28/G30)
- Pass position (Xref,Zref)

Command following a
simultaneous specified-axes
retract motion block (when the
number of simultaneously
controlled axes is 2)

- Positioning or linear interpolation 
(G00_G01)

- ABS/INCR (G90_G91)
- Feedrate (Fmr)
-Coordinates of the current point 

(Xmot,Zmot)
- Reference position return (G28/G30)
- Pass position (Xref,Zref)

Retraction after tool-tip radius
compensation cancel
(movement immediately after
the cancellation of tool-tip radius
compensation)

- Positioning or linear interpolation 
(G00_G01)

- ABS/INCR (G90_G91)
- Tool-tip radius compensation cancel 

(G40)
- Feedrate (Fmr)
- Coordinates of the current point 

(Xmot,Zmot)
- Reference position return (G28/G30)
- Pass position (Xref,Zref)
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(10) Termination of main machining

• Offset cancel (only when this item is set)

Referenced NC data format Data (function code) that can be output
Tool selection (offset cancel) - Tool number (Tsel)

- Offset number (Hcomlng)
Termination of each machining
process

- Line feed (EOB only)

(11) End of NC data

• Return to the home position (only when this item is set in the

CNC specifications)

• Program end

Referenced NC data format Data (function code) that can be output
Output of a block specifying
return to the home position

- INCR (G91)
- Reference position return (G28/G30)
- Pass position (Xref,Zref)

End of the main program - Program end (M02 or M30)

(12) Termination processing

• End of an NC data file

Referenced NC data format Data (function code) that can be output
Trailer section - % (EOR)

- Feed (FEEDnull, FEEDsp)
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17.7 Example of NC Data Output

An example of NC data output is given below.

(1) NC data start section

• Example of NC data output

O0001 (PROGRAM-1):  Program number and name

• CNC specification setting

Program number:  “0”

Total number of program number digits:  4

• NC data format

Start of the main program:  Omain, Name, EOB

• Explanation of codes

Omain : Outputs a main program number

Name : Outputs a program name as a comment.

EOB : Line feed code.  When a command other than a line

feed code is output by one function, a line is fed. When

the output of a command is not desired, specify this

code only.

(2) Start section of main machining

• Example of NC data output

(Machining type-1) : Comment

M08 : Coolant ON command

G50S4000 : Maximum spindle speed clamp value

G96S0150M03 : Constant surface speed control, surface

speed, spindle rotation

T101 : Tool change

• CNC specification settings

Coolant (liquid) : “M08”

Coolant (mist) : “M07”

Coordinate system

setting : “G50” (Maximum spindle speed clamp)

S code : “S”

Total number of

S code digits : 5

Constant surface

speed control : “G96”
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Spindle rotation

(clockwise) : “M03”

T code : “T”

Total number of

tool number digits : 2

Tool number

prefixed by 0 : 0

Total number of offset

number digits : 2

• NC data format

Start section of each

machining type : Gclr, FFFF, Sclr, ProcName, EOB

Workpiece coordinate

system selection : EOB

Coordinate system setting : EOB

Coolant ON command : M07_M08, EOB

Specification of a maximum

spindle speed clamp value : G92, Smaxrpm, EOB

Constant surface speed

control command : G96

Spindle rotation command : Srotsur, M03, EOB

Output of a tool change

command block : Tclr, Tsel, Hcomlng, EOB

• Explanation of codes

Gclr, FFFF : Clears G code modal information.  (Gclr clears

group-by-group G code information.  FFFF clears

the G code information for all groups.)

Sclr : Clears S code modal information.  (S codes that

have been held are cleared.)

ProcName : Outputs a machining type as a comment.

M07_M08 : Outputs a coolant ON command.

G92 : Outputs a coordinate system setting or maximum

spindle speed clamp value.

Smaxrpm : Outputs a maximum spindle speed clamp value.

G96 : Outputs a constant surface speed control

command.

Srotsur : Outputs a spindle speed.

M03 : Outputs a spindle rotation command.

Tclr : Clears T code modal information.  (Tool numbers

that have been held are cleared.)

Tsel : Outputs a tool number.

Hcomlng : Outputs an offset number.
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17.8 NC Machine Setting Tool Operation

To enable the editing of an NC machine file, an NC machine setting tool is

provided.  The flow of NC machine file editing using the NC machine

setting tool is described below.

Starting the NC machine setting tool

Choose the NC Machine
Setting Tool icon.

From the menu, select Setting => Library
Data Setting => NC Machine File.

↓
Selecting an NC machine

From the menu, select NC Machine File => Open.

- When creating a new NC machine file, select the most-similar NC machine.

↓
Setting data

From the menu, select Machine Setting => Machine Spec.

From the menu, select CNC Setting => CNC Spec.

From the menu, select CNC Setting => NC Data Format.

- When creating a new NC machine file, the NC machine name in the
machine specifications must be modified.

↓
Saving the NC machine file

From the menu, select NC
Machine File => Save.

From the menu, select NC Machine File =>
Save As.

When creating a new NC machine file, select Save As.

↓
Modifying a comment file including NC data

From the menu, select NC Machine File => Open.

Click the [Edit the Comment] button.

- To create a new NC machine file, modification must be made.

↓
Ending NC machining setting

From the menu, select NC Machine File => Exit.

NOTES

• Enter a character string for a setting item enclosed in double quotation

marks (“). The maximum number of characters is defined for character

string input.

• Enter a numeric value for a setting item that is not enclosed in double

quotation marks (“). Specifiable numeric values are integers and real

numbers.  Restrictions are imposed on integer input for some setting items.
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17.9 Customization

The NC machine setting tool is designed to enable the customization of

setting items and their initial values. Customization is described below.

17.9.1 File configuration

An NC machine file consists of nine files:

• Machine setting files

• xxx.MMF

• xxx.MDF

• CNC setting files

• xxx.CMF

• xxx.CDF

• xxx.FDF

• Machining pattern macro file

• xxx.PMP

• Machine setting + CNC setting

• xxx.MTF

• Prepost processor macro file

• xxx.PMF

• Comment file

• xxx.DOC

• CNC specification parameter file (xxx.CMF)

This file contains CNC-related data, extracted from the NC machine

file referenced at NC data preparation.  This file is newly created at

CNC specification setting.

• CNC specification definition file (xxx.CDF)

This file contains data related to the CNC specifications.  For CNC

specification setting, this file is selected and is displayed in a

window.  This file is newly created at CNC specification setting.

• NC data format definition file (xxx.FDF)

This file contains data related to the NC data output formats.  For NC

data format setting, this file is selected and is displayed in a window.

This file is newly created at NC data format setting.

• Machine specification parameter file (xxx.MMF)

This file contains machine-related data extracted from the NC

machine file referenced at NC data preparation. This file is newly

created at machine specification setting.



B-62824EN/02 17.  NC MACHINE SETTING

-243-

• Machine specification definition file (xxx.MDF)

This file defines data related to machine specifications.  For machine

specification setting, this file is selected and is displayed in a

window.  This file is newly created at machine specification setting.

• Machining pattern macro file (xxx.PMP)

This file contains machining patterns described in the prepost

processor macro language. This file is newly created at machining

pattern macro editing.

• NC machine parameter file (xxx.MTF)

This file is a parameter file referenced at NC data preparation.  This

file is created from the CNC specification parameter file, CNC

specification definition file, NC data format definition file, function

code definition file, machine specification parameter file, and

machine specification definition file by saving the NC machine file.

• Prepost processor macro file (xxx.PMF)

This file is executed at NC data preparation. This file is created from

the machining pattern macro file, prepost macro main file

(PMACMAIN.PMF), prepost macro subfile (PMACSUB.PMF), and

prepost macro header file (MDFILE.H) by saving the NC machine

file.

17.9.2 Modifying initial values

Initial values set in parameters (machine specifications, CNC specifications,

NC data formats) can be modified as necessary.

• Modify the machine specification definition file, CNC specification

definition file, or NC data format definition file.

1) Open a file by using a text editor.

Example:

Machine specification definition file

#define   Home position (X-axis)  100.0

#define   Home position (Y-axis)     0.0

#define   Home position (Z-axis)  100.0

               Symbol section              Data section
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2) Modify the data section of the definition file.

Example:  100.0 -> 0.0

Machine specification definition file

17.9.3 Modifying setting item names

The names of the items to be set for parameter setting (machine

specifications, CNC specifications, NC data formats) can be modified.

• Modify the machine specification definition file, CNC specification

definition file, or NC data format definition file.

1) Open a definition file by using a text editor.

2) Modify the symbol section of the definition file.

Example:  Home position (X-axis) -> Machine zero point (X-

axis)

Machine specification definition file

• Modify the machine specification parameter file or CNC specification

parameter file.

1) Modify the same symbol as that modified in the definition file.

#define  Machine zero point (X-axis)   0.0

#define  Home position (X-axis) 0.0

#define  Home position (Y-axis) 0.0

#define  Home position (Z-axis) 0.0

NOTES

• A character string used as data must be enclosed in double quotation

marks (“).

• To describe a single double quotation mark (“) in a character string,

specify two double quotation marks (““).

• When modifying the data section of the NC data format definition file,

enter a function code symbol name or function code numeric value (4

hexadecimal characters), delimited with a comma.
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Example:  Home position (X-axis) -> Machine zero point (X-axis)

Machine specification parameter file

17.9.4 Deleting setting items

Setting items for parameter setting (machine specifications, CNC

specifications, NC data formats) can be deleted.

• Modify the machine specification definition file, CNC specification

definition file, or NC data format definition file.

1) Open a definition file by using a text editor.

2) Delete a line from the definition file.

Machine specification definition file

• Modify the machine specification parameter file or CNC specification

parameter file.

1) Describe data directly in place of the symbol deleted from the

definition file.

Example:  Home position (X-axis) -> 0.0

Machine specification parameter file

#define  Home position (X-axis)  0.0  ←  Delete

#define  Home position (Y-axis)  0.0

#define  Home position (Z-axis)  0.0

HOME_POSI_XYZ = Machine zero point (X-axis)

Home position (Y-axis)  ,

Home position (Z-axis)

HOME_POSI_XYZ = 0, 0,

Home position (Y-axis),

Home position (Z-axis)

NOTE

When specifying a symbol name, use only alphanumeric characters,

‘_’, and double-byte characters.
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17.9.5 Adding setting items

Setting items for parameter setting (machine specifications, CNC

specifications, NC data formats) can be added.

• Modify the machine specification definition file, CNC specification

definition file, or NC data format definition file.

1) Open a definition file by using a text editor.

2) Add a line to the definition file.

Machine specification definition file

• Modify the machine specification parameter file or CNC specification

parameter file.

1) Describe the symbol added to the definition file.

Machine specification parameter file

HOME_POSI_XYZ = 0.0,

Home position (Y-axis),

Home position (Z-axis),

HOME_POSI_ROT =Home position (α -axis)

0.0,

0.0

#define  Home position (X-axis)  100.0

#define  Home position (Y-axis)  0.0

#define  Home position (Z-axis)  100.0

#define  Home position (α -axis)  0.0

NOTE

When specifying a symbol name, use only alphanumeric characters,

‘_’, and double-byte characters.
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18 FILE TRANSFER

18.1 Function Outline

The file transfer function outputs drawing data to a plotter and transmits NC

data to an external device. It is also used to delete or rename files.

18.1.1 Application software

Two types of application software are provided for file transmission. They

are the File Transmission Tool and the File Transmission Manager.

The File Transmission Tool is used to determine the file to be transmitted,

the device to which that file is to be transmitted, and how the transmission is

to be executed.  These settings are made via a conversational window and

registered in the File Transmission Manager schedule as a transmission job.

The File Transmission Manager executes registered jobs sequentially

according to the schedule.  Other applications can be executed while a file is

being transmitted.

18.1.2 Devices to which data can be transmitted

Data can be transmitted to the following devices via the RS-232C serial port:

• Plotter

Plotter manufactured by FANUC or any HP-GL compatible product

• Paper tape reader/punch

FANUC PPR etc.

• NC unit

NC unit manufactured by FANUC or any unit using an equivalent

protocol

• External memory unit

FANUC Handy File or PROGRAM FILE Mate

• Personal computer and peripherals

Those conforming to the protocols described later
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18.1.3 Data format that can be transmitted

Data to be transmitted to the plotter must conform to HP-GL format. Data

that can be transmitted to an external device is text-format data, such as NC

data, in ASCII, ISO, or EIA code.

18.1.4 Transmission protocols

Protocols for serial communication, free run, and start-stop synchronization

are supported. Flow control can be achieved by using Xon/Xoff or hardware.

18.1.5 File operation functions

The following operations can be performed on those files stored on the

personal computer (both on the hard disk and floppy disks) and on those

files stored in an external memory unit manufactured by FANUC (Handy

File or PROGRAM FILE Mate):

• Displaying a file list

• Deleting or renaming files, designating read-only files, and

designating read/write permitted files

• Specifying the names and numbers of files stored on an external

memory unit
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18.2 Activating the File Transmission Tool

18.2.1 Activation using the Symbolic CAP T output function

Executing the plot out function or NC data output function of Symbolic CAP

T automatically activates the File Transmission Tool.  In this case, however,

the data files that can be output are limited to those related to the figures and

NC data created by Symbolic CAP T.  Also, the file operations described in

Section 18.1.5 cannot be applied.

The following shows an example of the plot out operation:

¬ From the menu, select File => Plot Out.

­ Specify the range of data to be plotted out and other required settings.

Then, click OK.

® The File Transmission Tool is automatically activated.

The defaults for the file to be transmitted, the device to which the file

is to be transmitted, and how the transmission is to be executed have

already been set.
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18.2.2 Activating only the File Transmission Tool

Double-click the File Transmission Tool icon in the Symbolic CAP T group

window of the Program Manager.  Any data file and device can be specified.

Also, the file operations described in Section 18.1.5 can be performed.

File Transmission Tool icon:

18.2.3 Activating the File Transmission Manager

The File Transmission Manager is usually activated automatically by

activating the File Transmission Tool.  Once activated, keep it minimized to

an icon until it is to be used.
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18.3 File Transmission Tool Window

18.3.1 Menus

The following menus are available:

• File menu

This menu is used to send and receive data files and to terminate the

File Transmission Tool.

• Device Select menu

This menu is used to select the device to which the file is to be

transmitted, to register external devices, to specify transmission

conditions, and to cancel device registration.

• Options menu

This menu is used to specify the following:

• Whether transmission results are to be checked and whether an

alarm is to be issued to warn of file overwrite (when a FANUC

external memory unit is being used)

• Whether a TV check is to be performed when outputting NC

data to a file

• Whether the contents of the specified transmission operation are

to be checked and modified before transmission

• Help menu

This menu is used to obtain information about how to use the File

Transmission Tool, and also to determine its version.
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18.3.2 File specification areas

The file specification areas display information relating to the device and

files. These areas are used to specify the files to be transmitted or

manipulated.

A list of files can be specified. File names may be specified by using wild

cards.

For an explanation of the basic file specification procedure, refer to the

Windows documentation.

• File specification area 1
This area is used to specify files stored on the personal computer.

• File specification area 2
This area displays information related to the selected device. If the
selected device supports file operations, the files to be manipulated
can be specified in this area.

18.3.3 Buttons

The following buttons are displayed:

• Send button
Starts the sending of data to the selected device.

• Receive button
Starts the reception of data from the selected device.

• Delete button
Used to delete a file.

• Clear button
Deletes all the files currently displayed in the list.  In the case of the
Handy File, the floppy disk is initialized.

• Rename button
Used to rename a file.

• Read-only button
Used to change the file attribute to read-only.

• Read/write button
Used to change the file attribute to read/write enabled.

• Refresh button
Displays the latest list data in the file specification areas.

18.3.4 Operation guide

Provides operation guidance.

NOTE

The display of this button may be suppressed, depending on

the device being used.
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18.4 Operating Procedure

18.4.1 Selecting the device and setting the transmission conditions

First, select the device to which data is to be transmitted and set the

transmission conditions.

When using the currently selected device and conditions, this step can be

skipped.

For details of how to specify the transmission conditions, see section 18.6.

18.4.2 Specifying files

Specify the files to be transmitted.

If the sending device supports the specification of either the source or

destination file, specify the source file.

Multiple files can be specified.  Select multiple files from the list or specify a

wild card in the file name.

(This step can be skipped when Symbolic CAP T has already specified the

files to be transmitted.)
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18.4.3 Selecting a command

Click desired command button, such as Send, Receive, or Delete.

(This step can be skipped when Symbolic CAP T has already output the

files.)

18.4.4 Changing the contents of the transmission operation

The contents of the transmission operation are displayed as shown below.

The contents of the display can be changed as required.

(1) Discontinuing processing

To discontinue the transmission or manipulation of a file or files:

¬ Select the file or files from the list.

­ Click the Discontinuance button.

(2) Move

To change the order in which the files will be transmitted:

¬ From the list, select the file to be moved.

­ Click the Move Before or Move After button.

® Select the file before or after which the file selected in step 1 will

be placed.

(3) Specify File Name

This is used to specify either a destination file name, or the new file

name when renaming a file.  The destination file name is usually the

same as that of the source file.  (Note that the destination file name

may be modified because of limitations imposed on the file name

length or on the  characters that can be used.)  To specify a file name:

¬ Select a file from the list.

­ Click the Specify File Name button.

® Enter a new file name.

¯ Click OK.
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(4) Destination Directory

This is used to specify a destination directory. All listed files are

transmitted to the specified directory.  To specify a destination

directory:

¬ Click the Destination Directory button.

­ Enter the name of the destination directory.

® Click OK.

18.4.5 Starting transmission

Click OK.

18.4.6 Checking the transmission status

When transmitting files to an internal device, the transmission status can be

checked by referring to the displayed list.

When the error check option has been specified, the results of transmission

are automatically displayed and error messages are output in the event of

any errors occurring.

When transmitting files to an external device, the File Transmission

Manager window displays the registered transmission jobs and their status.

Check whether the jobs are registered in the list.  Also, the job execution

results can be checked.

The following shows an example of the File Transmission Manager window

displaying the transmission status:

Displayed items:

(a) Device names

(b) File names

(c) Amount of data transmitted

(d) Send or receive
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(e) Transmission status

Before transmission:  Blank

After transmission has started:  Start

While data is being sent:  Expected end time

While data is being received:  Expected end time

Once transmission has ended:  Complete

After checking the transmission status, click the Stop button.

18.4.7 Ending the transmission operation

¬ A message appears asking whether the same files are to be

transmitted to another device.  Click the Yes or No button.

­ Select File => Exit from the File Transmission Tool menu.

(This step can be skipped when the File Transmission Tool has been

automatically activated by Symbolic CAP T. In this case, the File

Transmission Tool automatically terminates.)

® While the File Transmission Manager is performing file

transmission, select Manager => Minimize. The File Transmission

Manager window is minimized to an icon, but file transmission

continues.

Once all files have been transmitted, select Manager => Exit.
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18.5 Outline of Processing for Each Function

18.5.1 Send

¬ Select the device to which data is to be sent.

­ Specify the source file in file specification area 1.

® Click the Send button.

¯ If files can be specified for the device to which data is to be sent,

specify the destination file name.  When transmitting data to an

internal device, a specific drive and directory can be specified so that

all files will be transferred to that directory.

° Change the file transmission order or discontinue the transmission if

necessary.

± Click OK to start transmission.

² Check the transmission status by referring to the list displayed by the

File Transmission Manager.

³ Terminate the operation from the Manager menu.

18.5.2 Receive

¬ Select the device from which data is to be received.

­ If files can be specified for the device from which data is to be

received, specify the name of the file from which data is to be

received.  Otherwise, specify the name of the file in which the

received data will be stored.

® Click the Receive button.

¯ When a file from which data will be received has been specified,

specify the name of the file in which the received data will be stored.

A specific drive and directory can be specified so that all files will be

received to that directory.

° Change the file transmission order or discontinue transmission if

necessary.

± Click OK to start transmission.

² Check the transmission status by referring to the list displayed by the

File Transmission Manager.

³ Terminate the operation from the Manager menu.

18.5.3 Delete

¬ When the file to be deleted is stored on an external device, specify

that device.  When it is stored on an internal device, this step can be

skipped.

­ Select the file to be deleted in the file specification area.
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® Click the Delete button.

¯ Cancel the deletion if necessary.

° Click OK to start deletion.

± Check the deletion results by referring to the list displayed by the File

Transmission Manager.

² Terminate the operation from the Manager menu.

18.5.4 Clear

¬ When the files to be deleted are stored on an external device, specify

that device.  When they are stored on an internal device, this step can

be skipped.

­ Click the Clear button.

® Click OK to start deletion.

¯ Check the deletion results by referring to the list displayed by the File

Transmission Manager.

° Terminate the operation from the Manager menu.

18.5.5 Rename

¬ When the file to be renamed is stored on an external device, specify

that device. When it is stored on an internal device, this step can be

skipped.

­ Select the file to be renamed in the file specification area.

® Click the Rename button.

¯ Enter a new file name.

° Cancel renaming of the file if necessary.

± Click OK to start renaming.

² Check the results by referring to the list displayed by the File

Transmission Manager.

³ Terminate the operation from the Manager menu.

18.5.6 Read-only and read/write

¬ When a file whose attribute is to be changed is stored on an external

device, specify that device.  When it is stored on an internal device,

this step can be skipped.

­ Select the file whose attribute is to be changed in the file specification

area.

® Click the Read-Only or Read/Write button.

¯ Cancel file attribute change if necessary.

° Click OK to change the file attribute.

± Check the results by referring to the list displayed by the File

Transmission Manager (this is possible only for files stored on an

external device).
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² Terminate the operation from the Manager menu.

18.5.7 Refresh

Clicking the Refresh button displays the latest data in the file specification

areas.
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18.6 Setting Transmission Conditions

18.6.1 Setting procedure

This procedure is necessary whenever a device is used for the first time.

Create and install a setting file for the device. Then, register the device in

the list of regularly used devices.

(1) Creating a setting file for a new device

¬ Select the Device Select menu.

­ Select File, Plotter, or Other Device from the menu.  When File

is selected, the following steps can be skipped.

® Click the Add button.

¯ Install one of the standard device files.

Select a device from the List of Devices, then click press the Install

button.
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° Select an equivalent device from the installed device list, then

click the Setting button.

± Set the communication condition.

For details, see Section 18.6.4.

² Set the transmission control.

For details, see Section 18.6.5.

³ Set the reception control.

For details, see Section 18.6.6. (When devices is Plotter, this

step can be skipped).

´ Save the settings.

Return to the Setting window, then click the Save As button.

Enter a new name, then click OK.

µ Install the setting file.

Select the file from the List of Devices, then click the Load button

(this operation is the same as that performed in step 4).

 11 From the list, select the device to be added, then click OK.

12 From the device list, select the device to be used, then click the
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Close button.

(2) Changing the device to be used

¬ Select the Device Select menu.

­ Select Plotter or Other Device from the menu, according to the

device type.

® From the device list, select the device to be used.  Then, click the

Close button.

(3) Changing the communication condition

¬ Select the Device Select menu.

­ Select Plotter or Other Device from the menu, according to the

device type.

® Select the device from the list, then click the setting button.

¯ Change the communication condition.

° Click OK.

± From the device list, select the device to be used.  Then, click the

Close button.

(4) Deleting a device from the list

¬ Select the Device Select menu.

­ Select Plotter or Other Device from the menu, according to the

device type.

® Select the device from the list, then click the Remove button.

¯ From the device list, select the device to be used.  Then, click the

Close button.
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18.6.2 Specifying the device and plotter

Install the setting file for the device, then select the device from the list.

• Setting button

Used to set the communication conditions, transmission control, and

reception control.

• Install button

Used to install the device file selected from the List of Devices. The

installed device name, connected port name, and setting file name are

displayed in the Installed Device list.

• Remove button

Used to delete devices from the Installed Device list.

• List of Devices

This list contains the setting files that can be installed. Select the

device to be installed from this list.

• Installed Device list

This list contains the installed device names.  Select the device to be

added to the list of devices to be used.

18.6.3 Standard setting files

The following setting files are provided as standard:

(1) plotter.cmm

For the plotter

(2) fanuc_nc.cmm

For the FANUC CNC series

(3) fanuc_io.cmm

For FANUC external memory units (Handy File and PROGRAM

FILE Mate)
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(4) ppr.cmm

For the paper tape reader/punch (FANUC PPR etc.)

(5) pcaux.cmm

For the personal computer

18.6.4 Setting the communication conditions

• Unit Name
Specify the name of the device to be connected.  A device name can
consist of up to 16 alphanumeric characters.

• File can be specified
Check this item if a FANUC external memory unit (Handy File or
PROGRAM FILE Mate) is to be used.

• Port
Specify the name of the port through which connection is to be made.

• Data Length
Specify the number of bits contained in a one-word data packet.

• Stop bit
Specify a space between characters.

• Parity
Specify a bit that is attached to each data packet to enable the
detection of transmission errors.

• Baud Rate
Specify the transmission speed at which data will be sent to the
connected device.

• Flow Control for Receiving
Specify the method of flow control to be used for data reception.  This
control temporarily suspends data transmission from the connected
device if the receive buffer becomes full.

• Flow Control for Transmitting
Specify the method of flow control to be used for data transmission.
This control monitors the connected device to determine whether it is
capable of receiving data and, if necessary, temporarily suspends data
transmission to the device.

• Xon
Specify the code used to request the transmission of data. This code
is either a hexadecimal code (“0x” plus two digits) or a decimal code
(consisting only of digits).

• Xoff
Specify the code used to suspend the transmission of data. This code
is either a hexadecimal code (“0x” plus two digits) or a decimal code
(consisting only of digits).

• Load
Specify this item to load communication conditions from a previously
saved file.
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• Save As
Specify this item to save the currently specified communication
conditions to a file.

• Transmission Control
Specify this item to switch to the page on which the conditions for
data transmission can be set.

• Reception Control
Specify this item to switch to the page on which the conditions for
data reception can be set.

18.6.5 Setting the transmission control conditions

• Data Code
Select the character code.

• EOB Code
Specify the code indicating the end of a transmitted data block (line).
When specified with a word, this code is either a hexadecimal code
(“0x” plus two digits), a decimal code (consisting only of digits), or a
character string (consisting only of characters).

• TV Check
Specify this item to insert a blank code for TV check into a data
block.

• Feed
Specifying this item causes a feed mark to be output to the paper tape
when the mark is encountered in the transmitted file.  The feed mark
can be added to the file when NC data is created.

• EOF
Specifying this item causes an EOF code to be output when
encountered in the transmitted file.

• Transfer interval
Transfer data is temporarily stored in an area called a buffer.  Specify
the intervals at which the file transfer manager sends the transfer
data into a Windows transmission buffer.  When no value is
specified, 300 ms is assumed.  Usually, this value need not be
changed.  If the remote unit cannot receive data at a lower baud rate,
increase the transfer interval.  Alternatively, decrease the buffer size,
described below.  Increasing the transfer interval reduces the transfer
rate.

• Buffer size
Specify the size of the transmission buffer described above.  When no
value is specified, the system assumes 1024 bytes.  Usually, this value
need not be changed.  If the remote unit cannot receive data at a
lower baud rate, reduce the buffer size.  Alternatively, increase the
transfer interval, which is described above.  Reducing the buffer size
reduces the transfer rate.
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• Timeout
Specify the maximum period that is allowed to elapse before the
receiving device, for which data reception is currently suspended,
becomes ready for receiving data again.

• Preprocessing Data
Set the commands to be used before data transmission.  A command
consists of a combination of a hexadecimal code (“0x” plus
twodigits), a decimal code (consisting only of  digits), and a character
string (consisting only of  characters), each delimited by a comma (,).

• Postprocessing Data
Set the commands to be used after data transmission.  A command
consists of a combination of a hexadecimal code (“0x” plus
twodigits), a decimal code (consisting only of digits), and a character
string (consisting only of characters), each delimited by a comma (,).

• Reception Control
Specify this item to switch to the page on which the conditions for
data reception can be set.

• Communication Condition
Specify this item to switch to the page for saving communication
conditions to a file.

18.6.6 Setting reception control conditions

• Data Code
Select the character code.

• Starting Code
Specify Effective as the Starting Code when data is not to be written
to the file.  Specify Write to enable writing of the starting code to the
file.  This code consists of a combination of a hexadecimal code (“0x”
plus two digits), a decimal code (consisting only of digits), and a
character string (consisting only of characters), each delimited by a
comma (,).

• Ending Code
Specify Effective as the Ending Code when data reception is to be
stopped upon the reception of the ending code. Otherwise, data
reception is not stopped until a timeout occurs.  Specify Write to
enable writing of the ending code to the fill. This code consists of
a combination of a hexadecimal code (“0x” plus two digits), a
decimal code (consisting only of digits), and a character string
(consisting only of characters), each delimited by a comma (,).

• EOB Code
Specify the code indicating the end of a transmitted data block (line).
When specified with a word, this code is either a hexadecimal code
(“0x” plus two digits), a decimal code (consisting only of digits), or a
character string (consisting only of characters).
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• TV Check
Specify this item to detect TV check errors.

• Timeout
Specify the maximum period that is allowed to elapse while waiting
to receive data.

• Preprocessing Data
Set the commands to be used before data reception. A command
consists of a combination of a hexadecimal code (“0x” plus
twodigits), a decimal code (consisting only of digits), and a character
string (consisting only of characters), each delimited by a comma (,).

• Postprocessing Data
Set the commands to be used after data reception. A command
consists of a combination of a hexadecimal code (“0x” plus two
digits), a deci-mal code (consisting only of digits), and a character
string (consisting only of characters), each delimited by a comma (,).

• Transmission Control
Specify this item to switch to the page on which the conditions for
data transmission can be set.

• Communication Condition
Specify this item to switch to the page for saving communication
conditions to a file.
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18.7 Transmission Schedule Management

The File Transmission Manager supports functions for changing the

transmission sequence specified in the schedule for discontinuing data

transmission.

18.7.1 Contents of the window

• Manager menu
Used to terminate the File Transmission Manager.

• Setup menu
Used to create a transmission condition setting file.

• Port box
Used to select the port for which a transmission schedule is to be
displayed.

• On Error check box
Used to specify whether the next job is to be executed or whether
transmission is to be temporarily suspended upon the occurrence of a
transmission error.

• Status list
Displays the transmission schedule in which registered jobs are listed
in the specified sequence, along with their current status.  To change
the schedule, change the positions of the pertinent jobs in this list.

• Pause button
Used to temporarily suspend the execution of a job. Data transmission
can also be suspended.

• Resume button
Used to resume the execution of a job that was previously suspended
using the Pause button.
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• Delete button
Discontinuance a specified job from the schedule.

• Up button
Raises the position of the specified job in the scheduled sequence.

• Down button
Lowers the position of the specified job in the scheduled sequence.

18.7.2 Changing the schedule

• Suspending transmission

Clicking the Pause button temporarily suspends transmission.

• Resuming transmission

Clicking the Resume button resumes the transmission that was

previously suspended.

• Specifying the job to be changed

Select a job from the status list.

• Discontinuing transmission

To discontinue transmission, select the associated job then click the

Delete button.

• Changing the scheduled sequence

To change the job execution sequence specified in the schedule:

¬ Select the job for which the schedule is to be changed.

­ To raise the job's position in the sequence, click Up.

To lower the job's position in the sequence, click Down.
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18.7.3 Exiting the File Transmission Manager

To exit the File Transmission Manager, first select the Manager menu, then

select either of the following:

• Minimize

Selecting Minimize allows another application to be executed while

continuing transmission according to the current schedule.  The File

Transmission Manager is reduced to an icon.

• Exit (Discontinuance of the job)

Selecting Exit cancels the current schedule and forcibly terminates

transmission.
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18.8 Example Transmission Procedures

18.8.1 Transmission to and from the CNC

(1) Reception using the FANUC online cable

¬ Set the CNC transmission conditions. The specified conditions

must be the same as those specified for the paper tape reader

(PPR).

­ Select the transmission device and transmission conditions by

using the File Transmission Tool.

® Start the transmission (reception) of data by using the File

Transmission Tool.

¯ Refer to the Status List to verify that transmission has started.

° Start transmission (punching) within the specified time (one

minute) by using the CNC.

± Check the transmission results in the Status List.

(2) Transmission using the FANUC online cable

¬ Set the CNC transmission conditions. The specified conditions

must be the same as those specified for the paper tape reader

(PPR).

­ Select the transmission device and transmission conditions by

using the File Transmission Tool.

® Start the transmission (reading) of data by using the CNC.

¯ Start transmission by using the File Transmission Tool.

° Check the transmission results in the Status List.

(3) Transmission or reception using the cross cable

¬ Set the CNC transmission conditions.  The specified conditions

must be the same as those specified for the paper tape reader

(PPR).

­ Select the transmission device and transmission conditions by

using the File Transmission Tool.

® Start the transmission or reception of data by using the File

Transmission Tool.

¯ Check the Status List to verify that transmission or reception has

started.

° Start transmission within the specified time (one minute) by

using the CNC.

± Check the transmission results in the Status List.
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19 PLOTTING

This section explains how to output a machining figure and tool path which

have been created.

19.1 Setting up a Plotter

Setup the plotter before starting plotting.

(1) Selecting the plotter setting menu item

Select File => Setup Plotter... from the menu.

(2) Setting communication conditions

Specify where the origin of the plotter will be when a form is loaded.

Select either the lower left corner or the center of the form,

depending on the plotter being used.  For details, refer to the manual

supplied with the plotter.

(3) Shift

The origin of the plotter may not correspond exactly to the lower left

corner or the center of the form, as selected above.  Set any difference

as a shift.

(4) Pens

Specify pen speeds for all the pens mounted on the plotter.  The units

in which the pen speed is specified varies with the plotter being used.

Refer to the manual supplied with the plotter.
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(5) Minimum unit

Set the amount the plotter will actually move for a specified move

amount of 1.  If the minimum unit supported by the plotter is 0.025

mm and the units of the figure dimensions are mm, specify 0.025.

(6) Clipping function ON/OFF

If the plotter supports a command (IW command) that enables the

specification of the drawing area, place a check on the clipping

function to limit plotting to within the range selected at plot out.

(7) Ending setup

Click OK to complete the setup.
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19.2 Procedures

Select File => Plot Out from the menu bar.

(1) Selecting a form size

Select a form size from the displayed list, or type in the form size

data.  When the form size data is typed in, the entered data can be

registered in the list by clicking the Addition button.  To delete any

unnecessary data from the list, select the data from the list and click

the Erase button.  Form size data must be entered according to the

following format.

Form standard name  Form size name  Width*Height  -dx, dy  Unit_

The form standard name, form size name, and units can be specified

using any characters other than an asterisk “*.”   The form size must

be specified in the same units as the figure(s) to be output.  dx

represents the horizontal margin.  dy represents the vertical margin.

(2) Specifying Rotate Axis

Place a check on Rotate Axis to rotate the drawing direction through

90 degrees.
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(3) Setting the scale factor

When auto scale is selected, the figure(s) within the plotting range

are plotted in the drawable area of the form, the maximum scale

factor being applied.  When free scale is selected, type in a scale

factor.

(4) Setting a line pattern length

Enter the lengths of the line patterns, using the same units as those

used to specify the form size.

(5) Setting form division

When No division is selected, the figure in the plotting range is

plotted using the entire form.

When 2 Divisions is selected, the figure in the plotting range is

plotted within the specified division of the two form divisions.

When 4 Divisions is selected, the figure in the plotting range is

plotted within the specified division of the four form divisions.

(6) Specifying the plotting range

Click the Last Position button to output a plot in the same range as

the previous plotting range (for example, when repeating the output

of the most recently plotted figure).   Click the Plotting Range button

to specify a different plotting range.  Specify a plotting range within

the drawing window by means of dragging.
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(7) Position offset

When a new plotting range is specified, the plotting position is

initially specified as follows:

When the origin of the plotter is at the lower left corner of the form,

the lower left position of the drawing area corresponds to the lower

left position of the plotting area.

When the origin of the plotter is at the center of the form, the center

of the drawing area corresponds to the center of the plotting area.

Press the Position Offset button to adjust the plotting position.  In the

drawing window, the plotting range is indicated by a dotted line,

while the form position is indicated by a broken line.  Drag the form

to adjust its position.

(8) Plot out

Clicking OK causes the File Transmission Tool window to appear.

For details of the related procedures, see the chapter on file

transmission.  The file transmission tools can transform data into

files or output data to the plotter.
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20 CAD DATA INPUT/OUTPUT

20.1 CAD Data Input/Output

The following subsections provide a general description of CAD data

input/output.

20.1.1 CAD data

Usually, a CAD/CAM system cannot read the internal data of a dissimilar

system directly, nor write data to such a system.

To overcome this problem, several CAD data formats have been placed in

the public domain.  (Data in such a CAD data format is referred to as CAD

data in this manual.)

Data can be transferred between dissimilar systems, therefore, by converting

that data to CAD data.

Typical CAD data formats include IGES and DXF.

This system allows DXF-format CAD data to be input and output.
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20.1.2 Handling of CAD data by this system

This system can input and output general CAD data.

(1) Input of CAD data

Drawing data created using another CAD system can thus be loaded

into this system.

This data can be handled in the same way as figure entities created

using symbolic CAP T, and be used for the creation of part figures

and others.

Drawing data created using another CAD system can be used for

machining as is, eliminating the need to create figure entities and

thus reducing the lead time.

(2) Output of CAD data

Figure entities created using this system can be output as data for use

in another CAD system.

Parts figures, tool paths, and so on, can also be output as figure

entities.

NOTE

In CAD data input/output, data may not be converted completely.

Any entities that cannot be converted perfectly are converted to the

closest approximation.
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20.2 DXF File Input/Output

The following subsections explain DXF file input/output.

20.2.1 Overview of DXF

DXF(Drawing Interchange Format) is a data format used for drawing data

conversion.

Usually, the extension “.dxf” is appended to a DXF file name.

Data in a DXF file consists of the following sections:

a) HEADER section

Contains general information relating to the drawing.

b) TABLES section

Contains the contents of each of the tables listed below:

• Line type table (LTYPE)

• Drawing layer table (LAYER)

• Character style table (STYLE)

• View table (VIEW)

• User coordinate system table (UCS)

• Viewport setting table (VPORT)

• Dimension style table (DIMSTYLE)

• Application identification table (APPID)

c) BLOCKS section

Contains the data constituting each block of the drawing.

d) ENTITIES section

Contains drawing data, including instructions to reference block

definitions.

e) END OF FILE
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20.2.2 DXF file input

The following illustrates the flow of the DXF file input procedure.

Normal operation
of this system

Start of DXF file input

DXF-Input menu

DXF file selection

Setting
Selection of either input

or setting
Conversion

method setting
End

Input (specification of new
input/additional input, specification
of input coordinate system)

input processing

End of input (input result
display)

Cancel

Cancel

Cancel
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(1) Start of DXF file input

Select File => Exchange CAD data => DXF-Input from the menu.

(2) DXF file selection

Select the DXF file to be input.

Clicking Cancel cancels the input procedure and returns the system

to normal operation.

(3) Selection of either input or setting

Specify whether to start input or set the conversion method.

Input button

Starts input.

Cancel button

Cancels input and returns the system to normal operation.

Setting... button

Displays the window used to set the conversion method.

Using this window, set the conversion method to be used for input.

Help button

Displays help messages relating to input.

(4) Setting the conversion method

When the Setting... button is clicked in 3, the window used to set the

conversion method appears.

For details of the items to be set, see the next subsection.

(5) Input processing

During input processing, a gauge indicating the progress of the

processing is displayed.

To cancel the processing, click the Cancel button.  This returns the

system to normal operation.

(6) Display of input results

When input processing terminates normally, the number of entities

converted, number of layers, the time required for the conversion, and

other information are displayed.
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20.2.3 Setting the input conversion method

The conversion method applied to input can be set.

The following explains the items that can be set.

(1) New input/Additional input

Specify whether the figure database should be initialized before

starting input of the DXF file.

New input:  Initializes the figure database before reading the file.

This is equivalent to inputting the DXF file after selecting File =>

New from the menu.

Additional input:  Does not initialize the figure database before

reading the file.

The figures defined in the DXF file are read and added to the current

figure database.

DXF

DXF

DXF input

[Additional input]

DXF input

This system

This systemThis system This system

This systemThis system
New
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(2) Input/output coordinate system

When inputting a DXF file, the coordinate system to be used for the

entities can be selected.

[World coordinates]

The x, y, and z coordinate values of the DXF file are input, these

being assumed to be the coordinate values in the figure database.

[Coordinates of current window]

The x, y, and z coordinate values of the DXF file are input, these

being assumed to be the coordinate values in the coordinate system

displayed on the window when input starts.

This option is used to read the image of the DXF file directly onto the

window.

(3) Setting a group name

A name can be assigned to a group of settings for conversion methods

4 through 7, as explained below.

Heavy-line entity conversion method 0
Layer conversion method 0
Line type conversion method 0
Color conversion method 0

A group of settings for a previously used conversion method can be easily

reused by assigning a name to the group.

It is convenient if the names assigned to the conversion method setting

groups reflect the system that outputs the DXF files to be converted, or the

intended use of the data to be converted.

(4) Heavy-line entity (TRACE) conversion method

The conversion method applied to heavy-line entities defined in the

DXF file can be specified.

Because heavy-line entities are not supported by this system, they are

converted by means of either of the following methods:

Conversion method
setting group 2

Conversion method
setting group 1

Default conversion method
setting group
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[Center line]

Converts heavy lines to center lines.

DXF This system

(The figure indicated by the broken line is for explanation purposes

only.  It is not included in the actual data.)

[Outline]

Converts heavy lines to polygons representing outlines.

DXF This system

(5) Layer

The conversion method applied to the layers in which entities exist

can be specified.

[Multiple layers to one layer ]

[Layer no.]

[Return to start layer ]

[Layers to layer]

[Start layer no.] [Remain at last layer ]

[Multiple layers to one layer]

Makes entities defined in different layers of the DXF file correspond

to one layer in this system.

DXF This system
Layer 3

Layer 2   Layer No.
 Layer 1

NOTE

Symbolic CAP T does not support multiple layers.  It is

therefore recommended that Multiple layers to one layer be

selected and layer number 1 be used.
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[Layer no.]

Specifies the number of the layer where the converted entities will be

placed.

[Layers to layer]

Makes the entities defined in different layers of the DXF file

correspond to different layers in this system.

DXF This system

 Layer 3            Layer 3

     Layer 2                Layer 2

       Layer 1     Layer 1

[Start layer no.]

Specifies the number of the first of the series of layers in which the

converted entities will be placed.

When Layers to layer is selected, either of the following can be specified

as the method to be applied once the last layer has been used.

[Return to start layer]

When the last layer number of this system is reached, subsequent layers

are made to correspond to the layers of this system starting from the start

layer again.

DXF This system

 Layer 4

 Layer 3 Last layer

  Layer 2 Layer 2

 Layer 1  Layer 1

Start layer

Start layer
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[Remain at last layer]

When the last layer number of this system is reached, all remaining layers

are made to correspond to the last layer.

DXF This system

(6) Line type

Specifies the line type of this system to which each line type specified

in the DXF file should be converted.

A line type can be specified for each of the main 25 line types that

can be specified in a DXF file, as well as for  other line types.

(7) Color

Specifies the color number of this system to which each color number

specified in the DXF file should be converted.

A color number can be specified for each of color numbers 1 through

255 that can be specified in a DXF file.

Layer 4

Layer 3 Last layer

Layer 2Layer 2

Layer 1Layer 1

Start Layer
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20.2.4 DXF file output

The following illustrates the flow of the DXF file output procedure.

DXF file output menu

conv.

end

output processing

normal operationof this system

start of DXF file output

cancel
specify the name

Conversion
method setting

cancel

output(specification of comment,
specification of output coordinate system)

cancel

end (display of result)

Selection of either output or
setting
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(1) Start of DXF file output

From the menu, select File => Exchange CAD data => DXF-Output.

(2) Output file name specification

Specify the name of the DXF file to be output.

Clicking the Cancel cancels the output procedure and returns the

system to normal operation.

(3) Selection of either output or setting

Select either the start of output or setting of the conversion method.

Output button

Starts output.

Cancel button

Cancels output and returns this system to normal operation.

Setting... button

Displays the window used to set the conversion method.

In this window, set the conversion method to be applied to output.

Help button

Displays help messages related to output.

(4) Setting of the conversion method

When the Setting... button is clicked in 3, the window used to set the

conversion method appears.

For details of the items to be set, see the next subsection.

(5) Output processing

During output processing, a gauge indicating the progress of the

output processing is displayed.

To cancel the processing, click the Cancel button.  This returns this

system to normal operation.

(6) Display of conversion results

When the output processing terminates normally, the number of

entities converted, the number of layers, the time required for the

conversion, and other information are displayed.
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20.2.5 Setting the output conversion method

The conversion method applied to output can be set.  The following explains

the items that can be set.

(1) Comment

A comment can be added to the DXF file.

Enter the creator's name, company and position, and a comment if

required.

A comment, if specified, has no effect on the DXF figure data.

(2) Output coordinate system

The coordinate system used for the entities to be output to the DXF

file can be selected.

[World coordinates]

The coordinate values registered in the figure database are output

directly as three-dimensional data to the figure entity DXF file.

[Coordinates of current window]

The figure entities are output to the DXF file as coordinate values in

the coordinate system displayed on the window when output starts.

As a result, the figure entities are output to the DXF file as planar

entities.

World coordinates
Z

Y

X World coordinates

Coordinate of
current window

Window
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(3) Setting a group name

A name can be assigned to a group of settings for conversion methods

4 through 7, as explained below.

A group of settings for a previously used conversion method can be

easily reused by assigning a name to the group.

It is convenient if the names assigned to the conversion method

setting groups reflect the system to which the converted DXF files are

transferred, or the intended use of the data to be converted.

(4) Line approximation for ellipse

When Coordinate of current window is selected as the coordinate

system used to output figure entities, circle and arc entities, viewed

slantwise, are output to the DXF file as ellipses and parts of ellipses.

Because elliptic entities are not included among the entity types that

can be defined in a DXF file, this system approximates ellipses with

fine line segments prior to outputting them.

[Tolerance of line approximation for ellipse]

The allowable tolerance when an ellipse is approximated with fine

line segments is referred to as the line segment approximation

tolerance.  The ellipse is divided into fine line segments, such that the

distances between the ellipse and the line segments do not exceed this

tolerance.

Conversion method
setting group 1

Conversion method
setting group 2

Default conversion method
setting group

Method of line approximation for
ellipse 0
Layer conversion method 0
Line type conversion method 0
Color conversion method 0
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(5) Output layer designation

Specifies whether entities existing in each layer should be output to

the DXF file.

The following three layers can be designated.

[Drawing layer]

Layer in which the figure entities created with the figure definition

exist

[Tool path layer]

This layer is not used with Symbolic CAP T.

[NC path layer]

Layer in which the tool paths drawn with NC Data Preparation exist

For each layer, one of the following output methods can be specified:

[Output all]

The entities existing in the specified layer are output irrespective of

whether the layer is visible or invisible.

[Not output]

The entities existing in the specified layer are not output, irrespective

of whether the layer is visible or invisible.

[Visible entities only]

Whether entities are to be output is determined according to the

current state of their layer.  That is, those entities existing in a layer

are output provided the layer is visible.  They are not output if the

layer is invisible.

(6) Line type

Specifies the line type that can be specified in the DXF file to which

each line type specified in this system should be converted.

Line segment approximation
tolerance



20.  CAD DATA INPUT/OUTPUT B-62824EN/02

-294-

Each of the seven line types supported by this system can be

converted to any of the main 25 line types that can be defined in a

DXF file.

(7) Color

Specifies the color number that can be specified in the DXF file, to

which each of the 16 color types used by this system is to be

converted.

Each of the colors used by this system can be converted to any of

color numbers 1 through 255 that can be defined in a DXF file.
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20.3 Handling CAD Data Efficiently

When data created using another CAD system is to be loaded into this

system, note the following to ensure the optimum efficiency of the

subsequent tasks.

Creating data in another CAD system

(1) Save entities into separate layers according to their purpose.

By saving figure entities in one layer and other entities (such as

dimension lines, drawing frames, and comments) into other layers,

that data to be used for machining can be extracted into this system

more easily.

(2) Delete hatching.

Hatching requires a very large number of entities, adversely affecting

the speed of entity search, redrawing, etc.

Delete as much hatching as possible.

(3) Output high-precision CAD data.

Low-precision CAD data produces coordinate value errors when

converted.

To create data having the best precision possible, output CAD data

using as many digits (as high a precision) as possible.

Operating procedure after CAD data has been loaded into the system

(1) Extract only that data that is required for machining by deleting

all other entities.

This system supports layers and groups.

There are several methods of deleting unnecessary entities from the

converted data, such as the deletion of entities from one layer at a

time, from one group at a time, and deleting one entity at a time.

(2) For low-precision CAD data

Problems may occur due to errors that arise when using converted

data.

When entity gap errors occur, any problems may be handled by

changing the allowable entity gap tolerance.

If this does not solve the current problems, or if it gives rise to other

problems, entities must be corrected or redefined.



20.  CAD DATA INPUT/OUTPUT B-62824EN/02

-296-

20.4 Conversion Specifications for DXF File Input/Output

20.4.1 DXF input conversion specifications

The conversion specifications for DXF file input are explained on a section-

by-section basis.

(1) HEADER section

This system does not reference this section.

(2) TABLES section

DXF

Table entry Description

Handling by

Symbolic CAP T

LTYPE Line type Ignored

LAYER Drawing layer Referenced during conversion

STYLE Character style Ignored

VIEW View Ignored

UCS User coordinate system Ignored

VPORT Viewport Ignored

DIMSTYLE Dimension style Ignored

APPID Application identification Ignored

If the LAYER table entry cannot be found (or if the TABLES section

does not exist), layer information cannot be obtained and, therefore,

converted entities are allocated to one layer; Layers to layer is ignored

if specified for the input conversion method.

(3) BLOCKS section

When the blocks written in the ENTITIES section are to be

converted, they are converted using the data in the BLOCKS section.

(4) ENTITIES section

Figure data appears in the ENTITIES and BLOCKS sections.

In both of these sections, figure data is represented in the same way.

The following table lists the correspondence between the figure data

before conversion and that after conversion.
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Entity type Description Representation in

Symbolic CAP T

LINE Line segment Line segment entity

POINT Point Point entity

CIRCLE Circle Circle entity

ARC Arc Arc entity

TRACE Heavy line Polygon representing the

outline; or center line

SOLID Painted figure Polygon representing the

outline

TEXT Character Not supported.

SHAPE User-defined character Not supported.

BLOCK Block Group entity

ENDBLK End of block Group entity

INSERT Block insert Group entity

ATTDEF Character attribute definition Not supported.

ATTRIB Character attribute Not supported.

PLINE Polyline Polygonal line/polygon

VERTEX Polyline vertex

Details Straight line Straight-line entity in polyline/

polygon

Arc Arc entity in polyline/polygon

Fit curve Not supported.

Spline curve Approximation with polyline/

polygon

Three-dimensional

 polygon mesh

Not supported.

SEQND End of polyline Polyline/polygon

3DFACE Three-dimensional face Polygon representing the

outline

VIEWPORT Viewport Not supported.

DIMENSION Dimension figure Not supported.
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20.4.2 DXF output conversion specifications

The conversion specifications for DXF file output are explained on a

section-by-section basis.

(1) HEADER section

Group code Description Entry in Symbolic CAP T

$ACADVER Version Fixed to “AC1009,” indicating GX-5, as

the version of the AutoCAD drawing

database

$CLAYER Drawing layer

number

Number of the currently effective

drawing layer

$ELEVATION Drawing plane

height

The current drawing plane height is

output.  Fixed to 0 if the output coor-

dinate system is Coordinate of

current window.

$UCSORG Drawing

coordinate

system origin

The origin of the current drawing

coordinate system is output.

Fixed to “0, 0, 0” if the output coordinate

system is Coordinate of current window.

$UCSXDIR X axis of the

drawing

coordinate

system

The direction of the X axis of the current

drawing coordinate system is output.

Fixed to “1, 0, 0” if the output coordinate

system is Coordinate of current window.

$UCSYDIR Y axis of the

drawing

coordinate

system

The direction of the Y axis of the current

drawing coordinate system is output.

Fixed to “0, 1, 0” if the output coordinate

system is Coordinate of current window.

999 Comment Output system name “PCFAPT” and any

comment specified by the user in the

setting window are output.
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(2) TABLES section

Information relating to the current layers is output.

For the drawing layers, the numbers of the layers currently being

used (a layer number being generated for each layer name) and the

display status of the layers (visible or invisible) are output.

No information is output for those layers for which output is not

specified.

Other table entries (LTYPE, STYLE, VIEW, VPORT, and

DIMSTYLE) are not output.

(3) BLOCKS section

Groups and machining figures, as well as any entities which they

contain, are output, together with hierarchical structures.

Groups are output in the format that uses the syntax of the BLOCK

and INSERT of DXF.

The group IDs used internally by this system are used for BLOCK

names.  If any group names exist, they are output as comments.

Machining figures are output as normal group entities, machining

information being removed before the figures are output.

The entities and attributes that constitute groups and machining

figures are the same as those supported by the ENTITIES section.

(4) ENTITIES section

Figure data appears in the ENTITIES and BLOCKS sections.

In both of these sections, figure data is represented in the same way.

The following table lists the correspondence between the figure data

before conversion and that after conversion.

Entity in

Symbolic CAP T

Entity type Description

Point POINT Point

Line segment LINE Line segment

Circle CIRCLE Circle (if the normal vector of the circle is

not horizontal to the Z axis of the world

coordinate system, the projection direction

(210, 220, 230) is also output.)

If Coordinate of current window is

selected and the normal vector is not

horizontal  to the Z axis of the coordinate

system, the circle is approximated with

fine line segments.
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Entity in

Symbolic CAP T

Entity type Description

Arc ARC Arc (if the normal vector of the arc is

not horizontal to the Z axis of the

world coordinate system, the

projection direction (210, 220, 230) is

also output.)

If Coordinate of current window is

selected and the normal vector is not

horizontal to the Z axis of the

coordinate system, the arc is

approximated with fine line segments.

Group entity,

Blank figure,

Parts figure

BLOCK

INSERT

Block definition and block call

Polyline/polygon 3D polyline and the definitions of its

vertexes

Details All

constituent

entities are

line

segments.

POLYLINE

VERTEX

2D polyline and the definitions of its

vertexes

All

constituent

entities are

on the same

plane.

Other than

the above

POLYLINE

VERTEX

BLOCK

INSERT

Block definition and block call

Fitting curve POLYLINE

VERTEX

2D polyline and the definitions of its

vertexes

Each of these entities is output with the following attributes:

• Line type

• Color

• Layer to which the entity belongs
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21 FAPT LANGUAGE FIGURE INPUT

21.1 Overview

The FAPT language figure input function analyzes and executes the figure

definition statements in part programs written in FAPT, converts them to

figure elements to be saved to Symbolic CAP figure databases, and inputs

the conversion results.

Figure elements input from a part program can be handled in exactly the

same way as those created using the figure creation function.
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21.1.1 Figure types that can be input

The following table lists the figure definition statements that can be input.

Each figure definition statement is converted to the corresponding figure

element on the figure database.

FAPT language figure definition statement Figure database

Point definition statement (Pi) Point

Straight line definition statement (Si) Straight line

Circle definition statement (Ci) Circle

Curve definition statement (CVi) Polyline/polygon

Multiple points definition statement (Gi) Multiple points

Fitting curve definition statement (Ti) Fitting curve

21.1.2 FAPT statement types that can be input

In addition to the figure definition statements, the following FAPT

statements can be written in part programs.

• Variable definition statement (Vi)

• Macro instruction statements (MAC and MEND)

• Branch instruction statements (JUMP, IF, and statement number)

• Definition data-related statements (DEL and CHECK)

FAPT language
figure input
function

Figure
database

Part program => =>
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21.2 Operation

21.2.1 Start-up

Select the CAD data exchange-FAPT-input command from the File menu.

21.2.2 Part program selection

Select the file name of a part program to be input.

Clicking the OK button opens the FAPT language figure input dialog box.

Clicking the Cancel button terminates the FAPT language figure input

function.
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21.2.3 FAPT language figure input

Specify how figure data is input from a selected part program file.

• Method for Input

Selects either of the following two figure database input modes:

• New

Inputs figures after the figure database is initialized.

• Additional

Inputs figures without initializing the figure database.

• Coordinate System for Input

Selects either of the following two coordinate systems for use at

input.

• World Coordinate System

Inputs h and v coordinates in FAPT statements as x and y

coordinates in the figure database, respectively.

• Coordinate System Displayed in Drawing Window

Inputs h and v coordinates in FAPT statements as x and y

coordinates in the display coordinate system (view coordinate

system) of the drawing window that has focus when input

begins.
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• Input button

Starts inputting a part program.  If New has been selected, a message

appears to prompt you to specify whether you want to have the

database initialized.

Selecting Yes starts to execute the part program.  Selecting No brings

you back to the FAPT language figure input dialog box.

• Cancel button

Terminates the FAPT language figure input function completely.

• Setting button

Opens the Set FAPT language figure input dialog box.

• Help button

Opens help for the FAPT language figure input function.

21.2.4 Settings related to the FAPT language figure input function

This function lets you make settings for inputting FAPT language figures.

• Programming Coordinate Axes

Selects a programming coordinate system for a part program to be

input.
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• Layer number

Selects a layer number to which a figure element is to belong after it

is input.

• Input Plane Depth

Specifies the height of an input surface for a FAPT language figure as

a third-axis value (default value is 0.0); the FAPT language figure

data is two-dimensional.

• Drawing Color

Specifies the color of a figure element to be used after it is input.  All

figure types are drawn in the specified color except for the CV curve,

for which the color specified using the PCOLOR statement is valid.

• Line type

Specifies the line type of a figure element to be used after it is input.

All figure types are drawn with the specified line type.

• OK button

Saves the settings and brings you back to the FAPT language figure

input dialog box.

• Cancel button

Cancels the settings and brings you back to the FAPT language figure

input dialog box.

• Help button

Opens help for Settings related to the FAPT language figure input

function.

21.2.5 Displaying the progress of input processing

This function opens the following box during input processing of FAPT

language figures to display the progress of processing.

• Stop button

Stops the FAPT language figure input processing.  The figures input

before the Stop button is clicked are not canceled.
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21.2.6 Displaying input information

This function opens the following box when the FAPT language figure input

processing ends (either normally or abnormally).

• Details button

Opens the FAPT input list box to display input results.

The input list contains the following information:

• Part program

• Error information

• Alarm information

• Figure information (variable, point, straight line, and circle)

• Part program file name and file information

• Input start and end time

• OK button

Terminates the FAPT language figure input function.
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21.3 Cautions and Restrictions

• A straight line is drawn after it is clipped according to the setting of

Figure Operating Area in the Figure Operation setting dialog box.

This setting dialog box is displayed by selecting Setting => Parameter

Setting => Figure Operation from the menu.

• A part program created in the P-G/P-H system cannot be used in

Symbolic CAP T, because its format is different.  (Format conversion

can be made using Handy files.)

• In the P-G/P-H system, statements not specified in its manual may

execute with no error detected.  These statements (not conforming to

the FAPT language syntax) may be detected as errors by Symbolic

CAP T, because the latter makes stricter syntax checks.

• Compatibility between the P-G/P-H system and Symbolic CAP T is

maintained as much as possible.  Some statements are not

compatible, however.

• Figure inputs cannot be undo/redo.
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22 DIMENSION MEASUREMENT

22.1 Dimension Measurement Function

This function measures coordinates and distances related to figures.  It can

• Blank figures created by symbolic input method

 
• Figures entered using CAD

• Tool paths

• Tool paths created by NC data preparation
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22.2 Measurable Dimensional Values

The dimension measurement function can measure the dimensional values

listed below.  The measurements can be displayed as required.

Coordinates

• Entity start/end point

• Intersection of two entities (neighborhood to the intersection is

selected)

• Intersection of two entities (two entities are selected)

• Midpoint of an entity

• Center of a circle/arc

• Existing point

• Mouse pointer position

Distances

• Distance between two points (that is measured using the coordinates

mentioned above)

• Distance between a point and entity

• Radius of a circle/arc

Angles

• Angle formed by two lines

NOTE

1. The entities must previously be defined.

2. Measurements are saved to a part file.
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22.3 Activating Dimension Measurement

To start dimension measurement, select Auxiliary => Measurement from the

menu bar.  Detailed descriptions of functions appear.  Select the desired

function from the submenu.

Coordinate Values:

Measures the coordinates explained in Section 22.2.

Distance between Two Points:

Measures the distance between two points.

Distance of Point and Entity:

Measures the shortest distance between a point and a line segment or

arc.

Radius Circle/Arc:

Measures the radius of a circle/arc.

Angle of Two Line:

Measure the angle formed two lines

Display Measured Information:

Displays measured dimensions.
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22.4 Measuring Coordinates

When Auxiliary => Measurement => Coordinate Values is selected from the

menu bar, the prompt area changes as follows:

First select which coordinate type to measure.

Mouse pointer position
Grid display

Existing point

Center of a circle/arc

Midpoint of an entity

Intersection of two entities (two entities
are selected)

Intersection of two entities
(neighborhood to the intersection is
selected)

Entity start/end point

Upon completion of selection, picking an entity whose coordinates you want

to obtain causes measured coordinates to be displayed in the lower right

section of the window.

In the drawing window, the obtained coordinates are indicated with the

mark: ¨

Coordinates can be measured continuously.  To obtain coordinates of the

same type as before, pick entities continuously.  To obtain coordinates of

different types, first select a type, then pick an entity.
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NOTE

It is possible to select the coordinate system of coordinates to be

displayed and the type of an X-coordinate.  The selected types

become valid when measurements are to be displayed as described

in Section 22.9.

To switch between coordinate systems, select the desired coordinate

system from the following combo box.

To switch between X-coordinate types, select the desired X-

coordinate type from the following combo box.
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22.5 Distance between Two Points

When Auxiliary  => Measurement => Distance between Two Points is

selected from the menu bar, the prompt area changes as follows:

Similarly to coordinate measurement, select the desired point type, then pick

the point where measurement is to start.  You will be prompted to specify

the position where measurement is to end.  Pick the desired end position,

and the distance between the two points will be displayed in the lower right

section of the window.

In the drawing window, the distance between the two points is drawn as: ↔
If the type of the specified start position is different from that of the specified

end position, after picking the first position, select the type of the end

position.

It is possible to measure distances continuously.

[Example of a distance between the intersection of two entities and a circle

center]

If this distance is measured, it is
drawn as shown below.
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22.6 

When Auxiliary => Measurement => Distance of Point and Entity is

selected from the menu bar, the prompt area changes as follows:

point where measurement is to start.  The prompt area changes as follows:

Pick the desired entity.  The shortest distance between that entity and the point

picked before will be displayed in the lower right section of the window.

In the drawing window, the distance between the two points is drawn as: 

It is possible to measure distances continuously.

It is impossible to
measure this distance.

NOTE)  Cautions for measuring the shortest distance

The distances measured are determined according to the

relationships between the point and entity as shown below:

• If the entity is a line segment:

 

 

 

 

• If the entity is an arc:
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22.7 Circle/Arc Radius

When Auxiliary => Measurement => Radius of Circle/Arc is selected from

the menu bar, the prompt area changes as follows:

Pick a circle/arc entity whose radius you want to obtain, and the measured

circle/arc radius will be displayed.

In the drawing window, the measured radius is drawn as: Ý

It is possible to obtain radiuses continuously.

     [Obtaining a circle radius] [Obtaining an arc radius:  

The arc center and the

point picked are

connected.]
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22.8 Angles Formed by Two Lines

When Auxiliary => Measurement => Angle of Two Lines is selected from

the menu bar, the prompt area changes as follows:

Pick one of entities that form the angle to be measured, and you will be

prompted to specify the other entity.  Pick the second entity, and the

measured angle will be displayed in the lower right section of the window.

In the drawing window, the measured angle is drawn as: ↔
Drawing of the angle begins at the first entity to be picked.

It is possible to measure angles continuously.

NOTE

It is possible to select the type of an angle to be measured.

To switch between angle types, select the desired one from the

following combo box.
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22.9 Displaying Measurements

When Auxiliary => Measurement => Display Measured Information is

selected from the menu bar, the prompt area changes as follows:

When an entity for which dimension measurement is finished is picked, the

information about a figure that contains the picked entity is displayed.

[If a coordinate entity is picked]

[If a distance entity is picked]

[If a radius entity is picked]

NOTE

It is possible to switch the coordinate system of coordinates to be

displayed and the type of an X-coordinate.
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[If an angle entity is picked]

22.10 Cautions

The following cautions should be observed in measuring dimensions.

(1) The double-head arrow ↔ indicating a distance varies as the figure is

enlarged/reduced.

(2) The heads of the double-head arrow ↔ may become invisible

depending on the display method used.

(3) The attributes (color and line type) of entities whose dimensions are

to be measured are become same as current attributes.
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23 STANDARD SETTING

This chapter explains how to set the initial values displayed on each

conversational window, displayed immediately after Symbolic CAP T starts.

23.1 Standard Setting for Blank Figure and Parts Figure

Set the initial values to be displayed on the conversational window used for

entering blank input data and symbolic figures.

From the menu, select Setting => Standard Setting => Blank Figure, Parts

Figure.

The Standard Setting conversational window appears. Change the values as

desired and click OK.

The following initial values can be set:

• Blank Figure

Select one value from among the listed blank figures.

• Color/Line of Blank

Set the color and line type/width of the blank figure to be displayed

after the blank data input conversational window is cleared.

• Standard Surf Rough

Select a value from among the listed surface roughness values.

• Part Position for Path

Select the part position for the path that will be used when a symbolic

figure is input.
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23.2 Standard Setting for NC Data Preparation

Set the initial values to be displayed on the conversational window used for

NC data preparation.

From the menu, select Setting => Standard Setting => NC Data Preparation.

The Standard Setting conversational window appears.  Change the values as

desired then click OK.

The following initial values can be set:

• Program No.

• Program Name

• Output Mode

Select either Absolute or Incremental.

• Sequence No.

Set sequence number output to ON or OFF and set the initial

sequence number and increment for each machining process or for

each block.

• Sub program

Set items for output in sub program format.
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24 PARAMETER SETTING

This chapter explains how to set the line colors and types used when

Symbolic CAP T is active.

24.1 Parameter setting for View

Make the required settings for the view of coordinate systems and others.

From the menu, select Setting => Parameter Setting => View.

The Setting conversational window appears.  Change the values as desired

and click OK.

The following data items can be set:

• Machining Plane Coordinate System

Set the display of the axis mark, origin mark, and drawing of the

drawing coordinate system to ON or OFF, and set the display range.

• World Coordinate System

Set the display of the axis mark and the origin mark of the world

coordinate system to ON or OFF.

• Grid

Set the display of the grid to ON or OFF; and set the base point

position, space, and number of mark spaces.

• Cursor Tracking

Set the display of cursor tracking to ON or OFF; and set the display

position update timing and the display coordinate system.
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24.2 Parameter Setting for Figure Operation

Make the required settings for figure operation.

From the menu, select Setting => Parameter Setting => Figure Operation.

The Setting conversational window appears.  Change the values as desired

and click OK.

The following data items can be set:

• Figure Operating Area

Set the figure operating area with world coordinate values.

• Figure Calculating Range

Specify whether, when creating a new figure by referencing another

figure, the effective range of the referenced figure should be

processed using the actual sizes of its entities or their extended sizes.

• Plural Possibilities of Figure Creation

Specify whether, when there are multiple figure creation possibilities,

the system should automatically select one according to the selected

position of the referenced figure, or display all possibilities so that the

user can select one.

• Display Attributes for Plural Possibilities of Figure Creation

Set the color and line type/width used to display multiple

possibilities.

• Range of the Straight Line

Set the range of a line segment used when a straight line is created.

• Range of the Arc

Set the range of an arc used when an arc is created.

• Grouping of Plural Points

Specify whether multiple points should be created as a group or as

individual points.

• Polyline/Polygon Created by Trace Mode

Specify whether, when creating a polyline/polygon by tracing, the

polyline/polygon should be created at the same position as the

referenced figure, or whether it should be projected onto the drawing.
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• Group Name

Specify whether, when creating multiple points as a group, the sys-

tem should automatically assign a group name to the points orprompt

the user to assign one.

• Assemble Polyline/Polygon

Set the maximum allowable tolerance to be applied when the system

attempts to determine whether entities are continuous when

assembling polylines/polygons.

• Round/Outer Round/Chamfer (Object Entities)

Specify whether, when inserting a corner R/chamber entity between

two entities, the two entities should be extended or trimmed to the

points where they meet the inserted entity, or be left as is.

• Round/Outer Round/Chamfer (Change Every Corners at a Time)

Set the maximum angle for corners to be inserted when inserting

corner Rs/chambers into polylines/polygons as a batch.

• Offset (Interfering Entities)

Specify whether to remove an interfered element if interference

occurs during offset.

• Offset (Length to Corner Cut Position)

Set the factor used to determine the distance to the corner cut position

when a corner is cut.
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24.3 Parameter Setting for Overall Setting of Symbolic CAP T

Specify the units and the drawing format to be referenced when calculating

machining conditions.

From the menu, select Setting => Parameter Setting => Overall Setting for

Symbolic CAP T.

The Setting conversational window appears. Change the values as desired

and click OK.

The following data items can be set:

• Unit Type

Select either MM or INCH.

• Drawing format

Select a drawing format from among the four supported formats.

• Text Editor Type

The path of text editor which is used to edit created NC data etc. is

specified.

The part which is replaced with object file is described as %file%.

If path has any space character, path is enclosed in double quotes.

(Example 1) notepad %file%

(Example 2) “C:\Program Files\Hidemaru\hidemaru.exe” %file%

• Tool Path Editing Function

Select wheather Tool path editing function is used or not.

24.4 Parameter Setting for Blank Figure and Part Figure

Set the color and line type/width for a part figure.

From the menu, select Setting => Parameter Setting => Blank Figure, Parts

Figure.

The Setting conversational window appears.  Change the values as desired

and click OK.

The following data items can be set:

• Color and Line

Specify the colors and line types/widths for a part figure, grooving,

threading, necking, and an undefined figure.

• Coefficient of a Thread

Specify the thread coefficient used to determine the thread depth.
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24.5 Parameter Setting for Pre-Machining Setting

Set, to ON or OFF, the prompts for Home position, etc., displayed on the

Setting of Pre-machining conversational window.

From the menu, select Setting => Parameter Setting => Setting of Pre-

machining.

The Setting conversational window appears.  Change the values as desired

and click OK.

The following data items can be set:

• Prompt for Home position (ON or OFF)

• Prompt for Index position (ON or OFF)

24.6 Parameter Setting for Machining Definition

The length of arrow which indicate an area division point displayed in

machining definition for Lathe is set.

When Setting => Parameter Setting => Machining Definition is selected

from the menu bar, dialog box for setting appears. It is possible to set the

following data by modifying values and pushing OK button.

• Length of arrow which indicate an area division point

The length of white and green arrows which specify cutting area is

set. The default value is 10.0.

If blank figure or parts figure is too big or small, the value should be

modified.
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24.7 Parameter Setting for Machining Condition Automatic Decision

When the machining condition is decided in machining definition

automatically, the reference value for automatic decision is set.

The dialog box of Parameter Setting of Machining Condition Automatic

Decision is displayed by the following operation.

1. From the Setting menu, select Parameter Setting.

2. From the cascading menu, choose Auto Process Determination.

The reference value for an automatic decision of following machining type

can be set.

Machining Types:

• Common in All Machining

• Center Drilling

• Drilling

• Tapping

• Reaming

• Common in Turning

• Turning : Rough (Outer/Face)

• Turning : Semi Finish (Outer/Face)

• Turning : Finish (Outer/Face)

• Turning:  Rough (Inner)

• Turning : Semi Finish (Inner)

• Turning : Finish (Inner)

• Grooving : Rough (Outer/Face)

• Grooving : Rough (Inner)

• Grooving : Finish (Outer/Face)

• Grooving : Finish (Inner)

• Threading : Outer

• Threading : Front

• Threading : Inner

WARNING

Before programming using the conversational function, ensure that

correct data is set in each item of the conversational window.  Failure

to set correct data may result in the tool colliding with the workpiece

and/or machine, possibly causing damage to the machine,

workpiece, and/or tool itself, or injury to the user.
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(1) Common to all machining types

• Maximum spindle speed

Set the maximum rotation speed of the spindle.

• Tool number

Set the initial value and increment for automatically determining

the tool numbers.

• Compensation number

Set the initial value and increment for automatically determining

the compensation numbers.

(2) Center drilling

• Clearance

Set the clearance in the direction of the tool axis.

• Maximum hole diameter

A tool having a diameter which does not exceed the maximum

hole diameter is selected during automatic tool selection.

(3) Drilling

• Clearance

Set the clearance in the direction of the tool axis, as well as the

secondary clearance.

• Maximum hole diameter

A tool having a diameter which does not exceed the maximum

hole diameter is selected during automatic tool selection.

• Return escape amount

Set the return escape amount for peck drilling.

• Dwell

Set whether the dwell is specified in units of seconds or

revolutions.  Also set the initial dwell.

• Remaining thickness allowing drilling

The automatic determination of drilling processes is not

performed if the remaining cutting allowance is less than the

specified remaining thickness.

• Finishing allowance

A tool is automatically selected according to the hole diameter

with the specified finishing allowance considered.

(4) Tapping

• Clearance

Set the clearance in the direction of the tool axis.

• Dwell

Set whether the dwell is specified in units of seconds or

revolutions.  Also set the initial dwell.
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(5) Reaming

• Clearance

Set the clearance in the direction of the tool axis.

• Dwell

Set whether the dwell is specified in units of seconds or

revolutions.  Also set the initial dwell.

(6) Common to all turning types

• Cutting edge protection angle

Set the cutting edge protection angle for the tool.

• Wall upward cutting method

Select judge according to the angle between the cutting edge and

wall, always cut up, or never cut up

• Angle between the cutting edge and wall for wall upward cutting

Set the threshold angle used to determine whether the wall is to

be traced.

• Pocket

Set whether a pocket portion of the parts figure is to be

machined.

• Overhanging

Set whether an overhanging portion of the parts figure is to be

machined.

(7) Turning:  Roughing (outer or end face)

• Clearance

Set the clearances in the directions of the Z- and X-axes.

• Return escape amount

Set the return escape amounts in the directions of the Z- and X-axes.

• First override value

Set the override value to be used for the first cut.

(8) Turning:  Semifinish machining (outer or end face)

• Clearance

Set the clearances in the directions of the Z- and X-axes.

• Return escape amount

Set the return escape amounts in the directions of the Z- and X-axes.

(9) Turning:  Finishing (outer or end face)

• Clearance

Set the clearances in the directions of the Z- and X-axes.

• Return escape amount

Set the return escape amounts in the directions of the Z- and X-

axes.
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(10) Turning:  Roughing (inner)

• Clearance

Set the clearances in the directions of the Z- and X-axes.

• Return escape amount

Set the return escape amounts in the directions of the Z- and X-

axes.

(11) Turning:  Semifinish machining (inner)

• Clearance

Set the clearances in the directions of the Z- and X-axes.

• Return escape amount

Set the return escape amounts in the directions of the Z- and X-

axes.

(12) Turning:  Finishing (inner)

• Clearance

Set the clearances in the directions of the Z- and X-axes.

• Return escape amount

Set the return escape amounts in the directions of the Z- and X-

axes.

(13) Grooving:  Roughing (outer or end face)

• Clearance

Set the clearance in the direction of the tool axis.

• Return escape amount

Set the return escape amount when the tool moves away from

the groove wall.

• Pecking return escape amount

Set the return escape amount in the direction of the tool axis.

• Dwell

Set whether the dwell is specified in units of seconds or

revolutions.  Also set the initial dwell.

(14) Grooving:  Roughing (inner)

• Clearance

Set the clearance in the direction of the tool axis.

• Return escape amount

Set the groove return escape amount when the tool moves away

from the wall.

• Pecking return escape amount

Set the return escape amount in the direction of the tool axis.

• Dwell

Set whether the dwell is specified in units of seconds or

revolutions.  Also set the initial dwell.
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(15) Grooving:  Finishing (outer or end face)

• Clearance

Set the clearance in the direction of the tool axis.

• Return escape amount

Set the return escape amount when the tool moves away from

the groove wall.

• Dwell

Set whether the dwell is specified in units of seconds or

revolutions.  Also set the initial dwell.

(16) Grooving:  Finishing (inner)

• Clearance

Set the clearance in the direction of the tool axis.

• Return escape amount

Set the return escape amount when the tool moves away from

the groove wall.

• Dwell

Set whether the dwell is specified in units of seconds or

revolutions.  Also set the initial dwell.

(17) Threading:  Outer

• Cutting method

Set the cutting method for threading.

• Clearance

Set the clearances in the directions of the surface, entry, and

exit.

(18) Threading:  Front

• Cutting method

Set the cutting method used for threading.

• Clearance

Set the clearances in the directions of the surface, entry, and

exit.

(19) Threading:  Inner

• Cutting method

Set the cutting method for threading.

• Clearance

Set the clearances in the directions of the surface, entry, and

exit.



B-62824EN/02 24.  PARAMETER SETTING

-331-

24.8 Parameter Setting for Tool Path Creation

Set the approach/escape method, etc.  From the menu, select Setting =>

Parameter Setting => Tool Path Creation.  The setting dialog box appears.

Change the values as desired, then click OK.

The following data items can be set:

• Tool compensation cancel (ON or OFF)

• Constant surface speed effective/not effective (except for hole

machining)

• Approach/escape method

Specify whether approach/escape should be performed for one axis or

two axes at a time.

WARNING

Before programming using the conversational function, ensure that

correct data is set in each item of the conversational window.  Failure

to set correct data may result in the tool colliding with the workpiece

and/or machine, possibly causing damage to the machine,

workpiece, and/or tool itself, or injury to the user.
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24.9 Parameter Setting for NC Data Preparation

Set the colors and line types/widths for the tool paths used during NC data

preparation.

From the menu, select Setting => Parameter Setting => NC Data

Preparation.  The setting dialog box appears.  Change the values as desired,

then click OK.

The following data items can be set:

• Color and line type/width of tool paths (for cutting feed and rapid

traverse)

• Execution list output item

• Graphic item

• NC data file extension

• NC data file overwrite check (ON or OFF)

• Comment characters for each machining type for NC data

preparation

For each machining type, set the comment characters to be output at

the beginning of each process in the NC data.

NOTE

When the C/Y-axis module is installed, comment text for each

machining type can also be set for the C- and Y-axes.
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24.10 Parameter Setting for Auto Saving

Set auto saving of a part file to ON or OFF, and also set the saving interval,

etc.

From the menu, select Setting => Parameter Setting => Auto Saving.

The Setting conversational window appears.  Change the values as desired

and click OK.

The following data items can be set:

• Auto saving (ON or OFF)

• Auto saving interval

• Prompt for Auto Saving (ON or OFF)

• Save file name
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25 TOOL BAR SETTING

25.1 Tool Bar Setting

Select those menu functions that are frequently used and register them as a

tool bar icon.  This saves time and effort when selecting menu items.

25.1.1 Storing the tool bar definition file

The contents of the tool bar are saved in the tool bar definition file.  Make a

copy of this file to guard against it being destroyed.

Normally, the tool bar definition file is registered with file name

'CAPT.TBT' in the same directory as that in which Symbolic CAP T is

installed.  Make copy of this file by using the File Manager, and store it in a

safe place.

25.1.2 Creating icons

When registering a new function from the menu bar, if an icon for the

function is not provided as standard, create a suitable icon by using the

Windows Icon editor.

25.1.3 Displaying the Tool Bar Setting window

From the menu, select Setting => Tool Bar Setting to display the Tool Bar

Setting window.

When displayed, the Tool Bar Setting window displays the contents of the

tool bar and, at the same time, this system enters a special operating state:

• Selecting a function from the side menu results in an error (functions

available from the side menu cannot be registered in the tool bar.)

• Selecting a function on the menu bar then clicking the tool bar is

always interpreted as the addition of that function to the tool bar.

• The prompt area cannot be selected.

NOTE

If Drawing Window is selected by mistake, the Tool Bar Setting window

can be made visible again by minimizing the drawing window.
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25.1.4 Registering menu items

Register a menu item by means of the following procedure:

• On the Tool Bar Setting window, select the number with which the

selected menu function is to be registered.

25.1.5 Deleting buttons/spaces

Delete a button by means of the following procedure:

• On the Tool Bar Setting window, select the number of the button/space to

be deleted.  More than one number can be selected at one time.

• Click the Erase button.

The selected button is deleted.  The buttons subsequent to the deleted button

are moved up, new numbers being assigned to each.

25.1.6 Inserting spaces

Insert a space by means of the following procedure:

• On the Tool Bar Setting window, select the number of the position

where a space is to be inserted.

• Click the Insert Space button.

A space is inserted at the position having the specified number.  The menu

items subsequent to that position are assigned numbers equal to their

previous numbers + 1.

25.1.7 Changing icons

Change an icon by means of the following procedure:

• On the Tool Bar Setting window, select the number of the button for

which the icon is to be changed.

• Click the Change Icon button.

• A list of icons is displayed.  Specify the file corresponding to the new

icon to be registered.

Refer to the help feature for details of the procedure for selecting an icon.

Icon files (files having a .ICO extension) and bitmap files (files having a

.BMP extension) can be used for this purpose.  These files can be created

with the Windows PaintBrush application.
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25.1.8 Saving settings/returning to the normal state

To save the new settings and return to the normal operating state, click the

End button.

Clicking the End button causes the following processing to be performed:

• The new settings are saved to the tool bar definition file.

• The tool bar is redisplayed with the new settings.

• The Tool Bar Setting window is cleared and the system returns to its

normal operating state.

25.1.9 Discarding the settings/returning to the normal state

To discard the new settings and return to the normal operating state, click

the Cancel button.

Clicking the Cancel button causes the new settings to be discarded, the Tool

Bar Setting window to be cleared, and the system to return to its normal

operating state.
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26 TROUBLESHOOTING

26.1 Before Trouble Occurs

Trouble may occur when you are preparing data. So, you should take the

following measures to protect the data from being lost because of any

possible trouble.

• Automatic saving of data being prepared

Automatic saving of data being prepared is enabled by following the

procedure below.

This automatic saving is enabled by default.  The following procedure

can be used when it is necessary to change the file name and update

interval.

(1) From the menu, select Setting => Parameter Setting => Auto

Saving.

(2) Set the amount of standard setting to Saving.

(3) Enter the update interval and extended time.

(4) Enter the name of the file to be saved.

(5) Click OK.

• Executing the save command

Save the data using the save command at the end of each operation.

(1) From the menu, select File => Save.

(2) If the file is going to be saved for the first time, you will be

prompted to specify the file name. Enter the file name when

requested.  If the file has been saved at least once, the data will

be saved immediately after step (1).
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26.2 If Trouble Occurs

This section describes what should be done to recover a normal operation

quickly.

• Saving the current data

Try to save data by following the procedure below.

If it is impossible to execute the procedure, go to the next step.

(1) Press the ALT--TAB keys several times to activate Symbolic

CAP T again.

(2) Press the ESC key several times to make menus selectable.

(3) From the menu, select File => Save.

• Restarting Symbolic CAP T

(1) Exit Symbolic CAP T.

(2) Terminate all applications (if running).

(3) Terminate Windows.

(4) Start Windows.

(5) Start Symbolic CAP T.

If it is impossible to exit Symbolic CAP T or Windows, press the

CTRL-ALT-DEL keys to reset the system.

• Restoring data from a file saved previously

(1) From the menu, select File => Open.

(2) Enter the name of the file previously saved using the save

command or automatic saving.
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26.3 Error Messages

If an error or warning occurs, the window as shown below appears and

describe what the error or warning is like.

The title of the error/warning window is the abbreviation of each function.

CAPSYMT at the top of the window is an abbreviation.  W 0102 is the type

and code of the error/warning.  W stands for warning, and E for error.

Message text describing the error

This button should be pressed after you confirm the message.

Abbreviation of a function in which the error or warning occurred

W and E stand for warning and error, respectively.

Error message number
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26.3.1 Abbreviations of functions

The abbreviation of each function is indicated below.  For details, see the

description of each group of messages.  A message including [C/Y] is output

only with the C/Y-axis module.

–C–

CAPBLANK ..................Messages concerning blank figure creation

(Section 26.3.2)

CAPSYMT ....................Messages concerning part figure creation

(Section 26.3.2)

CHCKANMD ................Messages concerning chuck data setting for

animated simulation (Section 26.3.3)

–F–

FPAUTO........................Messages concerning fully automatic process

determination (Section 26.3.5) [C/Y]

–M–

MACHPLAN .................Messages concerning machining surface setting

(Section 26.3.4)

MPROC .........................Messages concerning process specification

(Section 26.3.5) [C/Y]

–N–

NCOUT..........................Messages concerning NC data creation (Section

26.3.6)

–R–

RGMILLIB ...................Messages concerning the milling library

(Section 26.3.7) [C/Y]

RGSTCOM....................Messages concerning part file reading (Section

2.3.8)

RGSTCOND..................Messages concerning cutting condition setting

(Section 26.3.9)

RGSTTOOL..................Messages concerning tool/tooling data setting

(Section 26.3.10)

–S–

SYMGVPTN .................Messages concerning groove figure creation

(Section 26.3.2) [C/Y]

SYMHLPTN..................Messages concerning hole figure creation

(Section 26.3.2) [C/Y]
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SYMMLPTN .................Messages concerning rectangular/circular figure

creation (Section 26.3.2) [C/Y]

–No abbreviation–

Messages output during setup (Section 26.3.11 (1))

Messages concerning figure selection for modification (Section 26.3.11

(2))18. [C/Y]

Messages concerning machining profile selection (Section 26.3.11 (3))

[C/Y]

26.3.2 Messages related to blank and parts figure creation

[Abbreviation CAPBLANK] ----- Messages related to blank figure creation

Abbreviation-number Message  (Explanation)

[Error]

CAPBLANK-E0101 Cannot delete blank figure.

CAPBLANK-E0102 Data is not put to memory.

[Warning]

CAPBLANK-W0004 Data is empty(Outer,Length,Base-point).

CAPBLANK-W0005 Data is empty(Inner).

CAPBLANK-W0007 Data is not correct.

CAPBLANK-W0008 Machining data is defined for a modified blank figure. [C/Y]

The machining data may become unusable due to a machining profile

modification.  So, be sure to check the machining data before creating NC

data.

[Abbreviation CAPSYMT] ----- Messages related to parts figure creation

Abbreviation-number Message  (Explanation)

[Error]

CAPSYMT-E0001 Parameter-error is occured.

CAPSYMT-E0002 System-error is occured.

CAPSYMT-E0009 No supported error is occured.

CAPSYMT-E0010 Data is end.

CAPSYMT-E0011 Element is over maximum number.

CAPSYMT-E0012 Already figure data is exist.

CAPSYMT-E0013 Figure data is not found.

CAPSYMT-E0014 C.F data is not found.

CAPSYMT-E0015 PCF data is not found.

CAPSYMT-E0016 Element data is not found.

CAPSYMT-E0017  PEL data is not found.

CAPSYMT-E0018  Additional attribute data is not found.

CAPSYMT-E0019  Data is not found.
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CAPSYMT-E0020  Data is using now.
CAPSYMT-E0021  Reference figure data is not found.
CAPSYMT-E0062  Not necessary modifier is specified.
CAPSYMT-E0105  Duplicated open error is occuerd.
CAPSYMT-E0106  Modified open error is occuered for not existed figure.
CAPSYMT-E0107  Added open error is occuered for existed figure.
CAPSYMT-E0110  Next element is not found at current position.
CAPSYMT-E0111  Start-point of element is not exist.
CAPSYMT-E0112  Error information is not exist.
CAPSYMT-E0200  GP(ID) is not deleted.
CAPSYMT-E0201  GP(ID) is not opened.
CAPSYMT-E0202  GP(ID) is not copyed.
CAPSYMT-E0203  GP(ID) is not registered.
CAPSYMT-E0204  GP(ID) is not written.
CAPSYMT-E0205  Data is not read.
CAPSYMT-E0206  End process is not normal.
CAPSYMT-E0230  PPTN function error
CAPSYMT-E0500  Command argument pointer is NULL.
CAPSYMT-E0501  Symbolic figure number is illegal.
CAPSYMT-E0502  Symbolic figure is not exist.
CAPSYMT-E0503  Symbolic figure is not created at new open.
CAPSYMT-E0504  Symbolic figure is not modified at open.
CAPSYMT-E0506  It is impossible to move pointer(PGD) to start-point.
CAPSYMT-E0507  It is impossible to move pointer(PGD) to next element.
CAPSYMT-E0508  It is impossible to move pointer(PGD) to previous element.
CAPSYMT-E0509  It is impossible to move pointer(PGD) to previous/next element.
CAPSYMT-E0510  It is impossible to set data of parts position.
CAPSYMT-E0511  Element table data is not got.
CAPSYMT-E0512  Error is occured in alarm diagnosis.
CAPSYMT-E0513  It is impossible for alarm diagnosis.
CAPSYMT-E0514  Error code is occured in the reference to figure.
CAPSYMT-E0515  It is impossible to update element in the reference to figure.
CAPSYMT-E0517  Figure is not closed.
CAPSYMT-E0518  Process specification data error [C/Y]

Process specification data cannot be read.

[Warning]

CAPSYMT-W0050 Figure is parallel.
CAPSYMT-W0051  Figure is not crossed.
CAPSYMT-W0052  Figure is tangent.
CAPSYMT-W0053  Out of used modifier is specified.
CAPSYMT-W0054  Not decided by specified modifier.
CAPSYMT-W0055  Figure is a concentric circle.
CAPSYMT-W0056 Point is included in circle.
CAPSYMT-W0057  Point is exist on circumference.
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CAPSYMT-W0058  Figure is same figure.

CAPSYMT-W0059  Circle is included by another circle.

CAPSYMT-W0060  Radius is zero or negative value.

CAPSYMT-W0061  Data is over the limit.

CAPSYMT-W0063  Figure is exist in line.

CAPSYMT-W0064  Corner-R value is zero or negative.

CAPSYMT-W0065  Chamfer value is zero or negative.

CAPSYMT-W0066  Corner-R is not inserted.

CAPSYMT-W0067  Chamfer is not inserted.

CAPSYMT-W0068  Grooving is not inserted.

CAPSYMT-W0069  Corner data is not created at grooving.

CAPSYMT-W0070  Threading is not inserted.

CAPSYMT-W0071  Necking is not inserted.

CAPSYMT-W0072  Corner data is not created at necking.

CAPSYMT-W0074  Element is not decided.

CAPSYMT-W0099  Calculated error

CAPSYMT-W0100  Element type is not suitable.

CAPSYMT-W0101  Previous tangent is specified in spite of undefined C.F.

CAPSYMT-W0102  Element definiton data is lack.

CAPSYMT-W0103  End-point of element is not found.

CAPSYMT-W0104  Modifier for decided end-point is not suitable.

CAPSYMT-W0108  Element error at start-point is occured.

CAPSYMT-W0109  Previous element is not found at current position.

CAPSYMT-W0400  Specified element is not inserted at current position.

CAPSYMT-W0401  Specified element is not deleted.

CAPSYMT-W0402  Start-point is not deleted.

CAPSYMT-W0404  Grooving element is not inserted at 1st element.

CAPSYMT-W0405  Thread element is not inserted at 1st element.

CAPSYMT-W0406  Necking element is not inserted at 1st element.

CAPSYMT-W0407  Corner element is not inserted at 1st element.

CAPSYMT-W0408  Corner value is empty.

CAPSYMT-W0409  Figure is not defined.

CAPSYMT-W0410  A process-specified figure is deleted.  Process specification data is also

deleted. [C/Y]

If all entities are deleted while a machining profile that was previously

created by symbolic input is being edited, any previously created

machining profile is deleted.  This message is displayed for a process-

specified machining profile.

CAPSYMT-W0411  An edited figure is not a closed figure. [C/Y]

While a machining profile that was previously created by symbolic input is

being edited, this message is displayed if a mismatch between the start

point and end point results from a modification made to a pocket figure,

island figure, or hollow figure.  Make the modifications necessary to match

the start and end points.
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CAPSYMT-W0412  Machining data is defined for a modified blank figure. [C/Y]

The machining data may become unusable due to a machining profile

modification.  So, be sure to check the machining data before creating NC

data.

While a machining profile that was previously created by symbolic input is

being edited, this message is displayed if a process is specified for the

machining profile.

[Abbreviation SYMGVPTN] ----- Messages concerning groove figure creation [C/Y]

Abbreviation-number Message  (Explanation)

[Error]

SYMGVPTN-E0502 The machining surface is incorrect. [C/Y]

This message is displayed when a selected figure cannot be created using

the currently selected machining surface.

SYMGVPTN-E0504 Input data is insufficient. [C/Y]

This message is displayed when all of the input data required for figure

creation has not been entered.

SYMGVPTN-E0505 Input data is incorrect. [C/Y]

This message is displayed when the input data is incorrect.

SYMGVPTN-E0506 The angle of a groove is too large. [C/Y]

This message is displayed when a value greater than 360° is defined for

the angle of a circular groove on an end face, or for the angle of a groove

around a circular cylinder.

SYMGVPTN-E0507 The angle of a groove is greater than the pitch angle. [C/Y]

This message is displayed when a value greater than the pitch angle is

defined for the angle of a circular groove on an end face, or for the angle

of a groove around a circular cylinder.

SYMGVPTN-E0508 The total of the angles of multiple grooves exceeds 360°°. [C/Y]

This message is displayed when the total of the defined angles of multiple

circular grooves on an end face or multiple grooves around a circular

cylinder exceeds 360°.

SYMGVPTN-E0509 No more than 300 grooves can be defined. [C/Y]

This message is displayed when more grooves than the maximum number

that can be created at one time, namely 300, are entered.

[Abbreviation SYMHLPTN] ----- Messages concerning hole figure creation [C/Y]

Abbreviation-number Message  (Description)

[Error]

SYMHLPTN-E0502 The machining surface is incorrect. [C/Y]

This message is displayed when a selected figure cannot be created using

the currently selected machining surface.
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SYMHLPTN-E0503 The amount of memory is insufficient. [C/Y]

This message is displayed when the amount of memory is too small to

create a figure.

SYMHLPTN-E0504 Input data is insufficient. [C/Y]

This message is displayed when all of the input data required for figure

creation has not been entered.

SYMHLPTN-E0505 Input data is incorrect. [C/Y]

This message is displayed when the input data is incorrect.

SYMHLPTN-E0506 No more than 1000 holes can be defined. [C/Y]

This message is displayed when more holes than the maximum number

that can be created at one time, namely 1000, are entered.

[Abbreviation SYMMLPTN] ----- Messages concerning rectangular/circular figure creation [C/Y]

Abbreviation-number Message  (Description)

[Error]

SYMMLPTN-E0502 The machining surface is incorrect. [C/Y]

This message is displayed when a selected figure cannot be created using

the currently selected machining surface.

SYMMLPTN-E0504 Input data is insufficient. [C/Y]

This message is displayed when all of the input data required for figure

creation has not been entered.

SYMMLPTN-E0505 Input data is incorrect. [C/Y]

This message is displayed when the input data is incorrect.

SYMMLPTN-E0506 A corner R value is too large. [C/Y]

In rectangular figure creation, this message is displayed when a corner R

value is equal to or greater than half of the vertical or horizontal side

length.

26.3.3 Messages related to pre-machining settings

[Abbreviation CHCKANMD] ----- Messages related to chuck data setting for animated simulation

Abbreviation-number Message  (Explanation)

[Error]

CHCKANMD-E1001 Unsuitable type of the chuck.

The set data type of a chuck is inappropriate.  Re-set it.

CHCKANMD-E1002 Short of Memory.

Check the state of the system memory, and restart the system.

CHCKANMD-E1003 Unable to open the kept file 'chcktail.chk'. Please make sure of the

attribute, etc.

CHCKANMD-E1004 Unable to write in the kept file 'chcktail.chk'. Please make sure of the

attribute, etc.

CHCKANMD-E1006 Unable to edit the kept file ‘chcktail.chk’. Please make sure of the

attribute, etc.
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Check whether the chcktail.ctf file (in the directory where the tooling/tool

files specified during environment setting are saved) is write-protected.

CHCKANMD-E1005 Data of the appointed number is not.

CHCKANMD-E1007 Unable to delete a data. Please make sure of the attribute, etc.

Check whether the chcktail.ctf file (in the directory where the tooling/tool

files specified during environment setting are saved) is write-protected.

CHCKANMD-E1008 Unable to open the partfile.

Check whether the currently selected part file is write-protected.

CHCKANMD-E1009 Unable to read a data.

CHCKANMD-E1010 The Current Selected Chuck is unsuitable.

The Current Selected Chuck data, specified as the chuck data used for

animated simulation, is inappropriate. Check whether the data type and

figure data are correct.

CHCKANMD-E1012  System error

CHCKANMD-E1013 Unable to get the element of the blank figure.

CHCKANMD-E1016 Unsuitable blank figure.

Check whether the material figure set up on the Machining Definition

window is correct. It is likely that the figure is crossed or open.

CHCKANMD-E1014 No blank figure.

CHCKANMD-E1015 Unable to get the blank figure.

Set the blank figure on the Machining Definition window.  The blank

figure is used to determine where the chuck is to be located for animated

simulation.

CHCKANMD-E1017 Plural blank figure are selected.

Check whether the blank material is set up correctly on the Machining

Definition window.

[Warning]

CHCKANMD-W2001 Select the edited chuck.

Select one chuck to be edited from the list.

CHCKANMD-W2002 Unable to edit plural data at the same time.

Only one chuck data item can be selected at a time.  Select one chuck to be

edited from the list.

CHCKANMD-W2003 The Current Selected Chuck is not.

The chuck data to be used in animated simulation has not been selected.

CHCKANMD-W2004 Unable to select plural data at the same time.

Only one chuck data item can be used in animated simulation.

CHCKANMD-W2005 Select some data.

For erasure or addition to the registration list, select the chuck data from

the list.

CHCKANMD-W2006 Unable to get the data.

CHCKANMD-W2007 Chuck data 'L' is not. Do you try to set again?

CHCKANMD-W2008 Chuck data 'L1' is not. Do you try to set again?

CHCKANMD-W2009 Chuck data 'W' is not. Do you try to set again?
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CHCKANMD-W2010 Chuck data 'W1' is not. Do you try to set again?

L, L1, W, or W1 has not been set in the chuck data specified to be used in

animated simulation. If the window is exited with No selected, the Current

Selected Chuck data will not be written to the part file.

CHCKANMD-W2011 Please select some data to delete.

For erasure, select the corresponding chuck data from the list. Note,

however, that data cannot be erased from the Current Selected Chuck list.

CHCKANMD-W2012 No Registered Chuck is.

No chuck has been set in the Registered Chuck list.

CHCKANMD-W2013 The Current Selected Chuck is unsuitable for the inner diameter of

the blank figure. Do you try to set again?

The chuck with inner pawls to be used in animated simulation is larger

than the inner diameter of the blank figure, and cannot pick up the blank

figure. Select a chuck smaller than the inner diameter.

26.3.4 Messages concerning machining surface setting

[Abbreviation MACHPLAN] ----- Messages concerning machining surface setting [C/Y]

Abbreviation-number Message  (Description)

[Error]

MACHPLAN-E0211 No turning surfaces and end faces can be deleted.  Only those

machining surfaces (prefixed by * in the list) that were added later can

be deleted. [C/Y]

MACHPLAN-E0212 The machining surface contains machining profiles.  Before deleting

the machining surface, delete those machining profiles. [C/Y]

MACHPLAN-E0213 The height of a machining surface is too large or too small.  The

entered value was unusable. [C/Y]

26.3.5 Messages related to machining definition

[Abbreviation MPROC] ----- Messages concerning process specification

Abbreviation-number Message  (Explanation)

[Error]

MPROC-E0001 There is no area that can be machined. Alternatively, no cutting area

can be determined for a specified tool or cutting condition.

Check that there is an area that can be machined using a specified

machining method.

MPROC-E0002 A tool suitable for machining has not been registered as tooling data.

Add a tool suitable for machining to the tooling data, and rerun.

MPROC-E0003 No cutting condition can be determined automatically, because the

necessary data has not been registered as cutting condition data.
Check that the cutting condition data is registered correctly and that all

necessary data is registered, then rerun.
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MPROC-E0004 Machining is impossible with the specified tool.
Check that the specified tool is appropriate for machining.

MPROC-E0005 A blank figure has not been prepared. Alternatively, a blank figure is

incorrect.
Prepare a blank figure correctly, and rerun.

MPROC-E0006 A parts figure has not been prepared. Alternatively, a parts figure is

incorrect.
Prepare a parts figure correctly, and rerun

MPROC-E0007 No machining profile is created on any machining surfaces. [C/Y]

Retry after creating machining profiles.

MPROC-E0008 On the currently selected machining surface, machining profiles that

can be machined by the specified machining method are not created. [C/Y]

Select a machining surface on which machining profiles are created.

MPROC-E0009 For a turning surface, C/Y-axis machining data cannot be defined. [C/Y]

Select a machining surface other than a turning surface.

MPROC-E0010 The selected figure is not an island figure. [C/Y]

Select an island figure.

MPROC-E0011 The selected figure is not a hollow figure. [C/Y]

Select a hollow figure.

MPROC-E0012 A figure that cannot be machined with the specified machining method

was selected. [C/Y]

Select a figure that can be machined with the specified method.

MPROC-E0013 An error occurred during processing of the initialization file. [C/Y]

The initialization file does not exist under the Windows directory, or a

system environment problem such as insufficient memory has occurred.

After checking the program and system status, restart the system.

MPROC-E0014 An error occurred during processing of the file for automatic

determination. [C/Y]

The file for automatic determination does not exist, or a system

environment problem such as insufficient memory has occurred.  After

checking the program and system status, restart the system.

MPROC-E0015 The same tool number is assigned to different tools. [C/Y]

Check that incorrect tool numbers are not specified.

MPROC-E0016 On the currently selected machining surface, machining profiles of a

specified type are not created.
Retry after creating machining profiles.

MPROC-E0017 The selected figure is not a prepared hole figure. [C/Y]

Select a prepared hole figure.

MPROC-E0018 The selected prepared hole figure is a prepared hole figure of other

machining data, so that the figure cannot be deleted. [C/Y]

Delete the prepared hole figure by modifying the machining data defining

the prepared hole.

MPROC-E0019 Machining data is defined for the selected prepared hole figure, so

that the figure cannot be deleted. [C/Y]

Delete the prepared hole figure after deleting the machining data defined

for the prepared hole figure.
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MPROC-E0020 An attempt was made to delete a prepared hole figure, but machining

data is defined for the figure.  So, the figure cannot be deleted. [C/Y]

Delete the prepared hole figure after deleting the machining data defined

for the prepared hole figure.

MPROC-E0021 Machining data is defined for the current prepared hole figure, so that

the figure cannot be updated. [C/Y]

Create a prepared hole figure after deleting the machining data defined for

the prepared hole figure.

MPROC-E0022 The prepared hole figure cannot be created under the specified

conditions. [C/Y]

Check whether the dimensions of the prepared hole figure are correct.

MPROC-E0023 Under the specified machining conditions, no cutting start point can be

determined automatically. [C/Y]

Check whether the machining conditions are correct.

MPROC-E0024 The selected figure is not a cutting start point. [C/Y]

Select a cutting start point.

MPROC-E0025 All entities of the selected pocketing figure are open entities, so that

there is no area that can be cut. [C/Y]

When all the entities of a pocketing figure are open entities, contouring

cannot be defined.

MPROC-E0026 All entities of the selected pocketing figure are open entities, and no

island figure is defined for the figure, so that there is no area that can

be cut. [C/Y]

Pocketing (side face finishing) cannot be defined for a pocketing figure

when all entities of the figure are open entities, and no island figure is

defined for the figure.

MPROC-E0027 A specified cutting condition is incorrect. [C/Y]

(Depth of cut (tool radius direction) > Tool radius)
Specify a depth of cut (tool radius direction) smaller than the tool radius.

MPROC-E0028 The selected item is not a machining data item, so that the item cannot

be released from the machining group. [C/Y]

Select a machining data item from the process specification list, then retry.

MPROC-E0029 The selected machining data item cannot be released from the

machining group. [C/Y]

No machining data item can be released from a machining group when the

machining group has only one machining data item registered.

MPROC-E0030 Multiple machining data items cannot be released from a machining

group.  Select only one machining data item. [C/Y]

Multiple machining data items cannot be released from a machining

group.  Select only one machining data item from the process specification

list, then retry.

MPROC-E0031 In the last line of the process specification list, auxiliary work cannot

be executed. [C/Y]

In the last line of the process specification list, auxiliary work such as T

code initialization and release from a machining group cannot be executed.
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[Warning]

MPROC-W0200 The cutting method does not match the tool holder type. [C/Y]

The method of tapping (floating/rigid) does not match the specified tool

holder type (floating/rigid).  If a mismatch exists, the tool may be damaged

during machining.  Ensure that there is no mismatch.

MPROC-W0201 A modification was made to the first machining data in the machining

group.  Such a modification may invalidate other machining data of

the machining group.  So, be sure to check the other machining data. [C/Y]

The machining data of the machining group shares the data, including tool

data, of the first machining data.  If a modification is made to data such as

tool data of the first machining data, the cutting conditions of machining

data after the first machining data may become unsuitable, or incorrect NC

data may be created.  So, check the machining data following the first

machining data before creating NC data.

[Abbreviation FPAUTO] ----- Messages concerning fully automatic process determination [C/Y]

Abbreviation-number Message  (Description)

[Error]

FPAUTO-E0001 A figure cannot be created for some reason. [C/Y]

Figure name:  “Figure name”
Data such as figure information and machining information is abnormal,

so that no figure can be created.

FPAUTO-E0002 A prepared hole cannot be created. [C/Y]

Figure name:  “Figure name”
An attempt was made to create prepared holes automatically.  However,

the attempt failed because the position of a prepared hole could not be

determined due to its figure, or because no suitable tool could be found.

FPAUTO-E0003 A tool cannot be found. [C/Y]

Figure name:  “Figure name”
A tool required for the defined machining is not registered in the tooling

file.

FPAUTO-E0004 A cutting condition is not registered. [C/Y]

Figure name:  “Figure name”
A cutting condition for the defined machining is not registered in the

cutting condition library.

FPAUTO-E0005 The combination of a machining profile and machining type is

incorrect. [C/Y]

Figure name:  “Figure name”
Machining cannot be defined by a combination of a machining profile type

and the machining type information associated with the machining profile.
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26.3.6 Messages related to NC data preparation

[Abbreviation NCOUT] -----Messages concerning NC data creation

Abbreviation-number Message  (Explanation)

[Error]

NCOUT-E0001 The error occurred by the instruction when beginning to program.

An error occurred when data was output at the start of the program. The

data (such as O-number) belonging to the program or data common to all

processes is incorrect.  Check the data on the Setting of Pre-machining and

NC Data Preparation Setting windows.

NCOUT-E0002 The error occurred by the instruction when the program ended.

An error occurred when data signifying the end of the program was output.

It is likely that the system environment has a problem, such as insufficient

memory.  Check the program and system state, then restart the system.

NCOUT-E0003 The error occurred by the instruction when the process began(main).

An error occurred when data (such as cutting condition) belonging to a

process was output. It is likely that the command data is out of the

allowable range.  Open the Machining Definition window for the process,

and check the data on it.

NCOUT-E0004 The error occurred by the instruction when the process began(sub).

An error occurred when data (such as cutting condition) belonging to a

process was output. It is likely that the command data is out of the

allowable range. Open the Machining Definition window for the process,

and check the data on it.

NCOUT-E0005 The error occurred by the instruction when the process ended.

An error occurred when data signifying the end of the process was output.

It is likely that the system environment has a problem, such as insufficient

memory.  Check the program and system state, then restart the system.

NCOUT-E0006 The error occurred by instructing in the tool and the coordinates

system setting.

An error occurred when tool or coordinate system setting data was output.

It is likely that the specified data is out of the allowable range. Check the

tool data indicated on the Machining Definition window for the process in

which the error occurred, and the tool and tooling files related to that data.

NCOUT-E0007 The error occurred by the machine stating point position instruction.

An error occurred when the home position data was output. It is likely that

the specified data is out of the allowable range. Check the Home position

on the Setting of Pre-machining window.

NCOUT-E0008 The error occurred by the tool exchange position instruction.

An error occurred when the tool exchange position data was output.  It is

likely that the specified data is out of the allowable range. Check the Index

position on the Setting of Pre-machining window and the Start position of

a process in which the error occurred.



26.  TROUBLESHOOTING B-62824EN/02

-352-

NCOUT-E0009 The error occurred by the tool shape data instruction.
An error occurred when the tool figure data was output. Check the tool

data indicated on the Machining Definition window for the process in

which the error occurred, and the tool file and tooling file for that tool.

NCOUT-E0010 The error occurred the instruction concerning the main axis.
An error occurred when data such as a rotation speed and cutting speed

was output. It is likely that the specified data is out of the allowable range.

Open the Machining Definition window for the process in which the error

occurred, and check the data indicated on it.

NCOUT-E0011 The error occurred by instructing in the tool exchange position the

movement.
An error occurred when a command for moving the tool to the tool

exchange position was issued. It is likely that the specified data is out of

the allowable range. Check the Index position on the Setting of Pre-

machining window and the Start position of a process in which the error

occurred.

NCOUT-E0012 The error occurred by instructing in passed point the movement.
An error occurred when a command for moving the tool to the pass

position was issued. It is likely that the specified data is out of the

allowable range. Check the pass position for a process in which the error

occurred.

NCOUT-E0013 The error occurred by instructing the machine starting point position

or the turret rotating position.
An error occurred when the home or index position data was output. It is

likely that the specified data is out of the allowable range. Check the Home

position and Index position on the Setting of Pre-machining window.

NCOUT-E0020 The data when beginning to program is not correct.
An error occurred when data common to all programs was loaded. Data

that cannot be recognized is included.  Check the data on the Setting of

Pre-machining and NC Data Preparation Setting windows.

NCOUT-E0021 The data when the process begins is not correct.
An error occurred when data related to a process was loaded. Data that

cannot be recognized is included. Check the data on the Machining

Definition window for the process in which the error occurred.

NCOUT-E0022 The data of the tool and the coordinates system setting is not correct.
An error occurred when the tool and coordinate system setting data was

loaded. It is likely that a parameter such as a tool number has not been

specified or that data that cannot be recognized is included.  Check the tool

data and coordinate system selection data on the Machining Definition

window for the process in which the error occurred.

NCOUT-E0023 The process data is not correct.
An error occurred when the process data was loaded. Data that cannot be

recognized is included. Check whether the relevant Machining Definition

window is normal.

NCOUT-E0024 The data for the interference check is not correct.
An error occurred when the interference check data was loaded. Data that
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cannot be recognized is included.  Check the tool data on the Machining

Definition window.

NCOUT-E0025 The tool shape data instruction is not correct.
An error occurred when the tool figure data was loaded. Data that cannot

be recognized is included. Open the Machining Definition window, and

check the tool data for the process in which the error occurred, the tool file

and tooling file for that tool.

NCOUT-E0026 The machine reference point or the turret rotating point is not correct.
An error occurred when the home or index position data was loaded. Data

that cannot be recognized is included. Open the Setting of Pre-machining

window, and check the Home position and Index position data.

NCOUT-E0030 The data for the roughness processing is not correct.
An error occurred when the cutting condition data for roughing was

loaded. Data that cannot be recognized is included. Open the Machining

Definition window, and check the cutting condition data for the process in

which the error occurred.

NCOUT-E0031 The data for the semi-finishing processing is not correct.
An error occurred when the cutting condition data for semi-finishing was

loaded. Data that cannot be recognized is included. Open the Machining

Definition window, and check the cutting condition data for the process in

which the error occurred.

NCOUT-E0032 The data for the finishing processing is not correct.
An error occurred when the cutting condition data for finishing was

loaded. Data that cannot be recognized is included. Open the Machining

Definition window, and check the cutting condition data for the process in

which the error occurred.

NCOUT-E0033 The data for the hole opening processing is not correct.
An error occurred when the cutting condition data for hole machining was

loaded. Data that cannot be recognized is included. Open the Machining

Definition window, and check the cutting condition data for the process in

which the error occurred.

NCOUT-E0034 The data for the grooving processing data is not correct.
An error occurred when the cutting condition data for grooving was

loaded. Data that cannot be recognized is included. Open the Machining

Definition window, and check the cutting condition data for the process in

which the error occurred.

NCOUT-E0035 The data for the threading processing is not correct.
An error occurred when the cutting condition data for threading was

loaded. Data that cannot be recognized is included. Open the Machining

Definition window, and check the cutting condition data for the process in

which the error occurred.

NCOUT-E0036 The data for the necking processing is not correct.
An error occurred when the cutting condition data for necking was loaded.

Data that cannot be recognized is included. Open the Machining

Definition window, and check the cutting condition data for the process in

which the error occurred.
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NCOUT-E0050 The machining face data cannot be acquired.

An attempt to obtain the machining plane data failed. It is likely that the

system environment has a problem, such as insufficient memory. Check

the program and system state, then restart the system.

NCOUT-E0051 The cutting area cannot be acquired.

An attempt to obtain a machining area failed. It is likely that no

machining area was prepared during machining definition. It is also likely

that the system environment has a problem, such as insufficient memory.

Check the program and system state, then restart the system.

NCOUT-E0052 The process data cannot be acquired.

An attempt to obtain the process data failed. It is likely that the system

environment has a problem, such as insufficient memory. Check the

program and system state, then restart the system.

NCOUT-E0053 The set up data cannot be acquired.

An attempt to obtain the setup data failed. It is likely that the system

environment has a problem, such as insufficient memory. Check the

program and system state, then restart the system.

NCOUT-E0080 It is not possible to refer to the data of the INI file.

An attempt to obtain the INI file data failed. It is likely that the INI file is

not in the Windows directory. It is also likely that the system environment

has a problem, such as insufficient memory. Check the program and

system state, then restart the system.

NCOUT-E0081 It is not possible to refer to the data of the NC machine file.

An attempt to obtain the NC machine file data failed. It is likely that the

NC machine file is not in the specified directory. It is also likely that the

system environment has a problem, such as insufficient memory. Check

the program and system state, then restart the system.

NCOUT-E0082 It failed in the initialization of the POST. Please refer to 'LOG' file for

detailed. Do you open 'LOG' file?

An attempt to initialize the POST section failed.  It is likely that files such

as the NC machine file are not in the specified directory.  It is also likely

that the system environment has a problem, such as insufficient memory.

Check the program and system state, then restart the system.

NCOUT-E0099 The error which was not able to be expected occurred.

An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

NCOUT-E0101 The following process is a main process.

NCOUT-E0102 The following process is a sub process.

NCOUT-E0103 Next, there is no process.

These error messages indicate the type of the next process. These errors do

not usually occur. Once they occur, it is likely that the system environment

has a problem, such as insufficient memory. Check the program, then

restart the system.
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NCOUT-E0111 The specified file name is not correct.

The specified file name contains an invalid character or symbol.  Check

the file name.

NCOUT-E0113 I fail to remake the cutting area.

An attempt to re-create a machining area failed. It is likely that the system

environment has a problem, such as insufficient memory. Check the

program and system state, then restart the system.

NCOUT-E0114 There is no process data.

There is no process data. Define the type of machining in the Machining

Definition section.

NCOUT-E0115 Turning process data does not exist. [C/Y]

Turning process data does not exist.  If there are C/Y-axis machining

processes only, this message is displayed when the program is executed for

the first time.

NCOUT-E0297 This NC machine file does not allow C-axis machining. [C/Y]

The selected NC machine file is inadequate.  Select an NC machine file

that allows C-axis machining.

NCOUT-E0298 This NC machine file does not allow Y-axis machining. [C/Y]

The selected NC machine file is inadequate.  Select an NC machine file

that allows Y-axis machining.

NCOUT-E0299 “C/Y AXIS MODULE” is not installed.

The C/Y-axis module is not installed, but a part file created with the C/Y-

axis module is executed.  Install the C/Y-axis module before executing a

part file created with the C/Y-axis module.

NCOUT-E1001 The data for the machining cannot be acquired.

An error occurred when the machining condition data was loaded. Data

that cannot be recognized is included. Open the Machining Definition

window, and check the machining condition data for the process in which

the error occurred.

NCOUT-E1002 The error occurred by the interference check.

The tool will interfere with the workpiece when it approaches the

machining start position at the beginning of a process or when it escapes to

the machining start position at the end of a process. Open the Setting of

Pre-machining window, and check whether the Home and Index positions

were set to a point inside the workpiece.

Alternatively, interference occurred between the tool and workpiece during

grooving.  Check an escape amount for grooving.

NCOUT-E1003 The memory does not suffice.

Check the state of the system memory, and restart the system.

NCOUT-E1004 The data base I.D. is not correct.

This error is related to the data of the next process. It does not usually

occur.  Once it occurs, it is likely that the system environment has a

problem, such as insufficient memory. Check the program and system

state, then restart the system.
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NCOUT-E1005 The data for machining cannot be acquired.
An error occurred when the machining condition data was loaded. Data

that cannot be recognized is included. Open the Machining Definition

window, and check the machining condition data for the process in which

the error occurred.

NCOUT-E1006 The cutting area cannot be acquired.
An attempt to obtain a machining area failed. It is likely that the system

environment has a problem, such as insufficient memory. Check the

program and system state, then restart the system.

NCOUT-E1099 The error which was not able to be expected occurred.
An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

NCOUT-E1101 The clearance amount is not correct.
A clearance amount for hole machining is incorrect. Check the process

data for hole machining in the Machining Definition section.

NCOUT-E1102 The cutting amount is not correct.
A cutting depth for hole machining is incorrect.  Check the process data

for hole machining in the Machining Definition section.

NCOUT-E1103 The feedrate is not correct.
A feed amount for hole machining is incorrect. Check the process data for

hole machining in the Machining Definition section.

NCOUT-E1104 The dwell time is not correct.
The dwell time for hole machining is incorrect. Check the process data for

hole machining in the Machining Definition section.

NCOUT-E1106 In C-axis machining, the escape angle must be 0  or 180. [C/Y]

In C-axis fine boring, an incorrect escape angle is specified.  Check the

hole machining process data of the process specification section.

NCOUT-E1107 The angle of the chamfering tool is incorrect. [C/Y]

In hole chamfering, the angle of the tool used is incorrect.  Check the hole

machining process data of the process specification section.

NCOUT-E1108 Machining is impossible because the tool radius is greater than the

machining radius. [C/Y]

Circle cutting or hole contour chamfering is impossible because the radius

of the tool used is greater than the machining radius.  Check the hole

machining process data of the process specification section.

NCOUT-E1109 An approach or escape radius specified is so large that interference

with the machining radius occurs. [C/Y]

An approach or escape radius specified for circle cutting or hole contour

chamfering is so large that an interference with the hole figure occurs.

Check the hole machining process data of the process specification section.

NCOUT-E1199 A drill machining ended.
This error message indicates the end of drilling. This error does not

usually occur. Once it occurs, it is likely that there is insufficient memory.

Check the program, then restart the system.
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NCOUT-E1200 The error which was not able to be expected occurred.
An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory.  Check the program, then restart the

system.

NCOUT-E1201 The area for machining is not correct.
The machining area is incorrect. Data that cannot be recognized may be

included. Open the Machining Definition window, and check the program

for the process in which the error occurred.

NCOUT-E1202 The cutting condition is not correct.
The machining condition data is inappropriate. Data that cannot be

recognized may be included. Open the Machining Definition window, and

check the program for the process in which the error occurred.

NCOUT-E1203 The area for machining cannot be acquired.

NCOUT-E1204 The error which was not able to be expected occurred. (The element is

not correct.)
An attempt to obtain a machining area failed. Data that cannot be

recognized may be included. Open the Machining Definition window, and

check the program for the process in which the error occurred.

NCOUT-E1205 The feedrate to the roughness cannot be acquired.

NCOUT-E1206 The set feedrate is improper.
A feed amount is not set for a specific surface roughness. Alternatively, a

feed amount set for a specific surface roughness is inappropriate. Open the

Machining Definition window, and check the surface roughness and feed

amount set for the process in which the error occurred.

NCOUT-E1207 The set machining method is improper.

NCOUT-E1208 The method of machining the set valley is improper.
This error message indicates the type of a machining method used. This

error does not usually occur. Once it occurs, it is likely that there is

insufficient memory. Check the program, then restart the system.

NCOUT-E1240 System error

NCOUT-E1241 System error

NCOUT-E1242 System error

NCOUT-E1243 System error

NCOUT-E1244 System error

NCOUT-E1245 System error
An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

NCOUT-E1246 The memory does not suffice.
Check the state of system memory, then restart the system.

NCOUT-E1247 The area for the machining is not correct.

NCOUT-E1261 The cutting area is not correct.

NCOUT-E1263 The area is not correct.
The machining area is incorrect. Data that cannot be recognized may be

included. Open the Machining Definition window, and check the program

for the process in which the error occurred.
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NCOUT-E1260 System error

NCOUT-E1262 System error

NCOUT-E1264 System error

NCOUT-E1280 System error

NCOUT-E1281 System error

NCOUT-E1282 System error

NCOUT-E1300 System error

NCOUT-E1303 System error

NCOUT-E1305 System error

An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

NCOUT-E1301 The machining condition is not correct. (Grooving)

The machining condition for grooving is inappropriate. Data that cannot

be recognized may be included. Open the Machining Definition window,

and check the machining condition data for the process in which the error

occurred.

NCOUT-E1302 There is no area for the machining. (Grooving)

An attempt to obtain a machining area for grooving failed. Open the

Machining Definition window, and check the machining area for the

process in which the error occurred.

NCOUT-E1304 The memory does not suffice.

Check the state of system memory, and restart the system.

NCOUT-E1306 The element cannot be acquired. (Grooving)

NCOUT-E1308 The kind of the element is not suitable. (Grooving)

NCOUT-E1312 The cutting area is not correct. (Grooving)

The machining area for grooving is incorrect. Data that cannot be

recognized may be included. Open the Machining Definition window, and

check the machining area for the process in which the error occurred.

NCOUT-E1307 The data cannot be acquired. (Grooving)

NCOUT-E1309 The feedrate is improper. (Grooving)

NCOUT-E1310 The kind of machining is not correct. (Grooving)

NCOUT-E1311 The specification of the machining method is not correct. (Grooving)

The machining condition for grooving is inappropriate. Data that cannot

be recognized may be included. Open the Machining Definition window,

and check the machining condition data specified for the process in which

the error occurred.

NCOUT-E1500 System error

An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

NCOUT-E1501 The machining condition is not correct. (Threading)

NCOUT-E1502 The kind of machining is not correct (Threading)
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NCOUT-E1503 The machining shape is not correct. (Threading)
The machining condition for threading is inappropriate.  Data that cannot

be recognized may be included. Open the Machining Definition window,

and check the machining condition data specified for the process in which

the error occurred.

NCOUT-E1900 System error

NCOUT-E1902 System error

NCOUT-E1999 System error
An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

NCOUT-E1901 The start point is not obtained.

NCOUT-E1904 The end point is not obtained.

NCOUT-E1903 The machining start point is not obtained.
It is impossible to calculate the start position of the next machining

process. Alternatively, the Home or Index position has not been set up.

Open the Machining Definition window, and check the machining

condition data and machining area for the process in which the error

occurred.  Also open the Setting of Pre-machining window, and check for

the Home and Index positions.

NCOUT-E1905 The tool path cannot be decided.

NCOUT-E1906 The CL data cannot be output.
An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

NCOUT-E1907 The memory does not suffice.
Check the state of system memory, then restart the system.

NCOUT-E1908 There is no area for the interference check.(blank or parts figure)
The machining area is incorrect. Data that cannot be recognized may be

included. Open the Machining Definition window, and check the program

for the process in which the error occurred.

NCOUT-E1909 The movement point is in the area.
The tool will interfere with the workpiece when it approaches the

machining start position at the beginning of a process or when it escapes to

the machining start position at the end of a process. Open the Setting of

Pre-machining window, and check whether the Home and Index positions

have been set to a point inside the workpiece.

NCOUT-E1910 The kind of machining is improper.
This error message indicates the type of a machining method used.  This

error does not usually occur. Once it occurs, it is likely that there is

insufficient memory. Check the program, then restart the system.

NCOUT-E1950 The tool interfered with a part. [C/Y]

This message is displayed if a check to see if the tool interferes with a part

in C/Y-axis machining finds that interference occurs on the path.  If the

use of the interference check function is not specified on the NC creation

preparation window, no interference check is made, and this message is
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not displayed.

NCOUT-E2102 An incorrect pocketing figure is specified. [C/Y]

In pocketing, an incorrect pocketing figure is specified.  Check the

pocketing process data of the process specification section.

NCOUT-E2103 An incorrect cutting start point is specified. [C/Y]

In pocketing, an incorrect cutting start point is specified.  Check the

pocketing process data of the process specification section.

NCOUT-E2104 An incorrect pocketing figure is specified. [C/Y]

In pocketing, an incorrect pocketing figure is specified.  Check the

pocketing process data of the process specification section.

NCOUT-E2105 Machining condition data is incorrect. [C/Y]

In pocketing, an incorrect machining condition is specified.  Check the

pocketing condition of the process specification section.

NCOUT-E2106 Pocketing cannot be performed with a specified condition. [C/Y]

In pocketing, a specified machining condition is inadequate.  Check the

pocketing condition of the process specification section.

NCOUT-E2107 Finishing cannot be performed with a specified condition. [C/Y]

In pocket finishing, a specified machining condition is inadequate.  Check

the pocket finishing condition of the process specification section.

NCOUT-E2108 There is no area to be machined. [C/Y]

In pocketing, there is no area that can be machined with a specified

machining condition.  Check the pocketing condition of the process

specification section.

NCOUT-E2109 The number of cuts exceeded the limit. [C/Y]

In pocketing, the number of cuts exceeded a specified limit.  Modify the

pocketing condition of the process specification section (for example, to

use a tool with a greater maximum depth of cut).

NCOUT-E2110 No cutting start point can be found. [C/Y]

In pocketing, no cutting start point could be found.  Check the pocketing

condition and data of the process specification section.

NCOUT-E2111 The tool interfered with a part. [C/Y]

In pocketing, the tool interfered with a part.  Check the pocketing

condition and data of the process specification section.

NCOUT-E2199 System error [C/Y]

NCOUT-E2202 An incorrect contouring figure is specified. [C/Y]

In contouring, an incorrect contouring figure is specified.  Check the

contouring data of the process specification section.

NCOUT-E2203 An incorrect cutting start point is specified. [C/Y]

In contouring, an incorrect cutting start point is specified.  Check the

contouring data of the process specification section.

NCOUT-E2204 An incorrect contouring figure is specified. [C/Y]

In contouring, an incorrect contouring figure is specified.  Check the

contouring data of the process specification section.
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NCOUT-E2205 Incorrect machining condition data is specified. [C/Y]

In contouring, an incorrect machining condition is specified.  Check the

contouring condition of the process specification section.

NCOUT-E2206 Contouring cannot be performed with a specified condition. [C/Y]

In contouring, a specified machining condition is inadequate.  Check the

contouring condition of the process specification section.

NCOUT-E2207 Finishing cannot be performed with a specified condition. [C/Y]

In contour finishing, a specified machining condition is inadequate.

Check the contour finishing condition of the process specification section.

NCOUT-E2208 There is no area to be machined. [C/Y]

In contouring, there is no area that can be machined with a specified

machining condition.  Check the contouring condition of the process

specification section.

NCOUT-E2209 The number of cuts exceeded the limit. [C/Y]

In contouring, the number of cuts exceeded a specified limit.  Modify the

contouring condition of the process specification section (for example, to

use a tool with a greater maximum depth of cut).

NCOUT-E2210 No cutting start point can be found. [C/Y]

In contouring, no cutting start point could be found.  Check the contouring

condition and data of the process specification section.

NCOUT-E2211 The tool interfered with a part. [C/Y]

In contouring, the tool interfered with a part.  Check the contouring

condition and data of the process specification section.

NCOUT-E2299 System error [C/Y]

NCOUT-E2302 An incorrect grooving figure is specified. [C/Y]

In grooving, an incorrect grooving figure is specified.  Check the grooving

data of the process specification section.

NCOUT-E2303 An incorrect cutting start point is specified. [C/Y]

In grooving, an incorrect cutting start point is specified.  Check the

grooving data of the process specification section.

NCOUT-E2304 An incorrect grooving figure is specified. [C/Y]

In grooving, an incorrect grooving figure is specified.  Check the grooving

data of the process specification section.

NCOUT-E2305 Incorrect machining condition data is specified. [C/Y]

In grooving, an incorrect machining condition is specified.  Check the

grooving condition of the process specification section.

NCOUT-E2306 Grooving cannot be performed with a specified condition. [C/Y]

In grooving, a specified machining condition is inadequate.  Check the

grooving condition of the process specification section.

NCOUT-E2307 Finishing cannot be performed with a specified condition. [C/Y]

In groove finishing, a specified machining condition is inadequate.  Check

the groove finishing condition of the process specification section.

NCOUT-E2308 There is no area to be machined. [C/Y]

In grooving, there is no area that can be machined with a specified

machining condition.  Check the grooving condition of the process

specification section.
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NCOUT-E2309 The number of cuts exceeded the limit. [C/Y]

In grooving, the number of cuts exceeded a specified limit.  Modify the

grooving condition of the process specification section (for example, to use

a tool with a greater maximum depth of cut).

NCOUT-E2310 No cutting start point can be found. [C/Y]

In grooving, no cutting start point could be found.  Check the grooving

condition and data of the process specification section.

NCOUT-E2311 The tool interfered with a part. [C/Y]

In grooving, the tool interfered with a part.  Check the grooving condition

and data of the process specification section.

NCOUT-E2399 System error [C/Y]

NCOUT-E5001 The error occurred in POST. Please refer to LOG file for detailed. Do

you open LOG file?

NCOUT-E5004 The memory does not suffice.

Check the state of system memory, then restart the system.

NCOUT-E5097 The protecting key comes off.

It is impossible to prepare NC data, because the protect key is detached.

Attach it, then restart the system.

NCOUT-E5098 The system is a demonstration version.

It is impossible to output NC data to a file, because this system is a

demonstration version.

NCOUT-E5099 The error which was not able to be expected occurred.

An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

NCOUT-E7001 The blank figure does not exist.

This program has no blank figure. Enter blank figure data.

NCOUT-E7002 Two or more blank figures exist.

There is more than one blank figure for this program. This system cannot

process more than one blank figure. Correct the program.

NCOUT-E7003 The blank figure cannot be acquired.

A blank figure cannot be obtained. It is likely that the system environment

has a problem, such as insufficient memory. Check the program and

system state, then restart the system.

NCOUT-E7004 The blank figure is not correct.

The blank figure is incorrect. The blank figure must not be crossed or

open. Correct the program.

NCOUT-E7005 The blank figure for the animation cannot be registered.

A blank figure for animated simulation cannot be registered. It is likely

that the system environment has a problem, such as insufficient memory.

Check the program and system state, then restart the system.

NCOUT-E7006 The turning parts figure does not exist.

This program has no parts figure. Enter parts figure data.
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NCOUT-E7007 Two or more turning parts figure exists.

There is more than one parts figure for this program. This system cannot

process more than one parts figure.  Correct the program.

NCOUT-E7008 The turning parts figure cannot be acquired.

Parts figure cannot be obtained. It is likely that the system environment

has a problem, such as insufficient memory. check the program and system

state, then restart the system.

NCOUT-E7009 The chuck figure is not correct.

The chuck figure is incorrect. Check the chuck figure on the Setting of

Pre-machining window.

NCOUT-E7010 The chuck figure for the animation cannot be registered.

A chuck figure for animated simulation cannot be registered. It is likely

that the system environment has a problem, such as insufficient memory.

Check the program and system state, then restart the system.

NCOUT-E7011 The tailstock figure is not correct.

The tailstock figure is incorrect. Check the tailstock figure on the Setting

of Pre-machining window.

NCOUT-E7012 The tailstock figure for the animation cannot be registered.

The tailstock figure is incorrect. Check the tailstock figure on the Setting

of Pre-machining window.

NCOUT-E7013 The whole turning parts figure cannot be shown as it has too many

elements.

Because a figure consists of too many parts figure entities, it is impossible

to draw the entire figure. The output NC data is correct, however.

NCOUT-E7014 The whole blank figure cannot be shown as it has too many elements.

Because a figure consists of too many blank figure entities, it is impossible

to draw the entire figure. The output NC data is correct, however.

NCOUT-E7099 The error which was not able to be expected occurred.

An unexpected error, such as a calculation overflow, occurred. It is likely

that there is insufficient memory. Check the program, then restart the

system.

26.3.7 Messages concerning the milling library

[Abbreviation RGMILLIB] ----- Messages concerning the milling library [C/Y]

Abbreviation-number Message  (Description)

[Error]

RGMILLIB-E0001 The file cannot be found.  Check whether the file name and path name

are correct, and also whether the drive is ready. [C/Y]

The text file format is incorrect.

RGMILLIB-E0002 The format of the milling library file is incorrect.  A file of an

incorrect format is identified by the message displayed immediately

before this message. [C/Y]
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RGMILLIB-E0003 There is a file having the same name. [C/Y]

RGMILLIB-E0004 Data to be processed cannot be found. [C/Y]

Data to be acquired or deleted could not be found.  This error may be

caused by a system environment problem such as there being insufficient

memory.  After checking the system status, restart the system.

RGMILLIB-E0005 The amount of memory is insufficient. [C/Y]

After checking the system memory status, restart the system.

RGMILLIB-E0007 An unexpected error occurred. [C/Y]

This error may be caused by a system environment problem such as there

being insufficient memory.  After checking the system status, restart the

system.

RGMILLIB-E0008 The disk does not have sufficient free space. [C/Y]

The disk does not have sufficient free space for writing to a text file.

Check if the directory of the milling library specified in the operating

environment setting data has sufficient free space.

RGMILLIB-E0013 An attempt to delete a file failed.  Check if the file name and path

name are correct, if the drive is ready, and if the file is write-

protected.

RGMILLIB-E0014 An attempt to change the file name failed. [C/Y]

An attempt to change the file name of the milling library file failed.

Check if the directory of the milling library specified in the operating

environment setting data is write-protected.

RGMILLIB-E0015 An attempt to open the file for writing failed. [C/Y]

An attempt to open the milling library file for writing failed.  Check if the

directory of the milling library specified in the operating environment

setting data is write-protected, and if the write area has sufficient free

space.

RGMILLIB-E0023 An attempt to create work data for the milling library failed. [C/Y]

An attempt to create work data for the milling library failed. The message

displayed after this message indicates a cause.  The failure may have

occurred as a result of one of the causes listed below.

(1) The directory of the milling library specified in the operating

environment setting data does not contain a milling library file

(XXXXX.MML).  Check if a milling library file is contained.

(2) The format of the milling library file is incorrect.

RGMILLIB-E0024 An attempt to allocate a work data area failed. [C/Y]

An attempt to allocate a work area for the milling library data failed.  The

message displayed after this message indicates a cause.  The failure may

have occurred as a result of one of the causes listed below.

(1) The previous work data area still remains for some reason.  Restart

the system.

(2) There is a system environment problem such as there being

insufficient memory.  After checking the system status, restart the

system.
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RGMILLIB-E0025 Select only one data item to be modified. [C/Y]

Multiple milling data items were selected when the user clicked the

Modify button on the milling data name list window.  From the milling

data name list, select only one milling data item to be modified.

RGMILLIB-E0030 Milling data having the same name has already been created. [C/Y]

Milling data having the same name was registered when milling data was

registered or modified.  Modify the milling data name.

RGMILLIB-E0031 An attempt to add or modify milling data failed. [C/Y]

There may be a system environment problem such as there being

insufficient memory.  After checking the system status, restart the system.

RGMILLIB-E0032 Specify a milling data name. [C/Y]

When milling data was registered or modified, no milling data name was

specified.  Specify a milling data name.

RGMILLIB-E0033 Select only one list for insertion position specification. [C/Y]

Multiple machining process lists were selected when the user clicked the

Insert button on the milling process editing window.  Select only one

machining process list for insertion position specification.

RGMILLIB-E0034 An attempt to add or modify milling process data failed. [C/Y]

There may be a system environment problem such as there being

insufficient memory.  After checking the system status, restart the system.

[Warning]

RGMILLIB-I0001 The order of center drilling and drilling is reversed. [C/Y]

Process data editing resulted in an inadequate machining process.  Modify

the machining process.

RGMILLIB-I0002 The order of center drilling and drilling is reversed.  Do you wish to

modify the process? [C/Y]

When the user clicked the OK button on the milling process editing

window, an inadequate process was registered.  Modify the machining

process.

RGMILLIB-I0003 The order of preceding machining and roughing is reversed. [C/Y]

Process data editing resulted in an inadequate machining process.  Modify

the machining process.

RGMILLIB-I0004 The order of preceding machining and roughing is reversed.  Do you

wish to modify the process? [C/Y]

When the user clicked the OK button on the milling process editing

window, an inadequate process was registered.  Modify the machining

process.

RGMILLIB-I0005 The order of preceding machining and finishing is reversed. [C/Y]

Process data editing resulted in an inadequate machining process.  Modify

the machining process.

RGMILLIB-I0006 The order of preceding machining and finishing is reversed.  Do you

wish to modify the process? [C/Y]

When the user clicked the OK button on the milling process editing

window, an inadequate process was registered.  Modify the machining

process.
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RGMILLIB-I0007 The order of roughing and finishing is reversed. [C/Y]

Process data editing resulted in an inadequate machining process.  Modify

the machining process.

RGMILLIB-I0008 The order of roughing and finishing is reversed.  Do you wish to

modify the process? [C/Y]

When the user clicked the OK button on the milling process editing

window, an inadequate process was registered.  Modify the machining

process.

26.3.8 Messages related to loading part files

[Abbreviation RGSTCOM] ----- Messages concerning file reading

Abbreviation-number Message  (Explanation)

[Error]

RGSTCOM-E0001 The file is not found. Confirm whether the filename/pathname to be

correct, and the drive to be ready.

Check that the file is in the directory where the cutting condition file, tool

file, and tooling file are saved, as specified during environment setting.

RGSTCOM-E0002 The format of a text file is not correct.

The format of a cutting condition file is incorrect. The file is indicated in a

message that precedes this message.

RGSTCOM-E003 The same name file found.

RGSTCOM-E004 There is no data.

Data specified to be obtained or erased is missing. It is likely that the

system environment has a problem, such as insufficient memory. Check

the system state, then restart the system.

RGSTCOM-E0005 Insufficient memory.

Check the state of system memory, then restart the system.

RGSTCOM-E0007 The error not anticipated occurred.

It is likely that the system environment has a problem, such as insufficient

memory. Check the program and system state, then restart the system.

RGSTCOM-E0008 No enough capacity in the disk.

An attempt to save a text file failed, because there is no sufficient free

space on the disk. Check that there is sufficient free space in the directory

where the cutting condition file, tool file, and tooling file are saved, as

specified during environment setting.

RGSTCOM-E0013 Failed in the deletion of the file. Confirm whether the

filename/pathname to be correct, the drive to be ready, and no read-

only.

RGSTCOM-E0014 Failed in the change in the file name.

An attempt to change the file name of a cutting condition file, tool file, or

tooling file failed. Check whether the directory where the cutting

condition, tool, and tooling files are saved, as specified during

environment setting, is write-protected.
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RGSTCOM-E0015 Failed in the opening of the file for writing.

An attempt to open a cutting condition file, tool file, or tooling file for

write access failed. Check whether the directory where the cutting

condition file, tool file, and tooling file are saved, as specified during

environment setting, is write-protected and that there is sufficient write

area.

RGSTCOM-E0021 Failed in making the work data for tooling file.

An attempt to create working data for a tooling file failed. A message next

to this one indicates the cause of the failure.  Probable causes are:

(1) It is likely that the tooling file (xxxxx.TSF) is not in the directory

where the tool and tooling files are saved, as specified during

environment setting. Check that the tooling file is in that directory.

(2) It is likely that the format of the tooling file is incorrect.

RGSTCOM-E0022 Failed in the preservation of the tooling file.

An attempt to save a tooling file failed.  It is likely that there is no

sufficient free space in the directory where the tool and tooling files are

saved, as specified during environment setting.

RGSTCOM-E0023 Not Found tooling data. Regist tooling data.

A tool cannot be referenced during machining definition, because there is

no tooling data.  Register tooling data by selecting Setting => Library Data

Setting => Tool, Tooling, from the menu, then select the target tooling

data using the Setting of Pre-machining window.

RGSTCOM-E0024 The tooling main file cannot be read.

An attempt to load a tooling management file failed. A message next to

this one indicates the cause of the failure. Probable causes are:

(1) It is likely that the tooling management file (TLSTMAIN.TSF) is not

in the directory where the tool and tooling files are saved, as specified

during environment setting. Check that the tooling  Management file

is in that directory.

(2) It is likely that the format of the tooling management file is incorrect.

RGSTCOM-E0031 Failed in making the work data for work material data.

An attempt to create workpiece material working data failed.  A message

next to this one indicates the cause of the failure.  Probable causes are:

(1) It is likely that the workpiece material file (xxxxx.CNA, xxxxx.CDC,

or xxxxx.CTD) is not in the directory where the cutting condition file

is saved, as specified during environment setting. Check that the

workpiece material file is in that directory.

(2) It is likely that the format of the workpiece material file is incorrect.

RGSTCOM-E0032 Failed in the preservation of the work material file.

An attempt to save a workpiece material file failed. It is likely that there is

no sufficient free space in the directory where the cutting condition file is

saved, as specified during environment setting.

RGSTCOM-E0033 Not Found work material data. Regist work material data.
Cutting conditions cannot be set up automatically during machining
definition, because there is no workpiece material data. Register workpiece
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material data by selecting Setting => Library Data Setting => Machining
Condition from the menu, then select the target material using the Blank
Figure window.

RGSTCOM-E0034 The work material main file cannot be read.

An attempt to load a workpiece material management file failed.  A

message next to this one indicates the cause of the failure.  Probable causes

are:

(1) It is likely that the workpiece material management file

(CONDMAIN.CCF) is not in the directory where the cutting

condition file is saved, as specified during environment setting.

Check that the workpiece material management file is in that

directory.

(2) It is likely that the format of the workpiece material management file

is incorrect.

[Warning]

RGSTCOM-I0001 Not Found tooling data of using part file. If you want to use the tooling

data of using part file, regist and select tooling data.

The tooling data used in a loaded part file cannot be referenced during

machining definition, because it is not registered with the system. To use

the tooling data used in a part file, it is necessary to register the tooling

data by selecting Setting => Library Data Setting => Tool, Tooling from

the menu, then select the target tooling data using the Setting of Pre-

machining window. If the tooling data is not registered or selected, the one

used before the part file is loaded will be referenced during machining

definition.

RGSTCOM-I0002 Not Found tooling data of using part file. If you want to use the tooling

data of using part file, regist and select tooling data.

The tooling data used in a part file cannot be referenced during machining

definition, because it is not saved in the directory where the tool and

tooling files are saved, as specified during environment setting. To use the

tooling data used in a part file, it is necessary to register the tooling data by

selecting Setting => Library Data Setting => Tool, Tooling from the

menu, then select the target tooling data using the Setting of Pre-

machining window. If the tooling data is not registered or selected, the

first tooling data saved in the directory where the tool and tooling files are

saved will be referenced during machining definition.

RGSTCOM-I0003 Not Found work material data of using part file. If you want to use the

work material data of using part file, regist and select work material

data.

The workpiece material data used in a loaded part file cannot be referenced

during machining definition, because it is not registered with the system.

To use the workpiece material data used in a part file, it is necessary to

register the workpiece material data by selecting Setting => Library Data

Setting => Machining Condition from the menu, then select the target
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material data using the Blank Figure window. If the material data is not

registered or selected, the one used before the part file is loaded will be

referenced during machining definition.

RGSTCOM-I0004 Not Found work material data of using part file. If you want to use the

work material data of using part file, regist and select work material

data.

The workpiece material data used in a part file cannot be referenced

during machining definition, because it is not saved in the directory where

the cutting condition file is saved, as specified during environment setting.

To use the workpiece material data used in a part file, it is necessary to

register the workpiece material data by selecting Setting => Library Data

Setting => Machining Condition from the menu, then select the target

material data using the Blank Figure window. If the workpiece material

data is not registered or selected, the first workpiece material data saved in

the directory where the cutting condition file is saved will be referenced

during machining definition.

26.3.9 Messages related to cutting condition setting

[Abbreviation RGSTCOND] ----- Messages concerning cutting condition setting

Abbreviation-number Message  (Explanation)

[Error]

RGSTCOND-E0001 The file is not found. Confirm whether the filename/pathname to be

correct, and the drive to be ready.

Check that the file name/path name is correct. Also check that the drive is

ready.

RGSTCOND-E0002 The format of the text file is not correct.

The format of a cutting condition file is incorrect. The file is indicated in

the message that precedes this one.

RGSTCOND-E0003 The same name file found.

RGSTCOND-E0004 There is no data.

Data to be acquired or erased was found missing. It is likely that the

system environment has a problem, such as insufficient memory.  Check

the system state, then restart the system.

RGSTCOND-E0005 Insufficient memory.

Check the state of system memory, and restart the system.

RGSTCOND-E0007 The error not anticipated occurred.

It is likely that the system environment has a problem, such as insufficient

memory. Check the system state, then restart the system.

RGSTCOND-E0008 No enough capacity in the disk.

An attempt to save a text file failed, because there is no sufficient free

space on the disk. Check that there is sufficient free space in the directory

where the cutting condition file is saved, as specified during environment

setting.
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RGSTCOND-E0013 Failed in the deletion of the file. Confirm whether the filename/

pathname to be correct, the drive to be ready, and no read-only.

Check that the specified file name/path name is correct, that the drive is

ready, and whether the disk is write-protected.

RGSTCOND-E0014 Failed in the change in the file name.

An attempt to change the file name of a cutting condition file failed. Check

whether the directory where the cutting condition file is saved, as specified

during environment setting, is write-protected.

RGSTCOND-E0015 Failed in the opening of the file for writing.

An attempt to open a cutting condition file for write access failed. Check

whether the directory where the cutting condition file is saved, as specified

during environment setting, is write-protected and whether there is

sufficient write area.

RGSTCOND-E0021 The area of the work data cannot be secured.

An attempt to reserve a work area for cutting condition data failed during

machining definition or cutting condition registration. A message next to

this one indicates the cause of the failure. Probable causes are:

(1) It is likely that the previous working data area is lingering for some

reason. Restart the system.

(2) It is likely that the system environment has a problem, such as

insufficient memory. Check the system state, then restart the system.

RGSTCOND-E0022 The work material main file cannot be read.

An attempt to load a workpiece material management file failed. A

message next to this one indicates the cause of the failure. Probable causes

are:

(1) It is likely that the workpiece material management file

(CONDMAIN.CCF) is not in the directory where the cutting

condition file is saved, as specified during environment setting.

Check that the workpiece material management file is in that

directory.

(2) It is likely that the format of the workpiece material management file

is incorrect.

RGSTCOND-E0023 The work material name file cannot be read.

An attempt to load a workpiece material name file failed. A message next

to this one indicates the cause of the failure. Probable causes are:

(1) It is likely that the workpiece material name file (xxxxx.NCA) is not

in the directory where the cutting condition file is saved, as specified

during environment setting. Check that the workpiece material name

file is in that directory.

(2) It is likely that the format of the workpiece material name file is

incorrect.

RGSTCOND-E0024 The work material file cannot be copied in a fixed directry.

When you selected the Reading of Cutting Condition File option on the

workpiece material addition window, and clicked OK, the cutting



B-62824EN/02 26.  TROUBLESHOOTING

-371-

condition file was not copied to the directory where the cutting condition

file was saved, as specified during environment setting.

Check whether the directory where the cutting condition file is saved is

write-protected and that there is sufficient write area.

RGSTCOND-E0025 Failed in a new making the work material file.
When you selected the New Making of Cutting Condition File option on

the material addition window, and clicked OK, the cutting condition file

was not created in the directory where the cutting condition file was saved,

as specified during environment setting.

Check whether the directory where the cutting condition file is saved is

write-protected and that there is sufficient write area.

RGSTCOND-E0026 It is possible to write the data in the work material main file.
An attempt to save a workpiece material management file failed. A

message next to this one indicates the cause of the failure. Probable causes

are:

(1) It is likely that there is no sufficient free space in the directory where

the cutting condition file is saved, as specified during environment

setting.

(2) It is likely that the format of the material management file (COND

MAIN.CCF) is incorrect.

RGSTCOND-E0029 Failed in making the work data of the work material file.
An attempt to create workpiece material working data failed.  A message

next to this one indicates the cause of the failure.  Probable causes are:

(1) It is likely that the workpiece material file (xxxxx.CNA, xxxxx.CDC,

or xxxxx.CTD) is not in the directory where the cutting condition file

is saved, as specified during environment setting. Check that the

workpiece material file is in that directory.

(2) It is likely that the format of the workpiece material file is incorrect.

RGSTCOND-E0030 Failed in the preservation of the work material file.
An attempt to save a workpiece material file failed. It is likely that there is

no sufficient free space in the directory where the cutting condition file is

saved, as specified during environment setting.

RGSTCOND-E0031 Failed in writing the work material name file.
An attempt to save a workpiece material name file failed. A message next

to this one indicates the cause of the failure. Probable causes are:

(1) It is likely that there is no sufficient free space in the directory where

the cutting condition file is saved, as specified during environment

setting.

(2) It is likely that the format of the workpiece material name file

(xxxxx.CNA) is incorrect.

An attempt to discard workpiece material working data failed.  A message

next to this one indicates the cause of the failure. A probable cause is:

It is likely that the directory where the cutting condition file is saved, as

specified during environment setting, has no sufficient free space to hold

the working data text file.
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RGSTCOND-E0032 An attempt to discard workpiece material work data failed.
An attempt to discard workpiece material work data failed.  The message

displayed after this message indicates a cause.  The failure may have

occurred as a result of the following cause:

When work data is written into a text file, no sufficient write space is

available under the directory of the cutting condition file specified in the

operating environment setting data.

RGSTCOND-E0033 Failed in the deletion of machining type data.

The Erase button was clicked to erase the machining type data from the

Machining Type Selection window, but it was not erased. It is likely that

the system environment has a problem, such as insufficient memory.

Check the system state, then restart the system.

RGSTCOND-E0034 Failed in the addition of machining type list.

An attempt was made to add a workpiece material machining type to the

list on the Machining Type Selection window, but it was not added. It is

likely that the system environment has a problem, such as insufficient

memory.  Check the system state, then restart the system.

RGSTCOND-E0036 The tool type main file cannot be read.

An attempt to load a tool type management file failed. A message next to

this one indicates the cause of the failure. Probable causes are:

(1) It is likely that the tool type management file (TOOLMAIN.TLF) is

not in the directory where the tool and tooling files are saved, as

specified during environment setting. Check that there is the tool type

management file in that directory.

(2) It is likely that the format of the tool type management file is

incorrect.

RGSTCOND-E0037 Failed in the acquisition of the finish allowance data.

An attempt to obtain the finishing allowance data failed, when the Tool

Type Selection window was displayed. It is likely that the system

environment has a problem, such as insufficient memory. Check the

system state, then restart the system.

RGSTCOND-E0038 Failed in the preservation of the finish allowance data.

An attempt to save the finishing allowance data failed, when OK was

clicked to exit the Tool Type Selection window. It is likely that the system

environment has a problem, such as insufficient memory. Check the

system state, then restart the system.

RGSTCOND-E0039 Failed in the acquisition of the tool type and tool material name data.

An attempt to obtain the tool type and tool material name data failed,

when the cutting condition data was processed. It is likely that the system

environment has a problem, such as insufficient memory. Check the

system state, then restart the system.

RGSTCOND-E0040 Failed in the deletion of the tool type.

The Erase button was clicked to erase the tool type data from the Type

Tool Selection window, but it was not erased. It is likely that the system

environment has a problem, such as insufficient memory. Check the
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system state, then restart the system.

RGSTCOND-E0041 Failed in the order change of the tool type.

On the Tool Type Selection window, an attempt to change the sequence of

the tool type data failed. It is likely that the system environment has a

problem, such as insufficient memory. Check the system state, then restart

the system.

RGSTCOND-E0043 Failed in the acquisition of the tool material data of tool type main file.

An attempt to obtain the tool material name data from a tool type

management file failed. A message next to this one indicates the cause of

the failure. Probable causes are:

(1) It is likely that the tool type management file (TOOLMAIN.TLF) is

not in the directory where the tool and tooling files are saved, as

specified during environment setting.  Check that there is the tool

type management file in that directory.

(2) It is likely that the format of the tool type management file is

incorrect.

RGSTCOND-E0044 Failed in the addition of tool diameter - cutting speed list.

On the Cutting Condition Registration window, an attempt to add the tool

diameter versus cutting speed data failed.  It is likely that the system

environment has a problem, such as insufficient memory. Check the

system state, then restart the system.

RGSTCOND-E0045 Failed in the acquisition of the cutting condition data.

On the Cutting Condition Registration window, an attempt to obtain the

cutting condition data failed. It is likely that the system environment has a

problem, such as insufficient memory. Check the system state, then restart

the system.

RGSTCOND-E0046 Failed in the preservation of the cutting condition data.

On the Cutting Condition Registration window, an attempt to save the

cutting condition data failed. It is likely that the system environment has a

problem, such as insufficient memory. Check the system state, then restart

the system.

RGSTCOND-E0101 Select the added condition data from the list.

When the Reading of Cutting Condition File option was selected from the

workpiece material addition window, and OK was clicked, the desired

additional cutting condition was not selected. Select it from the list.

RGSTCOND-E0102 Specify the work material name.

When the New Making of Cutting Condition File option was selected from

the workpiece material addition window, and OK was clicked, the

workpiece material name of the cutting condition data to be prepared was

not specified.  Specify the workpiece material name.

RGSTCOND-E0103 Specify the file name.

When the New Making of Cutting Condition File option was selected from

the workpiece material addition window, and OK was clicked, the name of

the cutting condition file to be created was not specified.  Specify the file
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name.

RGSTCOND-E0104 An illigal character is included in the file name.

The name of the cutting condition file contains an invalid character.

Correct the file name.

RGSTCOND-E0105 Specify the path which the cutting condition data.

On the workpiece material addition window, when the List Display button

was clicked, the directory for which the contents are to be listed was not

specified. Specify the directory.

RGSTCOND-E0106 Select only one list which specifies the insertion position.

When the Insert button for the tool type data was clicked, it turned out that

more than one tool type had been selected from the tool type list. Select a

tool type as the insertion position; do not select more than one.

RGSTCOND-E0107 Select only one machining type which shoud be corrected.

On the Machining Type Selection window, when the Modify button was

clicked, it turned out that more than one machining type had been selected.

Select only one machining type to be modified from the machining type

list.

RGSTCOND-E0108 Select data which shoud be deleted.

When the Erase button was clicked, it turned out that the data to be erased

had not been selected. Select it.

RGSTCOND-E0109 Select a consecutive list.

When the Change Order button for tool types was clicked, it turned out

that the tool types had been selected discontinuously.  The sequence of two

or more tool types can be changed simultaneously, only when their tool

type data is continuous on the list. Select the tool type data that is

continuous on the list.

RGSTCOND-E0110 Specify the position after moving correctly.

During tool type sequence change, any of the tool types whose sequence

was to be changed was selected as the after-change position.  Select a tool

type other than those whose sequence is to be changed, as the after-change

position.

RGSTCOND-E0111 Select the data to which the order is changed from the list.

When the Change Order button for tool types was clicked, it turned out

that the target tool types had not been selected.  Select the target tool types

from the tool type list.

RGSTCOND-E0112 Select only one tool type which shoud be corrected.

On the Tool Type Selection window, when the Modify button was clicked,

it turned out that more than one machining type list had been selected.

Specify only one tool type to be modified from the tool type list.

RGSTCOND-E0113 This Data has already been registered.

When an attempt was made to register a cutting condition, it turned out

that the cutting condition for the target tool type and material had already

been registered.  Register a cutting condition for a different tool type and

material.
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RGSTCOND-E0114 Specify the tool material.

When an attempt was made to add tool type data, it turned out that the

relevant tool material had not been selected.  Select the tool material from

the tool material list.  If it is necessary to add the tool material, select

Setting => Library Data Setting => Tool, Tooling from the menu.

RGSTCOND-E0115 Specify the tool type.

When an attempt was made to add tool type data, it turned out that the

relevant tool type had not been selected. Select the tool type from the tool

type list.

RGSTCOND-E0116 Select only one data which shoud be corrected.

When the Modify button for tool diameter versus cutting speed was

clicked, it turned out that the target data had not been selected, or two or

more data items had been selected.  Select only one data item to be

modified.

26.3.10 Messages related to tool and tooling data

[Abbreviation RGSTTOOL] ----- Messages concerning tool/tooling data setting

Abbreviation-number Message  (Explanation)

[Error]

RGSTTOOL-E0001 The file is not found. Confirm whether the filename/pathname to be

correct, and the drive to be ready.

Check that the file name/path name is correct and that the drive is ready.

RGSTTOOL-E0002 The format of the text file is not correct.

The format of a tool or tooling file is incorrect. The file is indicated in the

message that precedes this one.

RGSTTOOL-E0003 The same name file found.

RGSTTOOL-E0004 There is no data.

Data to be acquired or erased was found missing. It is likely that the

system environment has a problem, such as insufficient memory. Check

the system state, then restart the system.

RGSTTOOL-E0005 Insufficient memory.

Check the state of system memory, and restart the system.

RGSTTOOL-E0007 The error not anticipated occurred.

It is likely that the system environment has a problem, such as insufficient

memory. Check the program and system state, then restart the system.

RGSTTOOL-E0008 No enough capacity in the disk.

An attempt to save a text file failed, because there was no sufficient free

space on the disk. Check that there is sufficient free space in the directory

where the tool and tooling files are saved, as specified during environment

setting.

RGSTTOOL-E0012 The same tool name has already been registered.

When an attempt was made to register or modify the data of a tool, it

turned out that another tool having the same name as the target tool had
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been registered. Change the tool name.

RGSTTOOL-E0013 Failed in the deletion of the file. Confirm whether the filename/

pathname to be correct, the drive to be ready, and no read-only.

Check that the specified file name/path name is correct, that the drive is

ready, and whether the disk is write-protected.

RGSTTOOL-E0015 Failed in the opening of the file for writing.

An attempt to open a cutting condition file for write access failed. Check

that the directory where the tool and tooling files are saved, as specified

during environment setting, is not write-protected and that there is

sufficient write area.

RGSTTOOL-E0021 The tooling main file cannot be read.
An attempt to load the tool management file failed. A message next to this

one indicates the cause of the failure. Probable causes are:

(1) It is likely that the tooling management file (TLSTMAIN.TSF) is not

in the directory where the tool and tooling files are saved, as specified

during environment setting. Check that there is the tooling

management file in that directory.

(2) It is likely that the format of the tooling management file is incorrect.

RGSTTOOL-E0024 The tool type main file cannot be read.
An attempt to load a tool type management file failed. A message next to

this one indicates the cause of the failure. Probable causes are:

(1) It is likely that the tool type management file (TOOLMAIN.TLF) is

not in the directory where the tool and tooling files are saved, as

specified during environment setting.  Check that there is the tool

type management file in that directory.

(2)  It is likely that the format of the tool type management file is

incorrect.

RGSTTOOL-E0027 The area of the work data cannot be secured.
An attempt to reserve a work area for tool/tooling data failed during

machining definition or tool/tooling registration. A message next to this

one indicates the cause of the failure.  Probable causes are:

(1) It is likely that the previous working data area is lingering for some

reason.  Restart the system.

(2) It is likely that the system environment has a problem, such as

insufficient memory. Check the system state, then restart the system.

RGSTTOOL-E0028 Failed in making the work data for tool file.
An attempt to create working data for a tool file failed. A message next to

this one indicates the cause of the failure. Probable causes are:

(1) It is likely that the tool file (xxxxx.TLF) is not in the directory where

the tool and tooling files are saved, as specified during environment

setting.  Check that the tool file is in that directory.

(2) It is likely that the format of the tool file is incorrect.

RGSTTOOL-E0029 Failed in the acquisition of the tool data.(tool file)
An attempt to read tool data from a tool file failed. It is likely that the

system environment has a problem, such as insufficient memory. Check

the system state, then restart the system.
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RGSTTOOL-E0031 Failed in making the work data for tooling file.
An attempt to create working data in a tooling file failed.  A message next

to this one indicates the cause of the failure. Probable causes are:

(1) It is likely that the tooling file (xxxxx.TSF) is not in the directory

where the tool and tooling files are saved, as specified during

environment setting. Check that the tooling file is in that directory.

(2) It is likely that the format of the tooling file is incorrect.

RGSTTOOL-E0032 Failed in the acquisition of the tool data.(tooling file)
An attempt to read tool data from a tooling file failed. It is likely that the

system environment has a problem, such as insufficient memory. Check

the system state, and restart the system.

RGSTTOOL-E0033 Failed in the addition of tooling list.

When displaying the tool data or tooling list window, an attempt to add

data to the tooling list failed. It is likely that the system environment has a

problem, such as insufficient memory.  Check the system state, and restart

the system.

RGSTTOOL-E0035 Failed in writing the tool type main file.

An attempt to save a tool type management file failed. A message next to

this one indicates the cause of the failure. Probable causes are:

(1) It is likely that there is no sufficient free space in the directory where

the tooling and tool files are saved, as specified during environment

setting.

(2) It is likely that the format of the tool type management file is

incorrect.

RGSTTOOL-E0036 Failed in the preservation of the tool file.

An attempt to save a tool file failed. It is likely that there is no sufficient

free space in the directory where the tool and tooling files are saved, as

specified during environment setting.

RGSTTOOL-E0037 Failed in the preservation of the tooling file.

An attempt to save a tooling file failed. It is likely that there is no

sufficient free space in the directory where the tool and tooling files are

saved, as specified during environment setting.

RGSTTOOL-E0038 Failed in the change in the tooling name.

An attempt to change the tooling name of tooling management and tooling

files failed. A message next to this one indicates the cause of the failure.

Probable causes are:

(1) It is likely that there is no sufficient free space in the directory where

the tooling and tool files are saved, as specified during environment

setting.

(2) It is likely that the format of the tooling management file

(TLSTMAIN.TSF) or tooling file (xxxxx.TSF) is incorrect.

RGSTTOOL-E0039 Failed in writing the tooling main file.

An attempt to save a tooling management file failed. A message next to

this one indicates the cause of the failure.  Probable causes are:

(1) It is likely that there is no sufficient free space in the directory where
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the tool and tooling files are saved, as specified during environment

setting.

(2) It is likely that the format of the tooling management file

(TLSTMAIN.TLF) is incorrect.

RGSTTOOL-E0040 The tooling file cannot be copied in a fixed directry.

When the file name/path name was correct, and the drive was ready, an

attempt to copy a tooling file to the directory where the tool and tooling

files were saved, as specified during environment setting, failed. Check

whether that directory is write-protected and that there is sufficient write

area.

RGSTTOOL-E0041 Failed in a new making the tooling file.

On the tooling addition window, when the New Making of Tooling File

option was selected, and OK was clicked, the tooling file was not created

in the directory where the tool and tooling files were saved, as specified

during environment setting.

Check whether that directory is write-protected and that there is sufficient

write area.

RGSTTOOL-E0101 This data is a current tooling data that refer to machining definition.

Do not delete this data.

It is impossible to erase the tooling data that is being referenced by

machining definition.

RGSTTOOL-E0102 Select tooling name from list.

On the tooling addition window, when the Reading of Tooling File option

was selected, and OK was clicked, it turned out that the tooling data to be

added had not been selected.  Select the tooling data to be added from a

list.

RGSTTOOL-E0103 Specify the tooling name.

On the tooling addition window, when the New Making of Tooling File

option was selected, and OK was clicked, it turned out that the tooling

name of the tooling data to be created had not been selected. Select the

tooling name.

RGSTTOOL-E0104 Specify the file name.

On the tooling addition window, when the New Making of Tooling File

option was selected, and OK was clicked, it turned out that the name of the

tooling file to be created had not been selected.  Select the file name.

RGSTTOOL-E0105 An illigal character is included in the file name.

The name of a tooling file contains an invalid character. Specify a valid

file name.

RGSTTOOL-E0106 Specify the path which the tooling data.

On the tooling addition window, when the List Display button was clicked,

it turned out that the directory for which the contents are to be listed had

not been specified.  Specify the directory.

RGSTTOOL-E0107 Select only one list from tool data which specifies the insertion

position.
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When the Insert option for the tool data was selected, and the New Make

button for tool data was clicked, it turned out that no tool in the tool data

list had been selected as the insertion position or that more than one tool

had been selected.  Select only one tool from the list.

RGSTTOOL-E0108 Select only one tool data which shoud be corrected.

When the Modify button for the tool data or tooling data was clicked, it

turned out that more than one tool had been selected.  Select only one tool

to be modified from the tool data list or tooling data list.

RGSTTOOL-E0109 Select data which shoud be deleted.

When the Erase button was clicked, it turned out that data to be erased had

not been selected. Select the data to be erased.

RGSTTOOL-E0110 Select only one list from tooling data which specifies the insertion posi-

tion.

When the Insert option for tooling data was selected, and the New Make

button for tooling data or the Copy to Tooling Data button for tool data

was clicked, it turned out that no tooling in the tooling data list had not

been selected as the insertion position or that more than one tooling had

been selected.  Select only one tooling from the list.

RGSTTOOL-E0111 Select tool from tool data which should be copied in the tooling data.

When the Copy to Tooling Data button for tool data was clicked, it turned

out that the tool whose tool data was to be copied had not been selected

from the tool data list.  Select the target tool from the tool data list.

RGSTTOOL-E0112 Specify the tool material name.

On the tool material addition window, when OK was clicked, it turned out

that no tool material name had been specified. Specify one.

26.3.11 Other messages

(1)   Messages displayed during setup

Message (Explanation)

• One or more Visual Basic applications are running. Please close those applications, then choose

OK to continue.

Applications created using Visual Basic are running, disabling further

processing to occur. If you know which application is the cause of the

failure, take measures as directed. If you do not, stop all applications other

than Program Manager.

• Could not make the installation path.

It is likely that the drive (for example, c:) specified in the path name does

not exist, the target drive is write-protected (for example, because it is CD-

ROM), the specified directory (for example, \CAPT) already exists and is

write-protected, or the hard disk has no free space.

Check on the above information using File Manager, and specify an

appropriate path name.
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• Drive <d>: has not enough disk space.  Need <size> bytes or more.

The system files are saved on the drive indicated by the path name

specified as a location for installation and the Windows system drive. If

this message appears, check for free disk space and erase unnecessary files,

using File Manager, then specify an appropriate path name.

• Set Disk #<n>.

Insert the <nth> floppy disk in the drive. This message appears also when

a floppy disk not specified is inserted.

• <filename> is just used by other applications, so not possible to be installed to <pathname>.

One or more other applications are using the indicated file. So, the file

cannot be replaced. Stop all applications other than Program Manager, and

perform setup again.

• <filename> was not able to be installed to <pathname>.

The probable causes are: The indicated file already exists, and is write-

protected; the indicated file is not supported by Symbolic CAP T or at least

its current version (for example, an English file having the same name has

been installed for a different application); the hard disk specified by the

path name has no free space; and there is insufficient memory.

When you are going to re-install the software in the same directory as

before, make sure that the existing files are not write-protected, using File

Manager or the like, or rename or erase the existing files if possible.  Also

check the size of the free space of the hard disk.  To check the free space of

memory, use, for example, the Help => About Program Manager menu of

Program Manager.  If other applications are running, stop them.

If it is impossible to solve the problem by any method, it is likely that the

system floppy disk is abnormal. In this case, please contact the sales

agency from which you purchased your Symbolic CAP T.

• Source File <filename> is not found.

• Source File <filename> is empty.

The system floppy disk is abnormal.

Please contact the sales agency from which you purchased your Symbolic

CAP T.

• Protector of the Symbolic CAP T Basic module is not connected.

Quit every process and connect the protector after turn off the power.

Connect the correct protector as directed.

If the message appears when the protector is already connected, check for a

loose connection, dirty or broken pin. Also make sure that the printer cable

is not broken and securely connected.

• <spec no.> spec no. is not correct. The spec no. of software is displayed in the label of the system

floppy disk. Confirm it. (e.g. A08B-9310-J500#EN07 for PC FAPT Basic module)

The format of the specification No. entered from the keyboard is incorrect.

When gathering a protector into another, it is necessary to enter the

specification No. of the associated software. Enter the correct specification

No. as directed.
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• <spec no.> spec no. is not correct or the specified protector is not connected.

The spec no. of software is displayed in the label of the system floppy disk. Confirm it. (e.g.

A08B-9310-J500#EN07 for PC FAPT Basic module)  If the protector is not connected, quit every

process and connect the protector after turn off the power.

The protector that matches the key-entered specification No. is not

connected. When gathering a protector into another, it is necessary to enter

the specification No. of the associated software and to connect the

protector that matches the specification No. Follow the instructions

strictly.

• <spec no.> protect key was not possible to be gathered into the protector of Symbolic CAP T

Basic module. Following causes are thought.  Confirm whether the connected protectors are

correct.

+ The key is already gathered to one.

+ Because the key has already gathered in protector other than Symbolic CAP T Basic module, it

has not remained any longer.

Confirm the connected protector.

• Error occurred while transferring protect key.

Check the protector for a loose connection, dirty or broken pin.  Also make

sure that the printer cable is not broken and securely connected. If the

printer cable in use is not a brand-name product, the problem may be

solved by exchanging it with a brand-name product. If a protector in use is

not a product of FANUC, detach it, and see what will happen. Also attach

the detached protector to the farthest position from the computer, and see

what will happen.

If it is impossible to solve the problem by any method, it is likely that the

protector is abnormal. In this case, please contact the sales agency from

which you purchased it.

(2)   Messages concerning figure selection for modification [C/Y]

Message (Description)

• No prepared hole figure can be selected. [C/Y]

This message is displayed when a prepared hole figure is selected in figure

selection for modification.

(3)   Messages concerning machining profile selection [C/Y]

Message (Description)

• Machining data is defined for a modified machining profile.  When a machining profile

modification is made, the machining data may become unsuitable.  So, be sure to check the

machining data before creating NC data. [C/Y]

This message is displayed when a modification is made to a machining

profile for which machining data is defined.



27.  APPENDIX B-62824EN/02

-382-

27 APPENDIX

27.1 Function Codes

27.1.1 NC data format setting function codes (special functions)

Symbol Code value Function Remark

Nop 0x0000 No function

FEEDnull 0x0100 Feed output

FEEDsp 0x0200 Feed output ISO:NULL

EIA:Space

27.1.2 NC data format setting function codes (move command words)

Symbol Code value Function Remark

Xmot 0x1000 X-axis output

Ymot 0x1010 Y-axis output

Zmot 0x1020 Z-axis output

Icent 0x1090 Output of arc center (I)

Jcent 0x10A0 Output of arc center (J)

Kcent 0x10B0 Output of arc center (K)

Rzx 0x10D0 Output of ZX-plane arc radius R

Xref 0x1110 X-axis output of pass position at

reference position return

Yref 0x1120 Y-axis output of pass position at

reference position return

Zref 0x1130 Z-axis output of pass position at

reference position return

Icom 0x1140 Output of cutter compensation

vector (I)

Jcom 0x1150 Output of cutter compensation

vector (J)

Kcom 0x1160 Output of cutter compensation

vector (K)

POL_MOV1_X

Y

0x1220 Plane first axis output during polar

coordinate interpolation

POL_MOV2_X

Y

0x1250 Plane second axis output during

polar coordinate interpolation
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Symbol Code value Function Remark

POL_MOV3_X

Y

0x1280 Plane third axis output during polar

coordinate interpolation

POL_CENT1_

XY

0x1320 Arc center first axis output during

polar coordinate interpolation

POL_CENT2_

XY

0x1350 Arc center second axis output

during polar coordinate interpolation

POL_CIR_R_

XY

0x1380 Arc radius R output during polar

coordinate interpolation

CYL_MOV1_Y

Z

0x1400 Plane first axis output during

cylindrical interpolation

CYL_MOV2_Y

Z

0x1430 Plane second axis output during

cylindrical interpolation

CYL_R_YZ 0x1460 Cylinder radius output during

cylindrical interpolation

CYL_R_ZERO

_YZ

0x1490 Cylinder radius (R0) output at the

end of cylindrical interpolation

CYL_CENT1_

YZ

0x1500 Arc center first axis output during

cylindrical interpolation

CYL_CENT2_

YZ

0x1530 Arc center second axis output

during cylindrical interpolation

CYL_CIR_R_Y

Z

0x1560 Arc radius R output during

cylindrical interpolation

Frev 0x1600 Feedrate (feed per rotation) output

Fmin 0x1610 Feedrate (feed per minute) output

Pdwell_sec 0x1620 Dwell command output (seconds)

Pdwell_rev 0x1630 Dwell command output (rpm)

Xorg 0x17C0 X-axis origin

Zorg 0x17E0 Z-axis origin

Zcycl 0x1800 Canned-cycle hole bottom

coordinates

Rcycl 0x1810 Canned-cycle R position

coordinates

Qpeck 0x1820 Depth of cut per canned pecking

cycle

Isft 0x1830 Canned-cycle shift amount (I)

Jsft 0x1860 Canned-cycle shift amount (J)

Ksft 0x1850 Canned-cycle shift amount (K)

Qsft 0x1860 Canned-cycle shift amount (Q)

Pcycl 0x1870 Canned-cycle dwelling time

(specified in seconds) for hole

bottom
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Symbol Code value Function Remark

Pcycl_rev 0x1880 Canned-cycle dwelling time

(specified in rpm) for hole bottom

Xthrd_cycl_m

ul

0x1900 Multiple-repetitive-threading-cycle

X-axis output

Ythrd_cycl_m

ul

0x1910 Multiple-repetitive-threading-cycle

Y-axis output

Zthrd_cycl_m

ul

0x1920 Multiple-repetitive-threading-cycle

Z-axis output

Ithrd_tapr 0x1930 Threading taper amount (X-axis

direction)

Jthrd_tapr 0x1940 Threading taper amount (Y-axis

direction)

Kthrd_tapr 0x1950 Threading taper amount (Z-axis

direction)

Qthrd_cang 0x1960 Threading cut angle

Fthrd_lead_X 0x1970 Threading lead (X-axis direction)

Fthrd_lead_Y 0x1980 Threading lead (Y-axis direction)

Fthrd_lead_Z 0x1990 Threading lead (Z-axis direction)

Fhacthrd_

lead_X

0x19A0 High-precision threading lead (X

axis)

Fhacthrd_

lead_Y

0x19B0 High-precision threading lead (Y

axis)

Fhacthrd_

lead_Z

0x19C0 High-precision threading lead (Z

axis)

Athrd_tang 0x19D4 Thread ridge angle

Kthrd_height 0x19E4 Thread ridge height

Dthrd_cut 0x19F4 Depth of cut on the first threading

cycle

Qthrd_mincut 0x1A04 Minimum depth of cut on a

threading cycle

Rthrd_fallow 0x1A14 Finishing allowance on a

threading cycle

Fmr 0x1C00 Feed per rotation/minute

Fthrd_lead 0x1C10 Threading lead

Fhacthrd_lead 0x1C20 High-precision threading lead

Pdwell 0x1C30 Dwell command output (seconds

or rpm)

Pcycl_sr 0x1C40 Canned-cycle dwelling time

(seconds or rpm) for hole bottom
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The output format varies according to the first digit of each code

value. The meaning of each value is as listed below.

Code value   0x1**a

a 0 1 2 4 5 6

Output of the same

value as the previous

× × × ¡ ¡ ¡

Sign output ‘+’ output × × ¡ × × ¡

‘-’ output ¡ × ¡ ¡ × ¡

27.1.3 NC data format setting function codes (G codes)

Symbol Code value Function Remark

G04 0x2000 Dwell

G28 0x2010 Return to the reference position

G29 0x2020 Return from the reference

position

G30 0x2030 Return to the second, third, or

fourth reference position

G92 0x2040 Coordinate system setting

G10L2 0x20B0 Workpiece coordinate system

setting

Gi_ret 0x20C0 Return piece to the initial level

point.

Gr_ret 0x20D0 Return to the R-point level

G_CYL_STRT 0x20E0 Start of cylindrical interpolation

G_CYL_OFF 0x20F0 End of cylindrical interpolation

Gthrd_mul 0x2100 Multiple repetitive threading

cycle

G00 0x2200 Rapid traverse

G01 0x2210 Linear interpolation

G02 0x2220 Circular interpolation (CW)

G03 0x2230 Circular interpolation (CCW)

Gthrd_nrm 0x2260 Threading

Gthrd_scr 0x2270 Threading (front)

Gthrd_cycl_nrm 0x2280 Simple threading cycle

Gthrd_cycl_scr 0x2290 Simple threading cycle (front)

G19 0x2300 YZ plane selection

G18 0x2310 ZX plane selection

G17 0x2320 XY plane selection

G90 0x2400 Absolute command

G91 0x2410 Incremental command

G94 0x2500 Feedrate (minutes)
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Symbol Code value Function Remark

G95 0x2510 Feedrate (rpm)

G21 0x2600 Metric command

G20 0x2610 Inch command

G40 0x2700 Tool-tip radius compensation

cancellation

GcomL_zx 0x2720 Left-side tool-tip radius compen-

sation (ZX plane)

GcomR_zx 0x2750 Right-side tool-tip radius com-

pensation (ZX plane)

G80 0x2A00 Canned cycle cancellation

G81 0x2A10 Drilling cycle

G82 0x2A20 Counter-boring

G83 0x2A30 Peck-drilling cycle

G84 0x2A40 Tapping cycle

G84_3 0x2AE0 Reverse rigid tapping

G85 0x2A50 Boring cycle

G86 0x2A60 Boring cycle

G87 0x2A70 Back-boring cycle

G88 0x2A80 Boring cycle

G89 0x2A90 Boring cycle

G73 0x2AA0 Peck-drilling cycle

G74 0x2AB0 Reverse tapping cycle

G76 0x2AC0 Fine boring

G84_2 0x2AD0 Rigid tapping

G84_3 0x2AE0 Reverse rigid tapping

Gcyc16 0x2AF0 Canned cycle (reserved)

Gcyc17 0x2B00 Canned cycle (reserved)

Gcyc18 0x2B10 Canned cycle (reserved)

Gcyc19 0x2B20 Canned cycle (reserved)

Gcyc20 0x2B30 Canned cycle (reserved)

G97 0x2C00 Constant surface speed control

cancellation

G96 0x2C10 Constant surface speed control

G54 0x2D00 Selection of workpiece coordinate

system 1

G55 0x2D10 Selection of workpiece coordinate

system 2

G56 0x2D20 Selection of workpiece coordinate

system 3

G57 0x2D30 Selection of workpiece coordinate

system 4
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Symbol Code value Function Remark

G58 0x2D40 Selection of workpiece coordinate

system 5

G59 0x2D50 Selection of workpiece coordinate

system 6

Gwcoord7 0x2D60 Selection of workpiece coordinate

system 7 (reserved)

Gwcoord8 0x2D70 Selection of workpiece coordinate

system 8 (reserved)

Gwcoord9 0x2D80 Selection of workpiece coordinate

system 9 (reserved)

Gwcoord10 0x2D90 Selection of workpiece coordinate

system 10 (reserved)

G_POL_STRT 0x2E00 Start of polar coordinate interpolation

G_POL_OFF 0x2E10 End of polar coordinate interpolation

G00_G01 0x2F00 Rapid traverse or linear interpolation

G02_G03 0x2F10 CW or CCW circular interpolation For CW

arc,

G02For

CCW

arc,G03

G03_G02 0x2F20 CCW or CW circular interpolation For CW

arc,

G03For

CCW

arc,G02

G90_G91 0x2F30 Absolute or incremental command For

absolute

command,

G90 For

incremental

command,

G91

G41_G42 0x2F40 Left- or right-side tool-tip radius R

compensation

For left-

side com-

pensation,

G41

For right-

side com-

pensation,

G42
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Symbol Code value Function Remark

G42_G41 0x2F50 Right- or left-side tool-tip radius R

compensation

For left-side

compen-

sation,G42

For right-side

compen-

sation, G41

G43_G44 0x2F60 Positive- or negative-side tool

length compensation

For positive-

side com-

pensation,

G43

For negative-

side com-

pensation,

G44

G17_G19 0x2F70 XY, YZ, or ZX plane selection For XY

plane, G17

For YZ

plane, G18

For ZX

plane, G19

G20_G21 0x2F80 Metric or inch command

G54_G59 0x2FC0 Workpiece coordinate system

selection

Outputs G

code for a

selected

workpiece

coordinate

system.

G94_G95 0x2FD0 Feedrate selection For feed per

minute, G94

For feed per

rotation, G95

G98_G99 0x2FE0 Return position selection

G96_G97 0x2FF0 Constant surface speed control

on/off
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27.1.4 NC data format setting function codes (integer words)

Symbol Code value Function Remark

Omain 0x3000 Program number output

Psub 0x3010 Output of subprogram call block P

code

Nseq 0x3020 Sequence number output

Hcomlng 0x3040 Offset number output

Pwcoord 0x3050 Workpiece coordinate system

value output

Lcode 0x3060 Output of origin offset fixed L

value

Osub 0x3070 Subprogram number output

Frapid 0x3090 Rapid traverse F code

Pthrd_type 0x30C4 Cutting by multiple repetitive

threading cycle

Pthrd_floop 0x30D4 Repetition count for threading

cycle finishing

Pthrd_chamf 0x30E4 Amount of cut by threading cycle

(chamfering)

DH_FIX 0x0100 Output of a fixed value for the

word described above

The output value is set according

to the next int value.

27.1.5 NC data format setting function codes (special codes)

Symbol Code value Function Remark

Eob 0x4000 Output of NC data with EOB Outputting

only EOB is

impossible.

EOB 0x4000 Output of NC data with EOB Outputting

only EOB is

impossible.

EobOnly 0x4010 Output of NC data with EOB Outputting

only EOB is

possible.

EOBonly 0x4010 Output of NC data with EOB Outputting

only EOB is

possible.

OPT_SKIP 0x4020 /.......EOB output

Eob_NON 0x4030 NC data output

EOBnon 0x4030 NC data output

Eor 0x4040 EOR (%) output

EOR 0x4040 EOR (%) output
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27.1.6 NC data format setting function codes (M codes)

Symbol Code value Function Remark

M00 0x5000 Programmed stop

M01 0x5010 Optional stop

M02 0x5020 Program end

M98 0x5030 Subprogram call

M99 0x5040 Subprogram return

M06 0x5060 Tool exchange

Mspndl_sel 0x511F Spindle range selection

M05 0x5120 Spindle stop

M03 0x5130 Spindle normal rotation

M04 0x5140 Spindle reverse rotation

Mspndlhalt 0x5150 Spindle pause

Mslock 0x5160 Spindle orientation stop

M03_M04 0x5170 Spindle rotation

M09 0x5300 Coolant off

M07_M08 0x5310 Coolant on

Mflood_on 0x5320 Coolant FLOOD

Mmist_on 0x5330 Coolant MIST

M_MILLAXES

OFF

0x5600 Milling axis off

M_MILLAXES

ON

0x5601 Milling axis on

M_YAXISOFF 0x5610 Y-axis off

M_YAXISON 0x5611 Y-axis on

M_CAXISOFF 0x5620 C-axis off

M_CAXISON 0x5621 C-axis on

M_ROTCLAM

PON1

0x5630 Rotation first axis clamp on

M_ROTCLAM

POFF1

0x5640 Rotation first axis clamp off
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27.1.7 NC data format setting function codes (S codes)

Symbol Code value Function Remark

Srot 0x6000 Spindle rotation command output

Ssurf 0x6010 Output of S code for surface

speed command

Smaxrpm 0x6020 Output of S code for maximum

spindle clamp value

Spndl_rng 0x6030 Spindle rotation range output

Srotsur 0x6040 Spindle rotation speed/surface

speed command S code

27.1.8 NC data format setting function codes (T codes)

Symbol Code value Function Remark

TOOL_OFST_

CAN

0x7000 Tool offset cancellation

Tsel 0x7010 Output of T code for selection of a

tool on tool post 1

Tfin 0x7040 Output of final T code for tool post

1

27.1.9 NC data format setting function codes (outputting arbitrary character strings)

Symbol Code value Function Remark

Str1

     :

Str16

0x8000

     :

0x800F

Output of arbitrary character

string No. 1

Output of arbitrary character

string No. 16

Name 0x8010 Part program name output

ProcName 0x8020 Machining type name output
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27.1.10 NC data format setting function codes (modal clearing)

Symbol Code value Function Remark

Gclr 0x9010 Clearing G-code modal infor-

mation

Following

this call,

specify the

number of

the group to

be cleared.

0xFFFF

means all

groups.

Mclr 0x9020 Clearing M-code modal

information

Following

this call,

specify the

number of

the group to

be cleared.

0xFFFF

means all

groups.

Tclr 0x9030 Clearing T-code modal

information

Sclr 0x9040 Clearing S-code modal

information

Fclr 0x9050 Clears F code modal information
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27.2 Pre/Postprocessor Macro Syntax

27.2.1 General

(1) Outline

The pre/postprocessor macro is used for customizing a postprocessor.

The pre/postprocessor macro has the following features:

• Text (ASCII) format

• Syntax similar to C language

• Blanks/tabs can be used between words, and multi-statements

are supported.

• Preprocessor pseudo instructions such as #include and

#define are supported.

• The concept of variables is employed; both local variables and

global variables can be used.

• Arithmetic operations, compare operations, and logical

operations are supported.

• The control structure supports condition decision and loop

execution.

• Procedures can be defined and subsequently called.

(2) Notation

• [a] : Entry a can be omitted.

• a|b : Either of entry a or b must be selected.

• ... : The preceding entry is repeated.

27.2.2 Components

(1) Character set
• Uppercase letters (A to Z), lowercase letters (a to z), numeric

characters (0 to 9), underscore (_).

Variable names can be created using these characters. The

reserved words are also created using these characters. Note that

pre/postprocessor macros distinguish between uppercase letters

and lowercase letters.

• Blank characters (space, tab, line feed, form feed, comment)

These characters are used to delimit constants, variable names,

and reserved words from each other in pre/postprocessor macros.

All blank characters other than those that do not appear in a

character string constant are ignored, such that blank characters

can be used to improve the readability of the pre/postprocessor

macro.
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• Special characters (, . ; " ( ) [ ] { } + - * / %

! & | = < > #)

When used in a pre/postprocessor macro, each of these special

characters has a special function. The use of a special character is

described whenever a special character appears in this manual.

Special characters other than the above are used only in character

string constants, comments, and #include file names.

• Escape sequence (\" \\)

The back slash symbol (\) is used to include a double quotation

mark (") or back slash symbol (\) in a character string constant.

If a character other than these characters is placed after a back

slash symbol, the back slash symbol is ignored and only the

character itself becomes effective. When \c is specified, for

example, c is assumed.

• Non-display characters

Non-display characters other than tabs, line feeds, and form

feeds cannot be used.

• Operators

Operators are special characters used to connect operands in an

expression and specify a type of operation. For details, see

Section 27.2.5.

(2) Constants

• Integer constant (decimal number, octal number,

hexadecimal number)

digits

0odigits

0xhdigits | 0Xhdigits

• Real constant
[digits][.digits ][E |e |D |d [+ |- ]digits]

• Character string constant
"characters"["characters"][...]

(3) Variable names and procedure names

Variable names and procedure names consist of one or more letters,

numeric characters, and/or underscores, starting with a letter.

No limit is imposed on the length of a name. If a name of more than

31 characters is specified, however, only the first 31 characters are

effective as the variable name or procedure name.

The system distinguishes between uppercase and lowercase letters.

Therefore, those names that are spelled in the same way but which

differ in their capitalization are treated as different variable names or

procedure names.

Variable names and procedure names must not duplicate any reserved

word.
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(4) Reserved words
void int double string

function if else for

break continue

(5) Comments
A comment consists of character strings enclosed within a /*-*/

pair. A comment may consist of more than one line. Nesting is not

allowed, however. A comment can be written in any location where

blank characters are allowed.

27.2.3 Structure

(1) Basic structure

A pre/postprocessor macro consists of one or more preprocessor

pseudo instructions, declare statements, assignment statements,

control statements, procedure statements, EL statements, and

comment statements. Each of these is summarized below.

• Preprocessor pseudo instruction

Before a pre/postprocessor macro is analyzed, preprocessor

pseudo instructions perform processing such as header

processing, macro expansion, and condition-based analysis skip

processing. Basically, the preprocessor pseudo instructions have

functions similar to those of the C preprocessor.

• Declare statement

A declare statement declares a variable by specifying a type name

and variable name. When a variable is declared, that variable can

simultaneously be initialized to an arbitrary value. The concepts of

lifetime and visibility apply to a declared variable.

• Assignment statement

An assignment statement assigns a value to a variable declared

with a declare statement. An assignment statement is an

assignment expression described as an independent statement.

The format of an assignment statement corresponds to the

assignment expression description.

• Control statement

A control statement either specifies a conditional expression to

select another statement, or controls a loop. A control statement

consists of a control part and main part. The control part

consists of one statement or multiple statements. Multiple

statements are enclosed in braces {}. Statements enclosed in

braces are referred to as a control block.

• Procedure definition statement

A procedure definition statement defines a procedure by

specifying a type name and procedure name. A procedure

definition statement consists of a formal argument part and main
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part. In the main part, any statements that can be specified in a

pre/postprocessor macro other than procedure definition

statements can be described.

• Procedure call statement

A procedure call statement executes a procedure defined with a

procedure definition statement.

• EL statement

An EL statement specifies the machining information to be

passed to the machining execution function. The format of an

EL statement is similar to that for calling a function. Many

different EL statements are supported, to be used with various

machining information items.

• Comment statement

A comment statement consists only of character strings, and has

no effect on the execution. A comment statement, enclosed in a

pair of /* and */, can be described at any location where blank

characters are allowed.

(2) File configuration

A pre/postprocessor macro can be divided into multiple files. In this

case, the pre/postprocessor macro must appear as a single large file

having #include pseudo instructions.

(3) Block
In the pre/postprocessor macro, those portions braces {} are called

blocks.

Three types of blocks are used. The first is a function block that

constitutes the main part of a function statement. The second is a

control block that is used when the main part of a control statement

includes multiple statements. The third is a procedure block that

constitutes the main part of a procedure statement.

Particularly, a function block declares a variable, defining the

lifetime and visibility of that variable.

One block can contain multiple blocks. This embedding is referred to

as nesting.

Note, however, that the pair of braces used for initialization in an

array declaration differs from those used to specify a block.

(4) Lifetime

Any variable declared outside all function blocks has a global lifetime.

A variable declared in a function block has a local lifetime within the

local block and the block(s) nested in the local block.

(5) Visibility

A variable declared outside all function blocks is visible in the range from

the declaration position to the end of the pre/postprocessor macro.

A variable declared in a function block is visible in the range from

the declaration position to the end of the local block.
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A variable declared in an external function block is visible in all

blocks nested in the function block. If a nested function block defines

the same variable name as that declared in an external function

block, the variable declared in the external function block will not be

visible in the nested function block. This state is cleared, however,

when the internal function block ends.

27.2.4 Declare statement

(1) Type name

A pre/postprocessor macro can handle three types of data:

• int: Integer type

• double: Real type

• string: Character string type

(2) Variable declaration

Before a variable can be used, it must be declared. A variable can be

declared by describing a data type followed by a variable name; an

additional variable of the same data type can subsequently be

declared by specifying a contiguous comma (,) followed by the

additional variable name.

A variable must be declared at the beginning of a function block.

After a statement other than a declare statement appears in a function

block, no further variables can be declared.

Within a single block, any given variable name cannot be declared

more than once.

There are two types of variable declarations, simple variable

declarations and array declarations:

• Type-name variable-name

    Simple variable declaration

• Type-name variable-name   (numeric-expression)[(numeric-

expression)...]

    Array declaration

By following a variable-name with one or more numeric-expressions

enclosed in parentheses(), an array declaration can specify the

number of array elements; all elements are of the type specified by

type-name.

Let n be the number of numeric-expressions that follow variable-name.

Then, the array is defined as an n-dimensional array; one numeric-

expression defines the number of elements of one dimension.

Note, however, that no more than ten numeric-expressions can be

specified. This means that an array having up to ten dimensions can

be specified.

From the viewpoint of syntax, the format of a numeric-expression

must, as a bare minimum, satisfy the numeric-expression format
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described in Section 27.2.5. Note, however, that a numeric-

expression is used to define the number of array elements, so that one

integer constant or an integer expression should be specified.

(3) Initialization

When a variable is declared, the variable can be initialized by

specifying an initial value.

• Initialization of a simple variable

Type-name variable-name = expression

• Initialization of an array

Type-name variable-name (numeric-expression) [(numeric-

expression)...] = {expression,...}

A simple variable declaration can be initialized by describing, after

variable-name, an equal sign (=) followed by an expression. A

variable of integer or real type, if not initialized explicitly, assumes

an initial value of 0. A variable of character string type, if not

initialized explicitly, assumes an initial value of "" (null string).

An array variable declaration can be initialized by describing an

equal sign (=) followed by {expression,...} after variable-name

(numeric-expression)[(numeric-expression),...].

Those expressions enclosed in braces {} are used for initialization.

At least one expression must be specified, but the number of

expressions must not exceed the number of array elements. Specified

values are assigned to the corresponding array elements.

If the number of expressions for initialization is less than the total

number of array elements, the remaining array elements of integer or

real type automatically assume an initial value of 0, while the

remaining array elements of character string type assume an initial

value of "" (null string). All array elements that are not explicitly

initialized assume initial values in the same way.

An error occurs if the number of expressions exceeds the total

number of array elements.

For details of the specification format of expressions, see Section

27.2.5.

27.2.5 Expression and assignment

(1) Expression

Expressions are classified into two types: numeric-expressions that

are used for obtaining integers or real numbers, and character-string-

expressions that are used for obtaining character string values.

(a) Numeric expression

A numeric-expression consists of one or several operands

connected by an operator.  Each basic operand is a constant or

variable.

Any operand can be enclosed in parentheses (). In this case, the
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operand enclosed in parentheses is assumed to be grouped

explicitly, and functions as an expression. The format of a

constant or variable depends on whether it is an integer or real

number, as follows:

• Integer constant: [Sign][0][x|X]integer-part

• Real constant: [Sign][integer-part][.fraction-part]

[e|E|d|D[sign]exponent-part]

• Integer variable: Variable-name of int type

• Real variable: Variable-name of double type

The operators used in an expression follow a priority order and

associativity as evaluation criteria.

The table below lists the operands, together with their priorities

and associativities.

Operator Type of operator Associativity Priority

()  [] Expression → Higher

!  - Unary operator ←

*  /  % Multiplication,

division

+  - Addition,

subtraction

<  <=  >

>=

Comparison Binary

operator

→

==  != Equivalence

&& Logical AND

|| Logical OR

= Assignment operator ← Lower

(b) Character string expression

A character-string-expression represents a character string

value with one character string constant or character string

variable.

No character string expression can be enclosed in parentheses.

The formats of character string constants and character string

variables are as follows:

• Character string constant:

 "Characters"["Characters"]

 [...]

• Character string variable:

 Variable of string type
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(2) Assignment

An assignment operation loads the evaluation value of the expression

on the right side of the assignment operator (=) to the previously

declared variable on the left side.  Accordingly, the type of the

variable on the left side of an assignment operator is related to the

expression on the right side, as follows:

• Variable-name of int type = numeric-expression

• Variable-name of double type = numeric-expression

• Variable-name of string type = character-string-expression

An assignment expression described as an independent statement is

referred to as an assignment statement.

The right side of an assignment statement contains an expression,

which may include an assignment operation.  So, an assignment

statement can be written as follows:

• Variable-name[= variable-name] = expression;

(3) Referencing variables

To use a variable as a basic operand, the variable must be declared

beforehand and must also be visible (Section 27.2.3.(5)). The value of

a variable is changed by assignment.  The current value of a variable

is obtained by referencing it.

When a variable to be referenced is an array variable, the elements of

the array to be referenced must be specified using subscript-

expressions enclosed in brackets [], after the variable-name.

• Array-variable-name[subscript-expression][...[subscript-

expression]]

The number of times [subscript-expressions] must match the

number of array dimensions.

From the viewpoint of syntax, a subscript-expression enclosed in

brackets[] must be a numeric-expression and, as a bare minimum,

satisfy the format of numeric-expressions described in (1) above.

27.2.6 Control statement

(1) If and else statements

The if and else statements are both conditional branch statements,

and have the following format:

• if(expression) statement-a;[else statement-b;]
 

Here, if(expression) is referred to as the control part, else is

referred to as the auxiliary part, and statement-a and statement-b are

referred to as the main parts. The expression in if(expression) is a

numeric expression.

If the result of evaluating the control part is true (≠ 0), statement-a is
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executed. If the result of evaluating the control part is false (= 0),

statement-b is executed. If, however, the result of evaluating the

control part is false (= 0), and else is omitted, no statement is

executed and statement-a is ignored.

By enclosing the main part of an if statement (and else statement) in

braces {}, multiple statements can be contained in the main part, as

described below. Such a main part is referred to as a control block.

• if(expression) {statement-1;...statement-m;}

[else {statement-1;...statement-n;}]
 

(2) For statement
The for statement is used to apply loop control.  Its format is as

follows:

• for([multi-expression-1];[multi-expression-2];[multi-

expression-3]) statement;

The part, for([multi-expression-1];[multi-expression-2];[multi-

expression-3]), is referred to as the control part, and statement is

referred to as the main part.

Here, a multi-expression represents one numeric-expression, or

multiple-numeric-expressions delimited from each other by a comma.

When a multi-expression is evaluated, the result of evaluating the last

numeric-expression is returned.

Each multi-expression in the control part performs the evaluation

described below.

Multi-expression-1: This expression is a loop initialization

expression which is executed once before

entering a loop. If this expression is omitted, no

initialization is performed.

Multi-expression-2: This expression is a loop condition expression

which performs evaluation before the execution

of one loop. If this expression is omitted, the

true condition is always assumed. If the result of

evaluation is true (≠ 0), the statement is exe-

cuted, and the loop is repeated. If the result of

evaluation is false (= 0), the loop is terminated.

Multi-expression-3: This expression is a loop adjustment expression

which is executed after the execution of one

loop. If this expression is omitted, no adjustment

is performed.

By enclosing the main part of a for statement in braces {},

multiple-statements can be specified in the main part, as described

below.

• for([multi-expression-1];[multi-expression-2];[multi-

expression-3]) {statement-1;...statement-n;}
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(3) Break statement
The break statement is an auxiliary statement for loop control

which can be described only within the main part. The appearance of

this statement causes the loop to stop immediately.

• break;

(4) Continue statement
The continue statement is an auxiliary statement for loop control

which can be described only within the main part. The appearance of

this statement causes the remaining statement or statements in the

main part to be ignored, and control is passed to the next iteration.

• continue;

27.2.7 Procedure statement

(1) Concept of procedure

Several statements can be combined into a procedure, such that those

statements can be executed simply by calling the procedure.

(2) Procedure type
Only one procedure type, VOID, can be used for a procedure

definition.

(3) Definition format
Procedure-type procedure-name([type-name-expression][,type-

name expression][...])

{

[declare-statement][...]

[assignment-statement | control-statement | EL-statement |

function-statement | procedure-call][...]

}

• The procedure statements in the main part of a procedure

definition is not executed during definition. Instead the main

part is executed when the procedure is called.

• The procedure-type must not be omitted.

(4) Calling a procedure
Procedure-name([expression][,expression][...]);

• An actual argument must be specified as immediate data, an

expression, or variable.

• Only input is allowed for immediate data or an expression. Both

input and output are allowed for a variable.

(5) Return value

• No value is returned. (An argument specified when calling a

procedure is used to return a value.)
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(6) Restrictions

• A procedure statement definition must be described outside all

blocks.

• Procedure names that duplicate reserved words (int, double,

string, function, and so forth) cannot be used.

• When the name of an EL statement duplicates that of a

procedure statement, the procedure statement has the higher

priority.

• A procedure name not exceeding 31 characters must be

specified. (All characters subsequent to the first 31 characters

are ignored.)

• If a procedure name is defined more than once, the most recently

made definition replaces all other definition(s).

• A procedure cannot be defined while another procedure is being

defined or called.

• While a procedure is being defined, another procedure cannot be

called.

• The calling of procedures can be nested up to 50 levels.

(7) Visibility

(a) Visibility of a procedure statement

• If a procedure definition statement exists in the same

file, the procedure statement will be visible from the

point at which it is defined until the end of execution.

• If a procedure definition statement exists in another

file, all procedures defined in the file(s) executed before

the current file are visible. The procedures in a library

that are made visible using the reference option become

visible from the start to the end of execution.

(b) Visibility of a variable

• A variable declared in a procedure block is visible

within the block, and its lifetime does not extend

beyond the block at the time of execution.

• A variable declared outside all blocks can be referenced

using a procedure. The global variables in files other

than that containing the procedure definition are not

visible.

(8) Arguments

• The type (numeric value or character string) of arguments, the

number of arguments, dimensions, and array size are checked.

• An error occurs if the number of arguments in an argument list

is invalid.
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An argument type check is made as indicated in the table below.

          Actual argument

  int type  double type

Formal argument

  double type

       ↓

  int type       ¡   int type   Error

Cast from int type

to double type

  int type

       ↓

  double type   double type       ¡   Error

Cast from double

type to int type

  string type   Error   Error       ¡

(9) Sample

#include  "mdfile.h"

/* procedure definition */

void proc( int i_1, int i_2, double d_1, double

d_2,

string s_1[3] )

{

draw_pen( i_1 );

draw_pen( i_2 );

mot_goabs( d_1, d_2, );

name_mac( s_1[0] );

i_1 = 3;

i_2 = 5;

d_1 = 20.0;

d_2 = 30.0;

s_1[1] = "str_1";

}

int wint;

double wdbl = 50.0;

string

type
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double dnm[10] = { 1.0,2.0,3.0,4.0,5.0,

   6.0,7.0,8.0,9.0,10.0 } ;

string str[3] = {"name", "main"} ;

/* Constant, expression, simple variable, array

elements, array variable */

proc( 2, wint=1+3, wdbl, dnm[5], str ); /*

procedure call */

27.2.8 EL statement

The EL statement specifies the machining information (referred to as EL

data) to be passed to the machining execution function. The basic format of

an EL statement is as follows:

• EL-statement-name([expression][,expression][...]);

A range of EL-statement-names are supported to match many different machining

information items. For each EL-statement-name, the type (numeric value or

character string) of the expression(s) in parentheses, as well as the number of

expressions, are determined. (Note, however, that for some EL statements such as the

EL statement for the post function, the type of expression(s) in parentheses and the

number of expressions are not fixed.)

This means that the EL statement has a format similar to that of calling functions in C;

an EL-statement-name is equivalent to a function name, and actual arguments are

described within parentheses.

27.2.9 Preprocessor pseudo instruction

The instructions below can be described to perform particular operations

before a pre/postprocessor macro is analyzed; the instructions are basically

similar those of the C preprocessor.

#include <pathname>

#include "pathname"

#define name sequence_of_tokens
#define name(arg[,...]) sequence_of_tokens
#undef name

#if
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#ifdef (Not supported.  Use #if defined(xxx).)

#ifndef (Not supported.  Use #if !defined(xxx).)

#else

#elif

#endif

defined

For details, refer to the relevant C language manual.

27.2.10 Restrictions

• Length of a line

Each line can contain up to 255 characters, including \n at the line

end.

• Length of a statement

The length of each statement is not limited.

• Length of a variable

The length of each variable is not limited. If a variable name of more

than 31 characters is specified, however, the first 31 characters

function as a variable name.

• Number of variables

The number of variables is not limited.

• Function statement nesting depth

Function statements can be nested up to 20 levels.

• Integer/real number value range

The same ranges as represented by int and double of C language

apply.

• Length of a character string

A character string can be up to 255 characters in length.
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Basic Operation 16

Before Trouble Occurs 337

Blank Figure Color/Line Type Modification 58

BLANK FIGURE CREATION 54

Blank Figure Creation 54
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<C>

CAD data 277

CAD DATA INPUT/OUTPUT 277

CAD Data Input/Output 277
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Canceling movement entry editing 136
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Changing and modifying the machining process 109

Changing Cutting Condition Files 189

Changing icons 335

Changing the contents of the transmission operation 254

Changing the order of the tool types 175

Changing the order of the tools in the tool data 203

Changing the schedule 269

Changing Tooling Files 212

Checking the transmission status 255

Checking tool paths for continuity 135

Chuck figure registration/edit screen 91

Circle\Arc Radius 315

Clear 258

CNC Specifications 221

Components 393

Condition setting 105

Confirming the version 16

Contents of Symbolic CAP T window 2-2

Contents of the screen 268

Control statement 400

Conversion specifications for DXF file input/output 296

Coordinate system 147

Coordinate system used for tool path editing 128

Copying figures 149

Creating icons 334

Creating polygons 155

CREATING PROGRAMS 140

Creation method of a fitting curve 156

Customization 242

CUTTING CONDITIONS 162

CUTTING CONDITIONS DATA UTILITY 179
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Data setting screen for animated simulation 124

Declare statement 397

Defining new machining process 111

Delete 257

Deleting a material name [Edit Cutting Condition Data] 168

Deleting a Tooling 198

Deleting buttons/spaces 335

Deleting cutting condition data 175

Deleting cutting condition data on a machining type basis 175

Deleting setting items 245

Deleting tool data from the tooling data 202
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Deleting tool paths 131
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DIMENSION MEASUREMENT 308

Dimension Measurement Function 308

Discarding the settings/returning to the normal state 336

Displaying input information 306

Displaying Measurements 317

Displaying the progress of input processing 305

Displaying the Tool Bar Setting screen 334

Distance between Points and Entity 314
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Drawing Format Setting 40

Drawing window 13

Duplicating the tool in the tool data 203

DXF file input 282

DXF File Input/Output 279

DXF file output 289

DXF input conversion specifications 296
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Edit menu 28

Editing 128

Editing cutting condition data 169

Editing movement entities 132
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Ending the transmission operation 256

Entity selection 61

Erasing movement entities 133

Error Messages 339

Example of NC Data Output 239

Example of operation 43

Example of referencing NC data formats 225

Example Transmission Procedures 271

Execution of Tool Path Editing 129

Exiting the File Transmission Manager 270

Explanation of each step 42
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<F>

FAPT LANGUAGE FIGURE INPUT 301

FAPT language figure input 303

FAPT statement types that can be input 301

Feedrate 220

FIGURE CREATION 141

Figure creation layer setting 39

Figure creation mode 19

Figure types that can be input 301

File configuration 242

File menu 26

File operation functions 248

File specification areas 252

FILE TRANSFER 247

File Transmission Tool Screen 251

Fitting curve 156

Flow of Operation 35, 41

Fully automatic determination 112

Function Codes 382

Function Outline 247

Functions 179, 194, 205

Functions of deleting 164

Functions Provided by Menu Bar 26

Functions Provided by Side Menu 19

Functions Provided by the Tool Bar 34
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<G>

G code 222

General 393

<H>

Handling CAD data efficiently 295

Handling of CAD data by this system 278

Help menu 33

Home position/index position 219
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If Trouble Occurs 338

Inputting Cutting Condition Files 184

Inputting Tool/Tooling Files 210

Inserting spaces 335

Inward offset for a corner 160
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Loading a File 139
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M code 222

Machine Specifications 219

MACHINING DEFINITION 93

Machining Definition Screen 94

Machining plane coordinate system 147

Machining process list 130
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Measurable Dimensional Values 309

Measuring Coordinates 311

Menus 251

Menu bar 13

Messages concerning machining surface setting 347
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Messages related to cutting condition setting 369

Messages related to loading part files 366

Messages related to machining definition 347

Messages related to NC data preparation 351

Messages related to pre-machining settings 345

Messages related to tool and tooling data 375

Modify menu 27

Modifying cutting condition data 175
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Modification of the Tooling Data 199

Modifying setting item names 244

Modifying the cutting condition data on a machining type basis 169

Modifying the NC Data Output Format 216

Modifying the operation flow 17

Modifying tool registered in the tooling data 202
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NC Data Format 225

NC data format setting function codes (G codes) 385

NC data format setting function codes (integer words) 389
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NC data format setting function codes (move command words) 382
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NC data format setting function codes (special codes) 389

NC data format setting function codes (special functions) 382

NC data format setting function codes (T codes) 391

NC DATA PREPARATION 115

NC data preparation data setting screen 121

NC Data Preparation Screen 116

NC Machine File 214

NC machine name 219

NC MACHINE SETTING 214

NC Machine Setting Tool Operation 241

<O>

Offset 159

Operating Procedure 253

Operation 302

Operation guide 252

Other messages 379

Other Symbolic CAP T icons 9

Other usable devices 2

Outline of Processing for Each Function 257

Outputting Cutting Condition Files 182

Outputting Tool/Tooling Files 208

Outward offset for a corner 159

Overview 162, 192, 301

Overview of Data 36

Overview of DXF 279

Overview of each function 35

Overview of NC Data Preparation Procedure 215
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PARAMETER SETTING 321

Parameter Setting for Auto Saving 333

Parameter Setting for Blank Figure and Part Figure 324

Parameter Setting for Figure Operation 322

Parameter Setting for Machining Condition Automatic Decision
326

Parameter Setting for Machining Definition 325

Parameter Setting for NC Data Preparation 332

Parameter Setting for Overall Setting of Symbolic CAP T 324

Parameter Setting for Pre-Machining Setting 325

Parameter Setting for Tool Path Creation 331

Parameter setting for view 321
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PARTS FIGURE CREATION 59

PLOTTING 272

Pre/Postprocessor Macro Syntax 393

PRE-MACHINING SETTINGS 84

Preparing and Displaying NC Data 115

Preprocessor pseudo instruction 405

Prerequisites 1

Printing NC data and a process table 126

Prior to Setting Up (Operating Environment) 1

Procedure 41

Procedure statement 402

Procedures 274

Process Order Editing Screen 119

PROGRAMMING EXAMPLES 41

Programming mode 19

Prompt area 14
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Reading the latest information about Symbolic CAP T 9

Read-only and read/write 258

Receive 257

Refresh 259

Registering a new tool and adding or inserting the data into the
tooling data 200

Registering a new tool and adding or inserting tool data 202

Registering menu items 335

Reinstalling Symbolic CAP T 8

Rename 258

Restrictions 406

<S>

Saving a File 138

SAVING AND LOADING FILES 138

Saving settings/returning to the normal state 336

Selecting a command 254

Selecting an NC Machine File 86

Selecting a tool path for editing 130

Selecting entities 145

Selecting the device and setting the transmission conditions 253

Selecting the Machining Type 95

Selecting Tooling Data 85

Selecting Utility Functions 181, 207

Send 257

Setting items of the chuck 89

Setting menu 32

Setting procedure 260

Setting reception control conditions 266

Settings related to the FAPT language figure input function 304

Setting the Chuck 89

Setting the communication conditions 264

Setting the home position 87

Setting the index position 88

Setting the input conversion method 284

Setting the output conversion method 291

Setting the transmission control conditions 265

Setting Transmission Conditions 260

Setting up a Plotter 272

Setting up an optimal module 6

Setting Up Symbolic CAP T 3

SETUP 1

Side menu 12

Special figure 56

Specifying a radius, distance, and angle 142

Specifying Another Area 107

Specifying files 253

Specifying positions 143

Specifying required functions 223

Specifying start entities 134

Specifying the Cutting Area 97

Specifying the Cutting Area and Condition Data 97

Specifying the device and plotter 263

Spindle speed 220

STANDARD SETTING 319

Standard setting files 263

Standard Setting for Blank Figure and Parts Figure 319

Standard Setting for NC Data Preparation 320

Start-up 302

Starting of Cutting Condition Data 165

Starting of tool data/tooling data editing 195

Starting Symbolic CAP T 9

Starting the Cutting Condition Data Utility 180

Starting the Tool/Tooling Data Utility 206

Starting transmission 255

Status window 15

Storing the tool bar definition file 334

Structure 395

Symbolic figure creation by figure reference 80

Symbolic Figure data editing 78

Symbolic figure data input 62
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Terminating movement entry editing 137

Terminating Symbolic CAP T 9

Terminating tool path editing 131

Timing of NC data format reference 226

Title bar 11

Tool bar 13

TOOL BAR SETTING 334

Tool Bar Setting 334

TOOL DATA AND TOOLING DATA 192

TOOL PATH EDITING 127

Tool Path Editing 127

Tool Path Editing Dialog Box 130

Tool Paths subjecting to editing 127

TOOL/TOOLING DATA UTILITY 205

Total number of axes/number of simultaneously controlled axes
219

Transmission protocols 248

Transmission Schedule Management 268

Transmission to and from the CNC 271

Trimming/Extending movement entities 133

TROUBLESHOOTING 337

Turning Figure Creation 59

Types of Figures 141

<U>

Undoing/redoing editing 133

Unit of editing 128

Using the Help function to become familiar with the operating
procedure 16

<V>

View menu 30

<W>

Whether to use the ATC function 220

World coordinate system 147

Writing NC data to a floppy disk and transferring NC data to a
peripheral device 125
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·  No part of this manual may be
reproduced in any form.

·  All specifications and designs
are subject to change without
notice.
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